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Conga Collaborate allows you to easily create, collaborate, and share documents through
web links on any device. Integrate data from Salesforce, Microsoft Dynamics, Netsuite, and
Pipedrive.



Release Notes

Review the latest features delivered in Conga Collaborate.

- Winter20.02.18 Release Notes
+ Winter20.02.04 Release Notes
+ Winter20.01.29 Release Notes
- Winter20.01.21 Release Notes
- Winter20.01.07 Release Notes
+ Winter20.12.17 Release Notes

+ Winter20.12.02 Release Notes
- Winter20.11.12 Release Notes

Winter20.02.18 Release Notes

These Release Notes contain the following information about Conga Collaborate
Winter20.02.18 Release.

- Packages: Lists packages that are required to upgrade to this release of the product

- System Requirements and Supported Platforms: Lists requirements and
recommendations for installing this release

- New Features: Provides high-level descriptions of new features introduced in this
release, with links to more detailed information

- Enhancements: Provides high-level descriptions of enhancements to existing features

- Resolved Issues: Lists customer-reported issues that are resolved in this release or
known issues resolved from previous releases

- Known Issues: Lists known issues that are applicable in this release

This documentation may contain descriptions of software features that are
optional and for which you may not have purchased a license. As a result, your
specific software solution and/or implementation may differ from those described in
this document. Please contact your CSM or AE for information on your specific
features and licensing.

Packages

The following packages and dependent packages are required to upgrade to this release
to utilize all the new features of this release. These are the minimum required versions; later



versions are also supported. Separate prerequisites for each feature can be found in the
respective guides. The packages marked as (New) are new packages in this release.

Product Latest Certified Version

(Version Name | Version Number)

Conga Collaborate [teration 114

System Requirements and Supported Platforms

The following table lists the minimum requirements for installing and using Conga
Collaborate.

System Requirement Minimum Supported Version

Browser - Firefox® (minimum supported version by Mozilla)
- Chrome® (minimum supported version by Google)
- Safari® (Mac only) (minimum supported version
by Apple)
- Microsoft Edge (minimum supported version by
Microsoft)

Upgrade Notes

To upgrade Conga Collaborate, see Installing and Configuring Conga Collaborate.

New Features

There are no new features in this release.

Enhancements

There are no new enhancements in this release.

Resolved Issues

The following table lists the issues resolved in this release.


https://documentation.conga.com/display/CCSFWIN20AG/Installing+and+Configuring+Conga+Collaborate

Conga
Internal
ID

TB-8155

TB-7765

TB-7811

TB-7978
TB-7986

TB-8142

Description

When you insert and save a Video URL in a document or Content Page, the https:is no
longer stripped from the video and it works as expected after previewing and
publishing.

Assigned logic groups are now cleared when you remove them from a page's Include
Logic.

The Document List now displays the correct currency based on what User Language is
selected.

The Euro symbol now displays correctly in the Pricing Table.

Pending Creation documents no longer appear on the Reporting page.

Links to embedded pages in print Table of Contents now work as expected.

Known Issues

There are no known issues in this release.

Winter20.02.04 Release Notes

These Release Notes contain the following information about Conga Collaborate
Winter20.01.29 Release.

- Packages: Lists packages that are required to upgrade to this release of the product

- System Requirements and Supported Platforms: Lists requirements and

recommendations for installing this release

- New Features: Provides high-level descriptions of new features introduced in this

release, with links to more detailed information

- Enhancements: Provides high-level descriptions of enhancements to existing features

- Resolved Issues: Lists customer-reported issues that are resolved in this release or

known issues resolved from previous releases

- Known Issues: Lists known issues that are applicable in this release



This documentation may contain descriptions of software features that are
optional and for which you may not have purchased a license. As a result, your
specific software solution and/or implementation may differ from those described in
this document. Please contact your CSM or AE for information on your specific

features and licensing.

Packages

The following packages and dependent packages are required to upgrade to this release
to utilize all the new features of this release. These are the minimum required versions; later
versions are also supported. Separate prerequisites for each feature can be found in the
respective guides. The packages marked as (New) are new packages in this release.

Product Latest Certified Version

(Version Name | Version Number)

Conga Collaborate Iteration 113

System Requirements and Supported Platforms

The following table lists the minimum requirements for installing and using Conga

Collaborate.
System Requirement Minimum Supported Version
Browser - Firefox® (minimum supported version by Mozilla)

- Chrome® (minimum supported version by Google)

- Safari® (Mac only) (minimum supported version
by Apple)

- Microsoft Edge (minimum supported version by
Microsoft)

Upgrade Notes

To upgrade Conga Collaborate, see Installing and Configuring Conga Collaborate.


https://documentation.conga.com/display/CCSFWIN20AG/Installing+and+Configuring+Conga+Collaborate

New Features

There are no new features in this release.

Enhancements

There are no new enhancements in this release.

Resolved Issues

The following table lists the issues resolved in this release.

Conga Description
Internal
ID

TB-7463 When sharing content with all workgroups within the assets library, the user interface
now saves the unchecking of the Disable Editing check box.

TB-7733 Copying a Content Page from the content list no longer takes you to a blank page.

TB-8046 Formatted date variables such as month name are now translated.

Known Issues

There are no known issues in this release.

Winter20.01.29 Release Notes

Conga Collaborate Winter20.01.29 Release Notes

These Release Notes contain the following information about Conga Collaborate
Winter20.01.29 Release.



- Packages: Lists packages that are required to upgrade to this release of the
product

- System Requirements and Supported Platforms: Lists requirements and
recommendations for installing this release

- New Features: Provides high-level descriptions of new features introduced in this
release, with links to more detailed information

- Enhancements: Provides high-level descriptions of enhancements to existing
features

- Resolved Issues: Lists customer-reported issues that are resolved in this release or
known issues resolved from previous releases

- Known Issues: Lists known issues that are applicable in this release

This documentation may contain descriptions of software features that are
optional and for which you may not have purchased a license. As a result, your
specific software solution and/or implementation may differ from those
described in this document. Please contact your CSM or AE for information on
your specific features and licensing.

Packages

The following packages and dependent packages are required to upgrade to this
release to utilize all the new features of this release. These are the minimum required
versions; later versions are also supported. Separate prerequisites for each feature can
be found in the respective guides. The packages marked as (New) are new packages in

this release.

Product Latest Certified Version

(Version Name | Version Number)

Conga Collaborate [teration 112

System Requirements and Supported Platforms

The following table lists the minimum requirements for installing and using Conga

Collaborate.



System Requirement Minimum Supported Version

Browser - Firefox® (minimum supported version by

Mozilla)

- Chrome® (minimum supported version by
Google)

- Safari® (Mac only) (minimum supported version
by Apple)

- Microsoft Edge (minimum supported version by
Microsoft)

Upgrade Notes

To upgrade Conga Collaborate, see Installing and Configuring Conga Collaborate.

New Features

There are no new features in this release.

Enhancements

There are no new enhancements in this release.

Resolved Issues

The following table lists the issues resolved in this release.

Conga  Description
Internal
ID

TB-8139 Implemented a fix to correct issues with updating user workgroups.

Known Issues

There are no known issues in this release.

Winter20.01.21 Release Notes


https://documentation.conga.com/display/CCSFWIN20AG/Installing+and+Configuring+Conga+Collaborate

Conga Collaborate Winter20.01.21 Release Notes

These Release Notes contain the following information about Conga Collaborate
Winter20.01.21 Release.

- Packages: Lists packages that are required to upgrade to this release of the
product

- System Requirements and Supported Platforms: Lists requirements and
recommendations for installing this release

- New Features: Provides high-level descriptions of new features introduced in this
release, with links to more detailed information

- Enhancements: Provides high-level descriptions of enhancements to existing
features

- Resolved Issues: Lists customer-reported issues that are resolved in this release or
known issues resolved from previous releases

- Known Issues: Lists known issues that are applicable in this release

This documentation may contain descriptions of software features that are
optional and for which you may not have purchased a license. As a result, your
specific software solution and/or implementation may differ from those
described in this document. Please contact your CSM or AE for information on
your specific features and licensing.

Packages

The following packages and dependent packages are required to upgrade to this
release to utilize all the new features of this release. These are the minimum required
versions; later versions are also supported. Separate prerequisites for each feature can
be found in the respective guides. The packages marked as (New) are new packages in

this release.

Product Latest Certified Version

(Version Name | Version Number)

Conga Collaborate [teration 111



System Requirements and Supported Platforms

The following table lists the minimum requirements for installing and using Conga

Collaborate.
System Requirement Minimum Supported Version
Browser - Firefox® (minimum supported version by
Mozilla)
- Chrome® (minimum supported version by
Google)
- Safari® (Mac only) (minimum supported version
by Apple)
- Microsoft Edge (minimum supported version by
Microsoft)

Upgrade Notes

To upgrade Conga Collaborate, see Installing and Configuring Conga Collaborate.

New Features

There are no new features in this release.

Enhancements

There are no new enhancements in this release.

Resolved Issues
The following table lists the issues resolved in this release.
Conga  Description

Internal
ID

TB-8117 Fixed a bug where certain PDFs included in documents as embedded pages were
causing issues with downloading a document to PDF.

Known Issues

There are no known issues in this release.
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Winter20.01.07 Release Notes

Conga Collaborate Winter20.01.07 Release Notes

These Release Notes contain the following information about Conga Collaborate
Winter20.01.07 Release.

- Packages: Lists packages that are required to upgrade to this release of the
product

- System Requirements and Supported Platforms: Lists requirements and
recommendations for installing this release

- New Features: Provides high-level descriptions of new features introduced in this
release, with links to more detailed information

- Enhancements: Provides high-level descriptions of enhancements to existing
features

- Resolved Issues: Lists customer-reported issues that are resolved in this release or
known issues resolved from previous releases

- Known Issues: Lists known issues that are applicable in this release

This documentation may contain descriptions of software features that are
optional and for which you may not have purchased a license. As a result, your
specific software solution and/or implementation may differ from those
described in this document. Please contact your CSM or AE for information on
your specific features and licensing.

Packages

The following packages and dependent packages are required to upgrade to this
release to utilize all the new features of this release. These are the minimum required
versions; later versions are also supported. Separate prerequisites for each feature can
be found in the respective guides. The packages marked as (New) are new packages in
this release.



Product Latest Certified Version

(Version Name | Version Number)

Conga Collaborate [teration 110

System Requirements and Supported Platforms

The following table lists the minimum requirements for installing and using Conga

Collaborate.
System Requirement Minimum Supported Version
Browser - Firefox® (minimum supported version by
Mozilla)
- Chrome® (minimum supported version by
Google)
- Safari® (Mac only) (minimum supported version
by Apple)
- Microsoft Edge (minimum supported version by
Microsoft)

Upgrade Notes

To upgrade Conga Collaborate, see Installing and Configuring Conga Collaborate.

New Features

There are no new features in this release.
Enhancements

Conga Collaborate API

You can now gather all associated items in a workgroup via API.

Resolved Issues

The following table lists the issues resolved in this release.


https://documentation.conga.com/display/CCSFWIN20AG/Installing+and+Configuring+Conga+Collaborate

Conga  Description
Internal
ID

TB-8014 PDFs no longer flip or rotate when you download a document as a PDF.

TB-8045 | In the main user list, the locked users filter now displays users locked due to
inactivity.

Known Issues

There are no known issues in this release.

Winter20.12.17 Release Notes

Conga Collaborate Winter20.12.17 Release Notes

These Release Notes contain the following information about Conga Collaborate
Winter20.12.02 Release.

- Packages: Lists packages that are required to upgrade to this release of the
product

- System Requirements and Supported Platforms: Lists requirements and
recommendations for installing this release

- New Features: Provides high-level descriptions of new features introduced in this
release, with links to more detailed information

- Enhancements: Provides high-level descriptions of enhancements to existing
features

- Resolved Issues: Lists customer-reported issues that are resolved in this release or
known issues resolved from previous releases

- Known Issues: Lists known issues that are applicable in this release



This documentation may contain descriptions of software features that are
optional and for which you may not have purchased a license. As a result, your
specific software solution and/or implementation may differ from those
described in this document. Please contact your CSM or AE for information on
your specific features and licensing.

Packages

The following packages and dependent packages are required to upgrade to this
release to utilize all the new features of this release. These are the minimum required
versions; later versions are also supported. Separate prerequisites for each feature can
be found in the respective guides. The packages marked as (New) are new packages in
this release.

Product Latest Certified Version

(Version Name | Version Number)

Conga Collaborate lteration 109

System Requirements and Supported Platforms

The following table lists the minimum requirements for installing and using Conga

Collaborate.
System Requirement Minimum Supported Version
Browser - Firefox® (minimum supported version by
Mozilla)
- Chrome® (minimum supported version by
Google)
- Safari® (Mac only) (minimum supported version
by Apple)
- Microsoft Edge (minimum supported version by
Microsoft)

Upgrade Notes

To upgrade Conga Collaborate, see Installing and Configuring Conga Collaborate.


https://documentation.conga.com/display/CCSFWIN20AG/Installing+and+Configuring+Conga+Collaborate

New Features

There are no new features in this release.

Enhancements

There are no new enhancements in this release.

Resolved Issues

The following table lists the issues resolved in this release.

Conga  Description
Internal
ID

TB-8128 You no longer receive a 500 error while downloading a template to PDF.

Known Issues

There are no known issues in this release.

Winter20.12.02 Release Notes

Conga Collaborate Winter20.12.02 Release Notes

These Release Notes contain the following information about Conga Collaborate
Winter20.12.02 Release.

- Packages: Lists packages that are required to upgrade to this release of the
product

- System Requirements and Supported Platforms: Lists requirements and
recommendations for installing this release

- New Features: Provides high-level descriptions of new features introduced in this
release, with links to more detailed information

- Enhancements: Provides high-level descriptions of enhancements to existing
features



- Resolved Issues: Lists customer-reported issues that are resolved in this release or
known issues resolved from previous releases
- Known Issues: Lists known issues that are applicable in this release

This documentation may contain descriptions of software features that are
optional and for which you may not have purchased a license. As a result, your
specific software solution and/or implementation may differ from those
described in this document. Please contact your CSM or AE for information on
your specific features and licensing.

Packages

The following packages and dependent packages are required to upgrade to this
release to utilize all the new features of this release. These are the minimum required
versions; later versions are also supported. Separate prerequisites for each feature can
be found in the respective guides. The packages marked as (New) are new packages in

this release.
Product Latest Certified Version

(Version Name | Version Number)

Conga Collaborate [teration 108

System Requirements and Supported Platforms

The following table lists the minimum requirements for installing and using Conga
Collaborate.

System Requirement Minimum Supported Version
Browser - Firefox® (minimum supported version by
Mozilla)
- Chrome® (minimum supported version by
Google)
- Safari® (Mac only) (minimum supported version
by Apple)
- Microsoft Edge (minimum supported version by
Microsoft)

Upgrade Notes



To upgrade Conga Collaborate, see Installing and Configuring Conga Collaborate.

New Features

There are no new features in this release.

Enhancements

There are no new enhancements in this release.

Resolved Issues
The following table lists the issues resolved in this release.
Conga  Description

Internal
ID

TB-8077 | Added workgroup_ids to GET calls for all workgroup-able data in Collaborate.

TB-8097 | Embedded pages now use the correct cover page headers or footers from your
selected theme.

Known Issues

There are no known issues in this release.

Winter20.11.12 Release Notes

Conga Collaborate Winter20.11.12 Release Notes

These Release Notes contain the following information about Conga Collaborate
Winter20.11.12 Release.

- Packages: Lists packages that are required to upgrade to this release of the
product

- System Requirements and Supported Platforms: Lists requirements and
recommendations for installing this release


https://documentation.conga.com/display/CCSFWIN20AG/Installing+and+Configuring+Conga+Collaborate

- New Features: Provides high-level descriptions of new features introduced in this
release, with links to more detailed information

- Enhancements: Provides high-level descriptions of enhancements to existing
features

- Resolved Issues: Lists customer-reported issues that are resolved in this release or
known issues resolved from previous releases

- Known Issues: Lists known issues that are applicable in this release

This documentation may contain descriptions of software features that are
optional and for which you may not have purchased a license. As a result, your
specific software solution and/or implementation may differ from those
described in this document. Please contact your CSM or AE for information on
your specific features and licensing.

Packages

The following packages and dependent packages are required to upgrade to this
release to utilize all the new features of this release. These are the minimum required
versions; later versions are also supported. Separate prerequisites for each feature can
be found in the respective guides. The packages marked as (New) are new packages in

this release.

Product Latest Certified Version

(Version Name | Version Number)

Conga Collaborate lteration 107

System Requirements and Supported Platforms

The following table lists the minimum requirements for installing and using Conga

Collaborate.



System Requirement Minimum Supported Version

Browser - Firefox® (minimum supported version by

Mozilla)

- Chrome® (minimum supported version by
Google)

- Safari® (Mac only) (minimum supported version
by Apple)

- Microsoft Edge (minimum supported version by
Microsoft)

Upgrade Notes

To upgrade Conga Collaborate, see Installing and Configuring Conga Collaborate.

New Features

There are no new features in this release.

Enhancements

There are no new enhancements in this release.

Resolved Issues
The following table lists the issues resolved in this release.
Conga  Description

Internal
ID

TB-7939 | Implemented a fix to correct an issue where a Logic Rule set up to return a snippet
could cause documents and templates to error instead of loading and
downloading correctly.

Known Issues

There are no known issues in this release.
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About Collaborate

Collaborate speeds up the document generation process by utilizing pre-built templates to
create proposals, quotes, invoices, and more from a variety of CRM systems in an online
format. Share digital documents and collaborate online in real-time with people
throughout your organization.

Overview

Conga Collaborate features easily configurable, "no-coding required” solutions that enable
teams to instantly generate accurate, branded documents with a couple of clicks, share it
with other stakeholders, and collect digital signature, closing deals faster. Conga
Collaborate's web-based application offers the ability to embed videos, images, forms, and
other multimedia directly into the document.

Create

Conga Collaborate offers document generation capabilities to create documents,
contracts, and presentations that are entirely customizable for your needs. You can also
create documents integrated with Salesforce.

- Create a Proposal Document / Contract / Presentation / Document Integrated with
Salesforce.

- Insert Images / Files.

- Use Text Snippets.

Customize

Customize your documents with Conga Collaborate's editing features.

- Using the Document Information Panel.

,Share

Share your documents with your prospects by emailing directly from Conga Collaborate.

Send an Online Document.



Track

Track your proposals from within Conga Collaborate to know when prospects open and
engage them.

Tracking a Document.

- Find info through the Reporting Feature.

Close

Close deals faster with Conga Collaborate's eSignature capabilities.

- Conga Sign: Integration with Conga Collaborate
- DocuSign: Integrating with Conga Collaborate



Collaborate for Users

For more information, select a topic:

- Conga Collaborate Basics

- Implementation Guide

- Installing and Configuring Conga Collaborate
- Using Conga Collaborate

- Guided Tour of Conga Collaborate

Conga Collaborate Basics

Getting started information for Conga Collaborate.

- Collaborate Product Guide

- Collaborate Technical Requirements

- Document Status Definitions

- Does Conga Collaborate Keep My Data Secure?
- Email Statuses and Events Defined

- Integrating Documents, Templates, and Content
- Introducing Online Documents to your Recipients
- July 2018 Conga Collaborate User Interface (Ul) and Document Build Updates
- Languages Available in Conga Collaborate

- Localization

- Recipient Suggestions

- Search operators in Conga Collaborate

- Send Online Documents with Conga Collaborate
- Security update: TLS 1.1/1.2

- Sorting Your Document List

- The document information panel

- User Roles and Permissions

- Using the Document Editor

- Using Your Activity Feed

- Using Your Document List



Collaborate Product Guide

Learn Conga Collaborate Basics

Creating Documents Integrated with Salesforce

Install Conga Collaborate

Salesforce: Integration and Installation Overview

Configure Conga Collaborate

Salesforce: Granting Login Access to Conga Collaborate

Salesforce: Adding the Conga Collaborate related list and buttons to page layouts
Salesforce: Install Conga Collaborate related lists and button

Salesforce: Relating objects to Conga Collaborate objects

Salesforce: Using the Incoming Data tool

Salesforce: Using the Outgoing Data tool

Salesforce: Creating auto-generated tables

Microsoft Dynamics: Integrating with Conga Collaborate

Using Conga Collaborate

Adding a new user

User roles and permissions

Differentiating user roles and permissions

Getting started with Theme Builder

Creating a Template

Grant Login Access to your Conga Collaborate User
Including call to action buttons

Copy and paste from Microsoft Word



Working from the document table of contents
Using the editor

Inserting variables into content

Conditional content

Hiding or showing content in Sections and Pages: Logic Builder

Deploying Conga Collaborate

Conga Collaborate Deployment Guide

Collaborate Technical Requirements

General Technical Requirements: Collaborate is a mobile-enabled, web-based platform
that you can access from any computer or mobile device with access to the Internet. You
can view published documents by using any recent version of these web browsers:

- Google Chrome

- Firefox

- Safari

- Internet Explorer (Edge)

Salesforce Technical Requirements: Managed package installs cannot change the
permissions on standard Salesforce profiles; for this reason, we recommend moving all
users who will need Collaborate access to a custom profile before installing the managed
package. Ensure profile and org permissions are set to use Collaborate.

To ensure your profile permissions are set correctly

1. When installing Conga Collaborate, select install for All Users. If you did not initially
install Collaborate for all users, you can reinstall and select install for ALl Users or
you can modify the object and field-level security for each object in the Collaborate
managed package as well as give access to the necessary Visualforce pages.

2. To edit Profile permissions, navigate to Setup > Manage Users > Profiles.

For every Profile that uses Collaborate, make sure the following are true:

- Read/Write access to all custom Collaborate objects (Documents, Proposals,
Content, Logs)
- Read/Write access to all fields on the Collaborate objects



- Minimum of Read access for all fields mapped in the Collaborate Salesforce
integration settings
- Access to all visualforce pages starting with the namespace tinderbox

Document Status Definitions

Collaborate documents have six possible statuses: Draft, Open, Accepted, Declined,
Voided, and Pending Approval.

Document statuses give you insight into the part of your process that a document is in.
Using document statuses, you can determine whether a document is being created and
worked on, has been published and sent to the client, or has been signed or declined by your
recipient. In addition, the Pending Approval status tells you that a document has been
submitted into a Salesforce approval process.

Definitions

- Draft - an unpublished document. This document is editable and cannot be sent to
recipients

- Open - a published document. This status indicates it is ready to be sent to recipients.
Documents that are currently being versioned also have this status. The majority of
the document is no longer editable outside of document properties found in the
Properties panel.

- Accepted - a document signed by the client (either using Octiv e-signature, DocuSign,
or upload signed PDF for acceptance). Accepted documents cannot be deleted unless
first marked as Voided, can no longer be versioned, and are no longer editable outside
of a few document properties located in the Properties panel.

- Declined - a document either declined by the client or manually marked as declined
by a Collaborate user

- Voided - a document that has been marked as no longer valid. A published document
can be marked as Voided at any point, even if it has not been Accepted by the client.
Voiding a document is irreversible and cannot be undone

- Pending Approval - a document that has been submitted into a Salesforce approval
process. This status requires that a Salesforce integration is present and also that
the Collaborate/Salesforce approval process integration has been configured.



Does Conga Collaborate Keep My Data Secure?

Absolutely. Keeping your data secure is our top priority. You can feel 100 percent confident
that we're protecting your Collaborate electronic assets to ensure they remain
confidential, available, and intact.

Collaborate is committed to protecting assets from all threats, whether internal or
external, deliberate or accidental. And we always will be.

We encrypt your account information and data, and we store it by using Amazon's
premiere cloud-hosting servers. Our automated backups of your information happen many
times each day. In other words, we're doing everything possible to keep your information
safe.

Email Statuses and Events Defined

There are three email statuses noted in the people tab of your documents depending on the
lifecycle of the email:

- Waiting on email status - This is the first email status you will see after an email is
sent. Once the email has been delivered or bounced, this status will update
accordingly.

- Bounced - If a server cannot or will not deliver a message, the email provider fires a
bounce event. Bounces are often caused by outdated or incorrectly entered email
addresses. Many times you won't know a bounced email address until it bounces. This
event can help identify which addresses should be removed from your lists to ensure
they don’t bounce again.

- Delivered - When an email is accepted at the receiving server, a delivered event is
generated.

There are also a variety of email events that can cause confusion without proper definition
and understanding. Below are helpful insights to have if/when notifications are received.

- Processed - When the email provider receives an individual message and prepares it
to be delivered - think of this as the top of the funnel (unless it is dropped), each
message pushed to an email provider will create a processed event.

- Dropped - There are a number of reasons your email may not be sent to a recipient
for delivery. This event will not only let you know an email has been dropped, it also
provides a reason, such as possible spam content (if spam checker app is enabled) or
if the recipient previously unsubscribed.



- Deferred - When an email cannot immediately be delivered, but it hasn't been
dropped, the deferred event fires. Sometimes called a soft bounce, the email provider
will continue to try for up to 72 hours to deliver the message.

- Bounced - If a server cannot or will not deliver a message, the email provider fires a
bounce event. Bounces are often caused by outdated or incorrectly entered email
addresses. Many times you won't know a bounced email address until it bounces. This
event can help identify which addresses should be removed from your lists to ensure
they don’t bounce again.

- Delivered - When an email is accepted at the receiving server, a delivered event is
generated. This event does not guarantee the email was placed in the recipient’s
inbox. In fact, a delivered email is only the beginning of an opaque process. The
remaining four events begin to give us hints about whether anyone will ever see this
delivered emaiil.

- Open - An opened email is the first step toward the action you want your recipient to
take. This event fires every time the email is viewed with images turned on. Like all
emalil service providers, our email provider uses a transparent image beacon to track
opened messages. This beacon is currently the only way a sender can tell if an emaiil
has been opened.

- Click - The pinnacle of email engagement is the click. Your call to action, whether it is
to confirm a newly registered account or to view a recommended product, asks the
recipient to click a link. The email provider tracks that interaction and executes a click
event.

- Spam Report - Most internet service providers (ISP) provide a feedback loop, sending
specific spam complaints to the email service providers. When the email provider
receives a notice, it triggers a spam event. It is recommended to remove any email
address that triggers this type of event from mailing lists to protect the sending
reputation.

- Unsubscribe - Reacting immediately when a recipient unsubscribes from your
mailings, by removing the email from your lists, can pay long-term dividends to your
sending reputation and deliverability rates.

Integrating Documents, Templates, and Content

You can build three main document types in Collaborate:

Proposal / Contract / Presentation documents are the end products you will send to your

recipients. You can build these from scratch or from an existing Template document.



Template Documents are standardized shells that you can personalize when you build
Documents for specific situations and clients. Templates simplify your document creation
by giving you a starting point.

Content includes Content, Images, Files, and Text Snippets that you may use in your Conga
Collaborate documents. Upload any Content, and it hangs out in your Content Library,
ready to be popped into the next document you want it for.

Themes govern the look and feel of your content for both Template and Proposal document
types.

Maintaining Master Copies with Referenced Content

For a piece of content that is identical across multiple templates—say, a Terms &
Conditions page that you use for different industries and so in different templates—
Referenced Content enables you to keep a master copy in your Content Library.

Instead of maintaining the Terms & Conditions page on each template and having to
remember which templates in your library contain Terms & Conditions, you can use
Referenced Content to pull the right content and the right template. Any updates you make
to the Terms & Conditions master copy in the Content Library will flow through to the
Templates where it's been added as Referenced Content.

Any Documents created from those Templates using Referenced Content will have the up-
to-date Terms & Conditions when you create them.

Introducing Online Documents to your Recipients

Not everyone you send Collaborate documents to has experience with our platform or
electronic documents in general. Most recipients are familiar with e-mail, but may still
expect contractual documents to be sent via fax or USPS. Easing the transition from a
paper/wet signature approach to the fast, easy eSignature process is paramount to a
fantastic recipient experience.

Providing more information at key points of the workflow can ease the recipient’s transition
from the paper process to the fast and easy electronic one. The language in the example
below is helpful for giving recipients a quick rundown of what they’ll do after they receive
access to your documents. It's all yours if you'd like to use it.

You may find that including the verbiage above or something similar will answer all of your
clients' questions about the new process before it even begins. However, we have found that
some recipients may need further instruction once they’ve landed in the document itself.



Providing a Cover Letter as the first page of the document you are sending is a good way to
continue to lead the client in this new process.

This cover letter can explain the various pieces of the electronic document the recipient is
currently seeing. Mentioning the important pieces like the Table of Contents on the left-
hand side for navigation throughout the document and reiterating the Calls to Action at
the top of the document are both good callouts for your recipients. You can also inform
them of the Next Steps panel and it's role in providing context for the status of the
document. If you have enabled features to allow your recipients to create Change Requests
or Add New Recipients, the Cover Letter is a great place to call these actions out.

Easing your recipients' transition to electronic document delivery and acceptance doesn’t
have to be complicated. Providing simple, instructive information at key points in the
workflow can go a long way to answering your new recipients' questions. If you have any
other creative ways you’ve helped your recipients with the transition please let us know!

Hello [NAME],

I've created a [QUOTE / PROPOSAL / CONTRACT] for your review in [MY COMPANY NAME]'s
secure online document management system. Click the link below to log into the document,
review terms and pricing, ask questions, and submit your electronic acceptance of the
agreement.

A few notes for your convenience:

- In the upper right corner of the screen, you'll see buttons labeled [List Call to Actions]

- An authorized signer may click [Accept] to submit a legally binding electronic
signature for the pricing and terms described in the document.

- Click [Ask a Question] to submit a note to me, and I'lL follow up with you shortly.

- If you need to review this document offline, click the button labeled Download at the
bottom of the left-hand menu to produce a PDF copy.

Thanks for your consideration and please let me know if you have any questions.
Best Regards,
[SIGNATURE]

July 2018 Conga Collaborate User Interface (Ul)
and Document Build Updates

To enhance the user experience within our platform, Collaborate changed the user
interface and document build view. These changes take effect July 22nd, 2018 at 6PM EDT.



Tabs within the Properties menu

Along the right-hand side of a Collaborate document is the document panel. In an effort to
shorten the length of this panel and reduce the need for users to scroll down to find
important options, several tabs were added to the Properties menu. Updates to the tabs
include:

- Details - The Details tab is a place for the document owner to edit information about
this document. Iltems that can be edited within this tab are Title, Client, Description,
Tags, Template, Owner, Value, Expiration Date, and any Document Relationships.

- Design - The main benefit of Collaborate documents is being able to style them
according to your company’s brand preferences. This style is controlled by a Theme.
Now, you can access any themes you have available to choose from in this Design
tab. Simply use the drop-down menu to select which theme you would like to apply to
your document.

- Metadata - A third tab available in Properties is the Metadata tab if enabled in your
account. Here we can add important information about this document that others
may need to use to search for or report on later. Metadata templates need to be set
up by a Collaborate administrator, but, once they are, users can use the drop-down
menu to choose which metadata they need to apply to their document.

- Privacy - Collaborate takes privacy seriously, so we wanted users to be able to
control these settings quickly and easily. In this tab, users can enable an access code
for their document, share it with specific workgroups, or simply make it public or
private.

- Options - The last tab under the Properties menu is Options. In this tab, users can
allow for a PDF download of their Collaborate document, enable a Cover page, add
a Signature Page to the PDF download, and enable the Table of Contents to print. All
of these options change the download behavior of your Collaborate document.

Integrations tab in the Document Panel

Another important change to the Document Panel is the addition of an Integrations menu.
When users click Integrations, on the right-side document panel, they can see a list of their
integrations for that document (i.e. Docusign, Salesforce). These can be toggled off and on
as needed. Users can also see which Salesforce Opportunity their document is linked to or
even change it in this tab. This is now where users will navigate to in order to Refresh
Variables from their connected CRM.



Content Menu

The next change to the document panel is the addition of a Content Menu (previously
called Assets). Here users can access Files, Images, Pages, Text Snippets, and Variables to
add into their document or they can add new Content with the Add New button at the top
of this menu.

Assets = Content

The term Assets is changed to Content in all other aspects of Collaborate as well to allow
for more intuitive user experience.

Content Pages = Pages

Content Pages have been simplified to Pages throughout the application.

For more information about Content, see our support article on the topic.

Version Menu

Collaborate allows users to create multiple versions of their documents. To make this
process easier, the Versions menu was updated. The New Version button is readily
available at the top of this menu along with a drop-down menu to see other versions of the
document. This is also a great place to double-check whether you are working on the most
current version of a document.

Download Button

The Download Button has also moved from the Table of Contents to the bottom of the
right side Document Panel, making this functionality more accessible and intuitive.

Languages Available in Conga Collaborate

Collaborate has many languages available for the user interface.

Many Collaborate customers prefer to use our platform in a language other than English.
The following languages are currently available for the Collaborate user interface:

- Danish
- German
- Spanish



- Finnish

- French

- Hungarian

- Dutch

- Polish

- Portuguese (Brazil)

- Swedish

- Turkish

- Chinese (People's Republic of China)
- ltalian

Localization

Collaborate provides you with a variety of language options.

Our new platform gives you more language options than ever. Collaborate now comes
ready to work in 15 languages and currencies. Follow these steps to select a language (and

currency) for your account:

1. From your Administration Settings view, click Account Settings icon from the table of
contents panel on the left

2. Click the General tab

3. Choose your language from the drop-down menu on the right

Languages supported:

- English

- Chinese (People’s Republic of China)
- Danish

- Dutch

- Finnish

- French

- German

+ Hungarian

- ltalian

- Polish

- Portuguese (Brazil)
- Spanish

- Swedish

- Turkish



Recipient Suggestions

When sending a document, a list of several potential recipients will display as you begin to
type in the name field. In the example below, when the letter “d” is typed, several potential
contacts that begin with that letter are now available to quickly add.

Once a recipient is selected, the rest of the fields populate automatically if that data is
available.

Search operators in Conga Collaborate

You can create search operators while using the advanced search bar to filter documents
and content.

Collaborate has search operators that can be used in the search bar to quickly narrow
documents by particular attributes.

The default search behavior in Collaborate is very broad and tends to return more results
than you want. This is because when you search on a term by typing it into the search bar,
our search engine looks not only through all document attributes to find your search term
but also combs through the bodies of the documents themselves. Using search operators
tells Collaborate to only search for your value in a particular document field.

The following search operators are supported:

- author

+ type

- status

- client

- tag

- owner

- updated
- name

- viewed
- value

- archived

Search operators can be used in the search bar on both the Documents and Content
libraries. To use the search bar, type the search operator followed by a colon and the value
you want to find:

- name: ABC Company Proposal



- tag: new business
- author: Jane Doe

Multiple search operators can be used in a single search, and you can save searches for
later use. You can also use the advanced search tool in order to use more search operator
options and also to build more complex search statements.

Finally, when using search operators related to dates or numerical values (updated, value,
or view, for example), you can set up dynamic interval searches to find what you need.

Some examples:

- updated: < 1day ago

- updated: < 8 hours ago
- updated: March 5

- updated: March 5th

Syntax matters when using this type of search. You must enter the search terms with
spacing exactly as described. For example, searching with something like updated: <2 days
ago will return results but they won’t match the filter you're trying to use.

Send Online Documents with Conga Collaborate

Conga Collaborate gives you the ability to send documents online instead of sending an
offline attachment like a Word document or a PDF. Offline documents affect the recipient’s
viewing experience and Limit some of the advantages of sending from Conga Collaborate
directly.

Delivering Online vs. Offline

- By keeping the experience online with Conga Collaborate, your recipient is able to
open your document from the device most convenient for them. Instead of waiting to
get back to a Laptop or Desktop, your client can open the document from a mobile
browser.

- Conga Collaborate online sending allows you to deliver responsive web pages
instead of a static PDF that doesn’t allow recipients to change the font size.

Delivering Online Documents to Your Recipients

Most recipients are familiar with email, but may still expect contractual documents to be
sent via fax or USPS. Providing more information at key points of the workflow can ease the



recipient’s transition from the paper process to the fast and easy electronic one. You can
use the template at the end of the documentation below in your email to your recipient.

Including the verbiage in the template, or something similar, helps answer your client's
questions about the new process before it even begins. Providing a Cover Letter as the first
page of the document you are sending is a good way to continue to lead the client in this
new process. This cover letter can explain the various pieces of the electronic document the
recipient is currently seeing. Mentioning the important pieces like the Table of Contents on
the left-hand side for navigation throughout the document and reiterating the Calls to
Action at the top of the document are both good callouts for your recipients. You can also
inform them of the Next Steps panel and its role in providing context for the status of the
document. If you have enabled features to allow your recipients to create Change Requests
or Add New Recipients, the Cover Letter is a great place to call these actions out.

Conga Collaborate provides you with a number of different ways to deliver the document
depending on your needs and recipient experience preferences. The sections below outline
the advantages of each of the three main delivery methods available in Conga
Collaborate.

Custom Recipient Link From Conga Collaborate

The most common method, and the one that provides the highest level of automation for
your recipients, is sending them a custom recipient link directly from Conga Collaborate. By
utilizing this method, you will be sending an email from the Conga Collaborate platform
and will allow your recipients to click one link and automatically log into the document. We
recommend this method for the majority of workflows as it provides the smoothest
experience for your recipients.

All Conga Collaborate emails are optimized for deliverability, however, to ensure proper
delivery of emails to your inbox, we recommend you:

- Add Conga Collaborate.com to your whitelist, also called the Approved Safe and
Senders List
- Update your email filters to includeoctiv.com

To add people to the document manually

1. Open your document and click on the People tab on the right-hand panel.

2. Click Add People.

3. Type in the First Name, Last Name, and Email Address of your recipient (you can add
additional recipients at this time by clicking Add Another Recipient).


http://Collaborate.com
http://includeoctiv.com

4. Click Submit to add the recipient(s) to the document. The fastest way to add people
to your document is to add them from your CRM. With the Conga Collaborate
document sharing experience, users can easily send documents to CRM contacts from
within Conga Collaborate. Today, the Conga Collaborate document sharing
experience supports the ability to add contacts from Salesforce, NetSuite, and
Pipedrive.

5. To add recipients from CRM, click the People tab.

6. Click Add People.

7. Click Add [CRM Name] Contacts (ex: if you use Salesforce, the button would read
“Add Salesforce Contacts”).

8. Choose the signing permissions for each added Contact (Conga Collaborate defaults
to making each Contact a Collaborator). Editing permissions will also allow you to
change actual contact info as well.

9. Click Submit.

If you have already published the document you will get a modal that asks if you'd
like to send the email now. If you are in a Draft state the recipients will be listed in the
People panel. Once you publish the document a Send Email button will appear on the
People tab as well as a Send Email Llink on the Next Steps tab.

Finally, Conga Collaborate tracks email status, allowing you to see who has
received an email by looking at the individual business cards for each recipient on the
People tab. An email icon will appear on the card indicating the date and time the
email was sent.

If additional follow-up is needed, document owners can send multiple emails to the
same recipient. Go to the People tab, click Send Emaiil, and select the email addresses
of the recipients.

Custom Recipient Link from Your Preferred Email
System

There are some cases where you may not want to send an email directly from Conga
Collaborate. (Ex: you are already working in another email chain with your recipient and
you'd like to keep the context of the email history.) In this case, Conga Collaborate provides
an easy way for you to pull out the custom recipient URL to send directly to your recipient.
This provides very similar benefits to the first method but takes you out of the Conga
Collaborate platform to send your emails.

1. To customize recipient links from your email, repeat the steps from the earlier section
to add recipients to the document.
2. Publish the document.



3. Instead of sending the email from Conga Collaborate, go to the People tab on the
document and click on “[Recipient’s Name] Unique document URL” to show the Unique
document URL for each Recipient.

4. Copy this URL and paste it into your own emaiil system to send to your Recipient.

Public URL from your Preferred Emaiil System

There are some cases where the private, custom recipient link is not necessary, and
allowing a recipient to log in to the document using a public link would be simpler. In these
cases, Conga Collaborate provides a public link to allow a recipient to navigate to a
document, enter their first and last name, and view the document. Using a public link
allows many people to view the document without the document owner having to explicitly
define recipients. This method is most useful for sending out a document to a large number
of people. As people log into the document, Conga Collaborate will track viewer
information through the name each person enters in order to view the document (along with
view count, view time, etc.). The other benefit to this method is that it allows you to send out
a document for acceptance when you are not sure who the signer should be on the
document. Using the Public URL and Conga Collaborate’s eSignature process, the first
person to click the Accept button is the one to sign the document.

1. In order to access the Public URL for your document Open the document.
2. Open the Properties tab.

3. Copy the link in the “View” bar at the top of the Properties tab.

4. Send the link to your recipients.

As soon as you add People to the document, only a person marked as a signer
will be able to sign. Those who view the document through the Public URL will
not be able to sign. In other words, if you follow the steps to add someone to
the People tab, they will be the only recipients to see the Accept button. If you
send out the Public URL to your recipients, anyone will be able to log in to the
document and click Accept.

Hello [NAME],

I've created a [QUOTE / PROPOSAL / CONTRACT] for your review in [MY COMPANY NAME]'s
secure online document management system. Click the link below to log into the document,
review terms and pricing, ask questions and submit your electronic acceptance of an
agreement. A few things to note:

- In the upper right corner of the screen, you'll see buttons labeled [List Call to Actions]



- An authorized signer may click [Accept] to submit a legally binding electronic
signature for the pricing and terms described in the document.

- Click [Ask a Question] to submit a note to me, and I'lL follow up with you shortly.

- If you need to review this document offline, click the button labeled Download at the
bottom of the left-hand menu to produce a PDF copy.

Thanks for your consideration and please let me know if you have any questions.
Best Regards,
[SIGNATURE]

Security update: TLS 1.1/1.2

This documentation provided information about using TLS 1.1/1.2.

To maintain the highest Level of security standards and comply with industry-wide best
practices, we sometimes need to make security improvements. Recently, that meant
disabling TLS 1.0 connections so we comply with higher encryption standards.

The Transport Layer Security (TLS) protocol ensures privacy between communicating
applications and their users on the Internet. When a server and client communicate, TLS
keeps third parties from eavesdropping or tampering with any message. TLS is the
successor to the Secure Sockets Layer (SSL).

To disable TLS 1.0 and enable TLS 1.1 or 1.2

1. In Internet Explorer, select Internet Options from the Tools menu.
2. Click Advanced to see the following options:
- Use TLS 1.0
+ Use TLS 11
- Use TLS 1.2
3. Check 1.1 or 1.2. If both 1.1 and 1.2 are unchecked, the recipient will be unable to view the
document. If your recipients can ensure that 1.0 is not the only option checked, they
should be able to view the document as expected.

Sorting Your Document List

Using the Sort By option in the Document List view allows you to sort through the content in
the main list that appears in the center section. For any sort, you can choose the order—for
example, oldest to newest (or vice versa) or A to Z (or Z to A).

When you're showing All Documents, you can Sort By:



- Date Modified
- Title
- Author

If you select the Proposals filter from the lefthand panel, you can Sort By:

- Date Modified

- Accepted Date

- Client Name

- Published Date

- Created Date

- Title

- Value

- Author

- Status (Accepted, Declined, Drafts, Open)
- Last Viewed

The document information panel

When you're in Document List view, a Document Information Panel appears on the right side
of your screen.

This panel dynamically changes to give statistics about the documents you've selected or
filtered for. The statistics include:

- A count of documents broken down by status
- A donut chart of documents by status
- The total dollar value

To drill down on details, add a search filter to the advanced search bar.

User Roles and Permissions

Collaborate provides you with three default user roles that define a user's access to
functions and documents and establish privacy hierarchies.

System Administrator

Has full access to everything in the account. Can view and edit all documents and
templates as well as access all available account settings



Manager

Has view and edit access to any documents generated by users set up as either their
Manager or their Report in the User Relationship Hierarchy.

Standard User

Can create documents and templates, can manage his or her personal settings, and can
view but not edit others' documents and templates.

New users that you create default to the Standard role. To change the default role a user

is assigned to:

From your user dropdown, go to Administration > Roles and Permissions.

Click the role to which you want to add users.

Click Add User.

Select the checkbox next to users you want to add to the role.

Click Add Users. Permissions in default roles are not customizable, but you can create
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a custom role and then customize any specific user permission within that role.
Contact your Account Manager for assistance in changing user permissions for a
custom role.

Using the Document Editor

Documents and Templates created in Conga Collaborate are web-based.

When drafting a document or template, you will find the editing toolbar located across the
top of the page, called the editor. The editor provides easy formatting tools to directly
manipulate the HTML that your content is built on.

Collaborate's robust, online editor allows you to build web-based templates, documents,
and content pages directly in Collaborate. And while many of Collaborate's features allow
you to streamline and automate document creation through your templates and data-
driven logic, we understand that many clients have use cases that involve manual
customization of a document before sending. Collaborate's editor gives your users the
flexibility to edit content online in their documents before sending, even after starting from

a template.

Here's a quick rundown of tools in the editor toolbar:



Tool Action

Table of Opens/Closes the Table of Contents

Contents

File Convert to Template, Delete, Duplicate, Back to Documents

Edit Cut, Copy, Paste, Select AlL, Find and Replace, Show Blocks, Source Code

Editing source code is helpful for technical admins or users who would like to
directly edit the HTML of the document. This feature is not available on
contracts.

Insert Insert images and other types of content, tables, anchors, links, special
characters or page breaks; add content through Responsive Layout

Format Headings, Blocks, Alignment, Font, Size, Line Height, Strikethrough, Subscript,
Superscript

Table Insert or edit a table

Undo the last action

—

Redo the last action

Bold the selected text

[talicize the selected text

Underline the selected text

Left align the selected text

Center the selected text

Right align the selected text
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Tool Action

Add bulleted list - choose bullet style from dropdown menu

Add numbered list - choose number style from dropdown menu

Decrease indent

Increase indent

Add a link

Edit an image

Clear formatting

Change text color

Change the background color

Turn Spell Check on or off

Insert a variable

Change the Font Family

Saved status Updates automatically (with each edit to the page) to show when the document
indicator was last saved.

’7 Expands/collapses the Document Header



Using Your Activity Feed

Your Activity Feed is front and center whenever you are in the Dashboard view. It shows all
of your account activity and makes keeping track of document status a snap.

Your activity feed shows when a document has been

- Created

- Updated

- Published

- Accepted

- Declined

- Commented on

Your activity feed resets each calendar month. From each activity in your feed, you can:

- Click the document or content title to go to the file referenced.
- Comment on the activity by clicking the quote bubble icon.

Using Your Document List

Whenever you click Documents from your dashboard or main dropdown menu, you're taken
to your Document List. This list shows all the documents you have access to, unless you
choose to narrow it down.

You can filter your Document List just by clicking on one of the attributes of a document—
type, author or status—and you can change how the list is sorted by using the Sort By
button at the top left.

Clicking a document name will open that document.

Implementation Guide

An implementation guide for Conga Collaborate.

Access Your Conga Collaborate Account

How to access your new Conga Collaborate Account.
Account Confirmation and Login



To access your new Collaborate account, you'll need to
confirm your user and set a password

1. You'll receive an email with the subject line Confirm Your [Organization] Account after
your user is created in Collaborate. Click the Confirm Account button to confirm your
email address and enable Collaborate to properly send documents and notifications
through your user.

2. Once you've clicked the Confirm Account button, you'll be prompted to set a
password in the New Password and Confirm Password input boxes before logging in
for the first time. All users created in your account will need to go through this initial
email confirmation step. However, if you are adding users in bulk, the user will not be
prompted to change his/her password. Users will need to manually complete that
step in their User Profile.

Conga Collaborate Implementation Guide

The goal of this guide is to help get started with your new Conga Collaborate account.
Welcome to Conga Collaborate!

The goal of this guide is to help get started with your Conga Collaborate account. To
begin, select one of the following options:

Access Your Account
Get Started with Document Creation

Integrate with Salesforce

Get Started with Document Creation

Get Started with Document Creation. Create, customize, share, track, and close a Conga
Collaborate document.

Create a Collaborate Document

Create your first document from your Collaborate org in standalone mode. In a later step,
you wull integrate Collaborate with your CRM, but we suggest you go through these steps
first to give yourself an introduction to the document lifecycle.

To create a document, take the following steps:

1. From the Dashboard, clickCreateand then select Proposal.
2. Select Start with a template in the pop up menu.



3.
4.

Choose your starting template, or select Start with a blank proposal instead.
Click Create.

Customize a Collaborate Document

To customize your document, take the following steps:

1.

Note:

Open the Properties panel on the right side of your screen, and click

the Metadata tab. Fill in all the fields in the tab.

Click back on your proposal page to customize specific content using the
online Editor.

Enable the Previewbutton for a preview of how your content will look after you
publish it.

As an admin, you can control which users have access to make edits in documents

and which pages are editable.

Share a Collaborate Document

To share your document, take the following steps:

1.

Under Next Steps on the right side of your screen, go to Properties and click Publish
Now.

Click Add People under Step 2. Enter your recipient's first name, last name, and email
address, and then click Add Another Recipient until all of your recipients are added.
We recommend adding yourself a test recipient. When all your recipients are added,
click Next.

Click Send Email Now.

Click the Include all recipients link under the first input box, or click the input box and
select your recipient(s).

Enter an email message or use the default, and click Send.Collaborate sends an
email on your behalf with a link for your recipient(s) to view the document.

Track a Collaborate Document

Tracking Report statistics are available once your recipients interact with the document. To

view the tracking report, take the following steps:

1.

2.

From your document, go to Next Steps on the right side of your screen and

click View > Tracking.

Click the View Full Report button to see who viewed the document and where they
spent their time.

Look for Text and Email Notifications as prospects open and engage with your documents.

Notifications are based on each user's notification preferences as configured in their User
Profile.



Close with Collaborate eSignature Options
Conga Collaborate offers the following eSignature integrations:

- Conga Sign: Integration with Conga Collaborate
- DocuSign: Integrating with Conga Collaborate

Installing and Configuring Conga
Collaborate

Information on installing and configuring Conga Collaborate.

Updating Recipient Digital Business Cards

A Digital Business Card is an easier way to access key contact information from within your
Conga Collaborate document.

Collaborate uses digital business cards to display LinkedIn profile information and photos
for all document recipients. This information is pulled from the database of third-party
vendor FullContact.

FullContact recipient data can become outdated and present incorrect information.
Updating FullContact's database ensures that all data is current.

Visit FullContact's privacy center and click Own Your Personal Data. Here you can update
the information in the FullContact database and Collaborate's digital business cards will
update accordingly.

Adding a New User

Collaborate administrators can maintain their users’ account information in the
Administrative area of Collaborate.

Admins can create, edit, and remove users. This article will specifically walk through
considerations when creating new Collaborate users.

To add a new user by following these steps:

1. From the User Drop Down menu in the top right corner of Conga Collaborate (your
avatar), click Administration.

2. Click Users.

Click the orange Add User button on the top right of the Users screen.

4. Create the new user account by filling in the name, email address, and username.

w


https://www.fullcontact.com/privacy-center/

5. Optional: You can use the External Integration ID to proactively link a user’s
Collaborate account to their CRM account if you have their CRM user ID. This is not
required and will happen automatically when the user attempts to create a
document from your CRM later.

6. Optional: You can enter additional user information such as mobile phone number,
time zone, and language on their profile at this time.

7. Click Save. Upon clicking Save, Collaborate sends the user a new account
confirmation email containing their username, Collaborate domain, and a link to
confirm their account and set their password.If you need to change details of the user
later, you can do so from the Users menu, by clicking on the user you'd like to edit.New
Collaborate users are automatically added to the “Standard User” role. If you'd like
to give a user more or less permissions, edit their role under “Roles and Permissions.”If
you have a lot of users to add at once, you might want to consider adding users via
bulk upload.

Authenticating Your Email Domain

If you've chosen to send Collaborate emails from your team’s email domain, rather than
the default address noreply@octiv.com, you will want to set up email authentication to
help ensure your emails reach the inbox of your recipient.

Email Service Providers (ESPs) rely on authentication to fight spam, prevent phishing, and
provide protection against other forms of fraud, which makes it an important step to take.
Many ISPs use authentication to help track sender reputation. Authenticating your email
domains will reduce the chances of your emails going to your recipients’ spam folders.
Finally, some email clients will show a warning message if they are unable to verify the
sender is sending from an approved IP address. For the best customer experience, be sure
authentication is set up so those alerts don’t show.

Once domain authentication has been set up, emails will be sent with a signature that
matches a record in your DNS (Domain Name Servers). This way, ESPs have a way to ensure
the sender is legitimate. Emails that do not pass authentication may be blocked or put
through additional scrutinization, and in some cases will not make it to the recipients’
inbox.

Since each email provider is different we cannot give you exact steps to update your
records; however, here are instructions for some commonly used hosts:

123-reg.co.uk

bluehost


mailto:noreply@octiv.com
http://www.123-reg.co.uk/support/answers/Domains/Domain-Configuration/how-do-i-set-up-a-txt-record-on-my-domain-name-1199/
https://my.bluehost.com/cgi/help/559

DNS Made Easy

DNSimple

GoDaddy

Hostgator

Hover

Media Temple

Namecheap

Network Solutions

Configuring Custom Roles and Permissions

Roles & Permissions control what each user can see and do within your Collaborate

organization. Set up custom roles when the three default roles do not meet your business

needs. Also, use the tool to clone a default role and make small changes.

In most cases, it is not necessary to set up custom roles and permissions. If you do feel you

need a custom role, we recommend contacting our support team to discuss your business

needs and determine if a custom role is necessary.

To configure custom roles:
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From your user dropdown, select Administration.

Click Roles & Permissions.

Select Create New Role.

Enter a descriptive name in the Role Name field.

Click Add User and select any and all users you wish to assign to this role.

Select default permissions by clicking Permissions and selecting default permissions
from the dropdown.

Customize permissions as appropriate for the role you've created. Filter to specific
collections of permissions using the categories in the left-hand panel, or use the
search field to find the permissions you want.

Click Save. When setting permissions, an empty checkbox next to specific permission
or a set of permissions indicates NONE of the individual qualifiers are selected. A “-”
means at least one qualifier is selected, and a checkmark means ALL qualifiers are
selected.


http://help.dnsmadeeasy.com/records/txt-record/
http://support.dnsimple.com/articles/advanced-editor
https://www.godaddy.com/help/add-an-spf-record-19218
https://support.hostgator.com/articles/cpanel/how-to-change-dns-zones-mx-cname-and-a-records
https://help.hover.com/entries/21204757-how-to-edit-dns-records-a-cname-mx-txt-and-srv
https://kb.mediatemple.net/questions/60/How%2bcan%2bI%2bchange%2bthe%2bDNS%2brecords%2bfor%2bmy%2bdomain%3F
http://www.namecheap.com/support/knowledgebase/article.aspx/317
http://www.networksolutions.com/support/how-to-manage-advanced-dns-records

Customizing Your Document Login Screen

By using Conga Collaborate’s Theme Builder, you can make your login screen your own by
adding a logo, background color, images, and other custom design elements.

Collaborate's Theme Builder allows you to customize the look and feel of your document
login screen.

The document login screen is only seen by recipients accessing a document through the
public URL.

Give customers a branded experience with your documents by adding a logo, background
color, images, and other custom design elements.

From your user drop-down menu in the top right corner, click Administration.
Select Themes.

Choose a theme to edit.

In the dropdown at the top of the right-hand menu, select Document Login.
In the right-hand menu, choose Login to view login screen settings.
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Customize your login screen with things like a logo, page background, text font, and
login button colors.
7. Click Save.

Deleting a User from Your Account

Easily delete a user from your Collaborate account. When a user doesn’t need further
access to Collaborate, you can delete that user.

To delete a user from your account:

From the Administration view, click Users.
Use the Search Bar or scroll through the user list to find the desired user.
Click on the name of the user you would like to delete.
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Click the Remove User button on the top right.
Things to consider when deleting a user:

- Deleted users retain their associated usernames and email addresses. If you'd
like to assign these to a new user in the future, the deleted user’s credentials
must be changed.

- Deleted users can be restored and will reclaim ownership of any documents
that have not been reassigned.



- Open documents owned by deleted users are still accessible and actionable by
recipients.

- Deleted users will continue to receive email notifications related to any open
documents they own. To avoid this and redirect notification emails, you may
consider transferring ownership of these documents to an active user.

Differentiating user roles and permissions

Standard Users, Managers, and System Administrators are the three roles within the
Default Permissions set that cannot be altered.

The following chart gives a detailed overview of what each of these roles can do within

Collaborate:

Conga Collaborate Function = Standard User Manager System
Administrator

Create presentations, proposals, | x X X
contracts, templates, and

content

Publish and send documents X X X
Access and edit own material X X X
Access private documents of X X X
direct reports

Assign documents and assets to | x X X
other users

Edit public or private documents X X
of direct reports

Edit private templates of direct X X
reports

Lock or unlock private items in X X

the assets library

Edit user roles and settings X



Conga Collaborate Function = Standard User Manager System
Administrator

Edit manager and reporting X
settings

Edit account settings X
Edit roles and permissions X
Create and edit themes X
Manage integrations X
Create and edit signals X
Manage tags X

Enhanced security controls

Use Collaborate's enhanced security controls to customize your organization's security.

Configure your security controls just as you want them. If you are a system administrator,
you can set password strength, session timeout, lockout attempts, and more under your
Account Settings.

Collaborate offers new enhanced security controls such as:

- Custom-configured password rules to manage failed login attempts and user lock
outs

- Password length and strength restrictions

- Password reset prompts

Check out the options from your Account Settings when you click User Password Rules to set
your controls. Your account manager can tell you more.

Ensuring Delivery of Conga Collaborate-Branded
Emails

Ensure email settings are optimized to receive Collaborate emails.



All Collaborate emails are optimized for deliverability however, to ensure proper delivery of

emails to your inbox, we recommend you:

- Add Octiv.com to your whitelist, also called the Approved Safe and Senders List
- Update your email filters to include Collaborate.com

User Notification Preferences

Use notification preferences to customize exactly how and when you receive notifications
about activity on your documents.

Conga Collaborate uses email and text alerts to notify users of activity on their
documents. Notifications can be customized on a user by user basis.

Use notification preferences to customize exactly how and when you receive notifications
about activity on your documents.

1. Open your user dropdown in the top right corner of the screen and select User Profile.
2. Select the Notifications tab.
3. Choose the notification types you want for the following events:

- Document Accepted

- Document Declined

- Proposal Voided

- Question or Comment Submitted

- Creation of Change Requests and Comments

- First Document View

- All Document Views

Notifications are sent based on the selected notifications types.

In order to receive text notifications, you must enter your phone number in your user profile
in Collaborate. All text notifications will come from a single phone number, 317-550-4586,
and messages are grouped in the same conversation.

Filtering Your Activity Feed

Control and customize what is displayed in Collaborate's Activity Feed.

You can control what you see in your Activity Feed by using the filters located on the right

side of your Dashboard.

You can also combine the owner filters (Everyone and Me—located on the top right of your
screen) with the activity filters, which are:

- Documents Created



- Documents Published
- Documents Accepted
- Documents Declined
- Comments

For example, select Me and then select Document Published to view only your published
documents in the Activity Feed. Or select Everyone and Documents Accepted to view all
users’ accepted documents in your Feed.

Your filter preferences will be saved as you move about the platform.

Getting Started with Account Settings

Account Settings are accessed from your User Drop Down Menu.

Where does a System Administrator go to administrate the system? Account Settings,
which you can access from your User Drop Down Menu (your avatar).

Clicking on Account Settings takes you to your Admin page, where you can:

- Edit account information such as
- Organization name
- Proposal viewing
- Privacy statement
- Time zone
- Language
- Favicon
- Update user password rules
- Enable automatically generated access codes
- Attach downloads to confirmation emails, and select download formats
- Add a custom acknowledge message
- Create or edit the default email template
Add users
- Assign or edit roles and permissions
- Create and edit a theme.
- Manage your integrations

Getting Started with Theme Builder

The Theme builder is a point and click tool that gives admins a high degree of control over
the branding in their documents.



In Collaborate, a theme is used to brand online documents, the PDFs and Word files that
can be downloaded from those online documents, and the emaiils that are delivered to
share those documents. The Theme Builder is a point and click tool that gives admins a high
degree of control over the branding in their documents.

Your Collaborate documents should be an extension of your company’s image and
branding. It is important to have documents that look professional and represent your
company well. The Theme Builder is your first step towards reaching that goal.

To get started with the Theme Builder:

1. Open your user dropdown and go to Administration > Themes.

2. Click one of the default themes or any theme you've already created in order to edit
it.

3. Use the tools on the right side of the page to make changes and preview your
changes within the theme editor.

4. Click Save to save theme edits.

Once you've opened a theme, you'll be in the basic theme editor. We recommend showing
all settings by clicking Show Advanced. This presents all configuration options and gives
much more granularity in design choices for your theme.

Colors

Colors can be defined in the Theme Builder using color sliders, RGB values, or hex color
codes. An admin can also define up to three additional custom colors that become
available within the user’'s document editor when documents use that specific theme. You
must click Show Advanced in the Content panel to access the three custom colors.

Logo Panel

From the Logo panel, you can upload a document logo. Images with transparent
backgrounds and a size of at least 300 x 200 pixels are recommended. This logo will be
used for both your documents and your document login page.

You can also upload a Favicon in the Logo panel. This is the image that sits next to your
site name on a web browser tab and also in most bookmark lists. We recommend images
with a transparent background and a size of at least 16 x 16 pixels.



Buttons

The Buttons panel enables you to edit the colors of buttons themselves as well as the
colors of the button labels. You can also choose whether a button lightens or darkens when
a mouse hovers over it. By clicking Show Advanced, you can also set the colors for the
document'’s Table of Contents sidebar.

Content

From the Content panel, you can choose the font and color of your text, headings, and links.
Collaborate comes with many fonts available by default, but if additional fonts are
needed, a Collaborate admin can use the Font Manager tool to add them. By clicking Show
Advanced, you can also set color and font selections for your document’s tables.

Layout

Within the Layout panel, you have the options to edit the color of the document header,
page title, and page title bar.

Background

The Background panel gives you the ability to set the background color or image, the size
and position of the background image, and also the repeat options for the image. We
recommend a background image that is at least 1920 x 1080 pixels if you want to cover the

entire background area.

PDF

Use the PDF panel to customize your PDF download by editing page size, cover page, and
standard page options. Customizable options include page background image, margins,
Table of Contents design, and header and footer text.

To add a PDF cover page background:

- Upload a jpg or png image that is 8.5 x 11 inches and 150 dpi.
- The uploaded image will cover the whole background of the PDF cover page

To add a standard PDF page background:



- Upload a jpg or png image that is 8.5 x 11 inches and 150 dpi.
- The uploaded image will cover the whole background of the standard PDF page

Login

The Login panel controls how your document looks from the document Llogin screen. You
have options to edit the logo, background color or image, color of the display text, and even
the colors that govern the Login button. You can preview the Login screen by selecting
Document Login from the drop-down beneath your theme name.

Notes on Branded Emaiils

When sending emails from Collaborate, colors and logos from the document’s theme will
be used to style the outgoing emails and notifications. There are three areas within the
Theme Builder that affect the look of your emaiils:

- The theme Logo becomes the image in your email headers
- The Document Header color becomes the background color within the email header
- The Accept Button color is used for any links or buttons within the email

Granting Conga Collaborate Login Access

Grant login access to the Conga Support team for advanced troubleshooting.

Occasionally the Collaborate Support team may request login access in order to assist
you with a question or issue that pertains to one user in particular. This would allow
Collaborate Support to access your account using a Collaborate specific user login to
troubleshoot issues pertaining to your question.

As a Collaborate Admin, you have the ability to grant this login access and specify the
duration of time Collaborate Support is able to log in. To grant Collaborate Support Login
access, you could follow the below steps:

Select Administration from your User Profile menu
Click Users

Select the user you wish to grant login access

Go to the Grant Account Login Access tab
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From the drop-down, select the length of time you wish to grant login access for (1
day, 3 days, 1 week, or 1 month)
6. Click Save



As a Standard User, you have the ability to grant login access and specify the duration of
time Collaborate Support is able to log in as your user profile. To grant Collaborate
Support login access, you could follow the below steps:

1. Select User Profile from the User Profile menu

2. Go to the Grant Account Login Access tab

3. From the drop-down, select the length of time you wish to grant login access for (1
day, 3 days, 1 week, or 1 month).

4. Click Save

Managing Text Snippets

Text snippets can be a useful way to provide direct access to subject matter expertise in
bite-sized pieces, in order to build a personalized document without gathering those subject
matter experts every time you're building a new proposal or document.

Over time, things change, and information can be quickly outdated if not updated
regularly. If your organization maintains more than a handful of text snippets, the regular
management can become time-consuming. To help expedite the process, you can export all
your text snippet data to a CSV file to work on updates.

Export all Text Snippets

To export all text snippets, click on the export icon in the left-hand panel. Text snippets are
exported in a CSV format and include the following fields:

- Name - The name of the text snippet

- Snippet - The body of the text snippet. This is exported in HTML format.

- Visibility - This indicates whether or not the text snippet is shared. “1” represents a
public text snippet, and “0” represents private (if workgroups are enabled, “1”
represents all workgroups, “0” represents no workgroups, and “2” represents some
workgroups).

- Locked for Edit - This indicates whether or not the text snippet is locked from being
edited by others. “1” represents that it is locked for edit, and “0” represents that it's
not locked.

- Tags - Displays all tags associated with this text snippet.

- Publish Date - The publish date of the text snippet, which is the date it becomes
available for use to pull into documents.

- Expiration Date - The expiration date of the text snippet, which is the date it is no

longer available for use to pull into documents.



- Last Modified Date - The last modified date of the text snippet, which is the last time
the snippet has been modified.

- ID - This represents the unique ID of the text snippet. This ID will be used to allow
users to override the existing text snippet upon re-import.

Import Text Snippets

Many organizations use the text snippet export to update the content, and they want to
import and override the existing text snippet. To do so, from within the Content page:

1. Select Add New

2. Select Text Snippet

3. Select “Bulk Upload” to import a list of text snippets (use the export spreadsheet,
update the Snippet content, and re-import the file. The ID field indicates which text
snippet will be replaced upon import).

The following fields can be adjusted when replacing an existing text snippet:

- Name - This will allow you to rename the snippet

- Snippet - This will allow you to replace the text of the snippet. Note the snippet is
displaying in HTML format. This will allow the snippet to retain formatting upon re-
import.

- Visibility - This allows you to change whether or not the text snippet is shared. “1”
represents a public text snippet, and “0” represents private (if workgroups are
enabled, “1” represents all workgroups, “0” represents no workgroups, and “2”
represents some workgroups. You cannot adjust which workgroups are shared via
import).

- Locked for Edit - You can decide whether or not the text snippet is locked from being
edited by others. “1” represents that it is locked for edit, and “0” represents that it's
not locked.

- Publish Date - Update the publish date of the text snippet, which is the date it
becomes available for use to pull into documents. Note that if excel changes the date
format to MM/DD/YYYY then Collaborate will ignore this field (Excel is extremely
particular about date formatting. We recommend only importing dates if you are
comfortable with Excel - we recommend updating dates in the Collaborate Ul).

- Expiration Date - Update the expiration date of the text snippet, which is the date it
is no longer available for use to pull into documents. Note that if excel changes the
date format to MM/DD/YYYY then Collaborate will ignore this field (Excel is extremely
particular about date formatting. We recommend only importing dates if you are
comfortable with Excel - we recommend updating dates in the Collaborate Ul).



If your spreadsheet includes snippets without an ID or with an ID that doesn’t match, they
will be imported as new text snippets. IDs are assigned by the system and cannot be
assigned by the import file.

Conga Collaborate Deployment Guide

This is our guide to launching a successful Collaborate platform.

This is our guide to launching a successful Collaborate platform. With these resources, and
the support of our team, we want to help you get implemented quickly and start seeing
value from our software.

Formal deployments look different in every organization. The important thing is that users
are notified, trained, and have the proper incentive to use the new process. The success of
the deployment is key to getting value out of your investment in Collaborate and the time
you've spent setting it up.

Consider Collaborate’s best practice approach to deploying a new solution by creating
your own strategy and timeline (including specific dates!) to execute in the following key
areas:

- Testing - Include System Integration testing, end-user testing, time for any necessary
revisions, and a final sign-off date.

- Migration - Move the solution to your production environment if needed and confirm
that solution still performs as expected.

- Go-Live - Set the date that your Collaborate users will begin using the platform for
live document generation.

- Phase-out “the old way” - Set a date (we recommend 30-60 days after go—Live) when
your Collaborate users will no longer have access to “the old way.” Once these old
systems/processes have been phased out, only Collaborate will be used for document
generation going forward.

- Communicate to Collaborate users - Generate excitement about the Collaborate
platform and share key dates regarding training, go-live, and phase-out dates for old
systems. Consider sending a monthly “Tips & Tricks” email to keep users up to date on
the most recent improvements.

- Provision User Licenses - Create user credentials and add users to the correct roles
and permissions groups.

- Training - Consider what individual behavior changes you are asking the users to
make and address them in your training. Create and distribute training materials (we
recommend a step-by-step user guide and a short recorded video). Host training
sessions for Collaborate users, and make them aware of available support resources



and where they can log feedback going forward. Also consider how you will reinforce
the use of this new tool with follow-up training, office hours to answer questions, or
quick check-ins at team meetings to monitor usage and success.

- Collect User Feedback - Continue to assess your users’ needs and iterate and improve
Collaborate as applicable. This might be as simple as asking your users to email
feedback or as formal as sending out a survey to capture more detailed feedback.

- Recognize and Reward - Consider how you will recognize and reward users for
adopting this new tool. Some examples include: celebrating a user’s first accepted
document, highlighting user success stories at team gatherings, or creating
leaderboards in your CRM.

- Track Success Metrics - We recommend selecting success criteria and metrics to track
based on the goals you wish to achieve. For example, if you have a goal to shorten
your sales cycle, monitor metrics in Collaborate’s reporting tool that help track time,
such as: Time to Build, Time to First View, or Time to Close. Set aside time (we suggest
monthly) to track your progress, and when possible, always take a snapshot of this
metric “before Collaborate,” so you can compare your success.

- Here is an example Rollout and Adoption Timeline:
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Also, check out our deployment workbook. It's designed for large organizations that need
extra strategies for success. This workbook walks project managers and key stakeholders
through several detailed planning exercises, expanding on several concepts presented in
this article, with the goal of crafting an end-to-end enterprise-level deployment plan.

Download the Workbook

Conga Collaborate Emails and SMTP

Conga Collaborate can send emails via SMTP (Simple Mail Transfer Protocol).
Collaborate can send emails via SMTP (Simple Mail Transfer Protocol).

By using SMTP, you can send Collaborate emails through your own mail server and help
prevent your emails from ending up in spam folders.

Contact Collaborate support in order to enable this feature. Support will enable SMTP and
then send you instructions for accessing the configuration page. At that point, configuration
is done on your own and is not supported by Conga.


https://documentation.conga.com/download/attachments/143889789/1cade2d0-de18-11e9-aa99-0242cfd72409.xlsx?api=v2&modificationDate=1615491110943&version=1

Setting Up a Custom Domaiin for Your Account

Conga Collaborate defaults every account to the octiv domain - [accountnamel.octiv.com.
This domain can be changed to use any valid domain.

Use a custom domaiin in order to fully whitelabel your account and provide a fully branded
experience to your recipients.

Contact support if you'd like to set up a custom domain. They will provide instructions and
pricing.

SAML: Integrating with Conga Collaborate

Integrate SAML with your Conga Collaborate account.

Begin Integration

To connect SAML to your Collaborate account, take the following steps:

1. From your Account Settings view, click Integrations.
2. Choose SAML from the Integrations menu.
3. Click the checkbox next to Enable SAML.
4. Fill out the fields:
- The provider **Name** (Salesforce, for example)
- A URL of the **Identity Provider**
- The digital **certificate** or metadata XML file from the platform you are
linking
5. Click Save Changes

SAML Features

Using this integration through Collaborate and Salesforce (for example) makes Salesforce
the Identity Provider (IdP). After you enable this integration, you see a separate link asking
you to sign on using Salesforce. Entering your credentials confirms you as the user and
redirects you to Collaborate After sign-in, you're authenticated by SAML and have reached
out to all service providers involved. Using SAML can also auto-provision users in
Collaborate, meaning that all accounts are managed via the identity provider. Use the
auto-provision toggle to set this feature. Because your email address is your user
identification, you need to make sure you're using the same one in all the systems you


http://octiv.com

connect. You can use any SAML 2.0 identity provider, including Salesforce, Microsoft ADFS,
Okta, and Onelogin.

Set up your SAML integration on the Salesforce end by configuring a domain name,
enabling the identity provider, and creating a connected app. The following sections walk
you through each step.

Configure a Domain Name

Start the process by logging in to Salesforce. From your home page, follow these steps:

Click Security Controls under Administer.

Click Identity Provider in the drop-down menu.
Click Configure a Domain Name.

From Domain Management, choose My Domain.
Enter the sub-domain name you want.

Click Check Availability.

Check Terms and Conditions.
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Click Register Domain.

Salesforce will register the DNS change and send an email confirmation. You can then log
in to and test your custom domaiin. If everything'’s shipshape, Deploy to Users to make it
official.

Enable Identity Provider

After you have a custom domain, use these steps to enable the Identity Provider:

1. Click Enable Identity Provider.
a. This generates a self-signed x.509 certificate to be used for SAML
authentication.
2. Click Download Certificate.
a. The certificate is used when configuring Conga Collaborate for Single Sign-On.

Create Connected App

Follow these steps to create your connected app:

1. From Connected Apps, click Create Apps.

2. Click Apps.

3. Click New.

4. Create a New Connected App for Conga Collaborate (the service provider).



5. Fill out the following fields:

- Connected App Name

- API Name

- Contact Email

- Enable SAML (Must be checked)

- Entity ID: {account}.octiv.com

- ACS URL: https://{account}.octiv.com/sso/saml/consume
Click Manage.
Right-click and copy the link for the IdP Initiated login URL.
Click Edit the Connect App.
Paste the IdP Initiated Login URL into the Start URL under Basic Informaction.
10. Click Save.
11. Click Manage Profiles.
12. Add the user profiles who can access this App.

The connected App Conga. Collaborate should now be visible in the drop-down box and
should automatically log you into your Conga Collaborate account.

Finish the Integration

After you're in Conga Collaborate, follow these steps to finish this integration:

Go to your Account Settings.

Click Integrations.

Click the SAML box.

Copy the configuration settings provided by Salesforce.com into the SAML
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Configuration form.
- The IDP Start URL is the IdP-Initiated Login URL from Salesforce.
- The IDP SSO Target URL is the SP-Initiated POST Endpoint from Salesforce.
- The IDP Certificate Fingerprint comes from the self-signed certificate from
Security -> Identity Provider.

For more integration information, see SSO Integration Overview.

Setting Alerts with Conga Collaborate Signals

Conga Collaborate Signals send email alerts that are triggered by specific activity within
your account. They also allow for scheduled digest emails of activity within your account.

Collaborate Signals send email alerts that are triggered by specific activity within your
account. They also allow for scheduled digest emails of activity within your account.


http://octiv.com
http://octiv.com/sso/saml/consume
http://Salesforce.com

Signals are only visible to the user who created them. So a signal configured by User A will
not be visible to User B, even if User B is an Administrator.

Signals allow you to set up an alert to send to a manager anytime his/her report publishes
a document, schedule weekly summaries of documents created off of a certain template, or
notify the CEO when a proposal over a certain value is closed. Using document statuses,
events, tags, and other pieces of information, you can create customized alerts that fit your
business needs.

From your user dropdown in the top right corner, select Administration.
ClickSignals.

Click New Alert on the right-hand side of the page.

Choose the Document Type you want to trigger the alert.

Click Continue.

In Alert Options, choose which document attributes or Collaborate events that you
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want to trigger the alert. Available options are:
- Owner
- Title
- Value
- Tag
- Status
- Events

The Owner, Title, Value, and Tag will not trigger the alert until the document is
published.

1. Click Continue.

2. In Delivery:
- Fill out Alert Name with a descriptive name.
- Choose the alert frequency.
- Choose the alert recipients.

Recipients will have to be Reports of your user in the Relationships tab in your User Profile in
order to be available as a recipient.

1. Click Create.

Setting Content Publish and Expiration Dates

You can control the date your Content appears in—and are hidden from—your Content
Library. That means no Content can be used before its time, and you never have outdated



files lingering in your account to add confusion and make errors all too easy. You ensure
that your content shows up for use only when you want it to by setting publish and
expiration dates.

An expired Content element stays in the documents you've inserted it into, but it no longer
appears in your Content Library. You can still pull it up if you need it by using the Expired
filter to search. And if you decide you want to bring it back into heavy rotation, just reset
the expiration date.

Use the steps below to set publish and/or expiration dates for your Content:

1. In your Content Library, click the file you want to add a publish date or an expiration
date to.

2. Click the pencil icon above your Content Library.

3. Use the editing panel that appears on the right of your screen to set the dates you
want by adding dates to the Publish Date and/or Expiration Date field(s).

4. Click the Save button.

Setting Password Security Rules

Use these steps to manage your password security.

Collaborate is doing everything we can to protect the security of your information. You can
take our work even further by specifying your own rules for users’ passwords.

Use these steps to manage your password security:

1. Click Administration from the User Drop Down Menu (your avatar).
2. Choose Account Settings from the icon.
3. Click User Password Rules and set your own.
- The minimum length for passwords (6-12 characters).
- Session timeout, or how long users can be inactive before they're automatically
logged out.
- Password expiration interval. The number of failed login attempts before a user
is locked out.
- Specific values for passwords, including (or not) numbers, lower- and upper-case
letters, white-space characters, and symbols.
4. Use the checkboxes on the right to determine whether Users must reset their
passwords at first login.
- Passwords must be unique and non-reusable.
- Common patterns are restricted from being used as passwords.
5. Click Save. Feel good about your efforts to ramp up security.



Set the maximum number of failed login attempts, after which the user will have to request
an unlock email from the bottom of the forgot password screen (Options: 5-20 attempts;
Default value: 10 failures).

You also have several other security options available to compliment the password rules
that can be toggled On/Off (Force users to reset their password the first time they log in;
Unigque non-reusable passwords; Restrict common patterns from being used as passwords).

SMTP Email Delivery Errors

Question or Issue

After connecting Conga Collaborate to SMTP, emails fail to send.

Causes or Possible Causes

Multiple scenarios cause this error, but if you use Outlook 365 you can check logged error
messages on the account's Background Jobs page to see why an email failed to send. To
troubleshoot this error, take the following steps:

1. From within Collaborate, add yourself as a recipient on the People tab of the
document build view, and send it to yourself as a test.

2. A small black envelope appears under your name on the People tab to indicate the
document attempted to send.

3. If the icon's description text indicates delivery failure, go to your Collaborate Org's
Reporting page and select the Background Jobs tab.

4. Search for the title of the document you tried to send, and hover your mouse over it to
see the associated error description further detailing why the document failed to
send.

SSO: Integration overview

An overview of SSO integration information for Conga Collaborate.

SAML enables you to log in to multiple software platforms from one central location,
meaning you don‘t have to remember multiple usernames and passwords. SAML will
authenticate your accounts and enable your systems to communicate and to authenticate
users from one to the other.



It's also a powerful onboarding tool: Accounts can be set up automatically with auto user
provisioning. Users can be mapped to Collaborate just by logging in using their Identity
Providers credentials, instead of having to set up hundreds of user accounts within
Collaborate.

Connecting From Collaborate

Follow these steps to connect SAML to your Collaborate account:

Click on your User Drop down then select Administration.

Click Integrations.

Choose SAML from the Integrations menu.

Click the checkbox next to Enable SAML.

Fill out the following fields according to your Identity Provider’s (IdP) documentation:
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- Provider Name - This field is for your reference so name it something familiar to
you or any other Account Admins
- IDP SSO Target URL
- IDP Certificate Fingerprint - You can optionally upload a certificate provided by
your IdP
6. The remaining fields are optional and vary depending on individual IdPs. Please refer
to your particular IdP’s documentation.
7. Click Save Changes.

Alternatively, you can utilize the Metadata URL field to have Collaborate automatically
pull the required information directly from your IdP. This URL would be provided by your IdP.
The metadata file will contain all the required information about your particular IdP’s
configuration.

Authentication: Collaborate will utilize the Subject NamelD field within the SAML assertion
to authenticate with the specific Collaborate user. Collaborate will match on an email
address or username, but an email address is preferred. Please ensure you are passing
NamelD in the Subject or you will get the following error message: No associated
Collaborate account was found. Please contact your account administrator.

Connecting from Your IDP

The SAML Configuration Information at the bottom of the SAML Integration page should
contain the URLs that your IdP will require when setting up the integration.



Optional Settings

Automatically Initiate SP Login: by enabling this setting your users navigating to the
https://[accountname].octiv.com (or your custom domain) will be automatically redirected
to your IdP login screen. If your users will only ever log into Collaborate through your IdP
you should likely enable this option.

Auto-Provision users: by enabling this option Collaborate will automatically create users
within your Collaborate account for any user that tries to log in and does not already
match a current Collaborate user. Collaborate will make its best guess from the SAML
Attributes provided and associate to the proper User fields within Collaborate. However, if
you want to specify the actual fields to use, you can utilize the Attribute Mapping fields
directly below the Auto-Provision Users setting

SAML Features

Using this integration through Collaborate and Salesforce (for example) makes Salesforce
the Identity Provider (IdP). After you enable this integration, you see a separate link asking
you to sign on using Salesforce. Entering your credentials confirms you as the user and
redirects you to Collaborate.

After sign-in, you're authenticated by SAML and have reached out to all service providers
involved.

Using SAML can also auto-provision users in Collaborate, meaning that all accounts are
managed via the identity provider. Use the auto-provision toggle to set this feature.

Because your email address is your user identification, you need to make sure you're using
the same one in all the systems you connect.

You can use any SAML 2.0 identity provider, including Salesforce, Microsoft ADFS, Okta, and
Onelogin.

For more information on SAML integration, see SAML: Integrating with Conga Collaborate

Google OAuth2

Collaborate supports the Google oAuth2.0 protocol for authentication and authorization.
See Google’s documentation on this here.


http://octiv.com
https://developers.google.com/identity/protocols/OAuth2

Salesforce: Updating the Managed Package

Update the Conga Collaborate managed packaged to use the latest features and

functionality.

The Collaborate managed package requires a patch install in order to upgrade
from Version 1.22 to Version 1.24 (current version as of February 2019).

Updating to the new version will keep you up to date and allow you to take advantage of
new features in the integration. Some of the notable updates in this new package are:

- Removed deprecated package components
- Template Name is now available as a field on the Octiv Documents object
- Managed package installation now includes a step to set your Collaborate URL

The Collaborate managed package can be upgraded and/or reinstalled without removing
any existing Collaborate data or settings.

1. Determine the current package version.
a. In your Salesforce instance, navigate to Setup.
b. In the Quick Find bar, search for and click Installed Packages.
c. ldentify the Conga Collaborate Version Number.
2. Determine upgrade steps based on the current package version.
a. If the current version is Version 1.24 or higher (Latest version as of February 2019),
no action is required.
b. If the current version is Version 1.22.1, directly update to the latest version of
Collaborate.
c. If the current version is Version 1.22 or lower, first install the patch package
(Version 1.22.1) and then update to Version 1.24.

You will be unable to update your installed package directly from Version 1.22 to
Version 1.24 without first installing the patch package (Version 1.22.1). Salesforce
blocks this package upgrade because Version 1.24 removes unused legacy Apex code
that one or more Visualforce pages or global Visualforce components need in order
to function.

1. Perform the upgrade.



a. Log into the Salesforce instance in which you wish to install the update
Collaborate package.

b. If needed, first install the patch package, Version 1.22.1.

c. Use this link to Install in Sandbox or this link to install in Production.

d. Choose security settings for the package install (we recommend Install for ALl
Users), then click Upgrade.

e. Click Done.

f. (Optional) Once Version 1.22.1in installed, install Version 1.24. Click this link to
install in Sandbox or this link to install in Production.

Once the package is installed, you can go back to the Installed Packages page and
view the Unused Components. These items are no longer needed with the new
package version 1.24. You may delete these components from your Salesforce
instance. As a managed package provider, Collaborate cannot go into your
Salesforce instance and delete these or include code in the patch package to delete

them.

Managing Workgroups

Conga Collaborate works like your business does, and so we've developed a workgroup
feature that enables you to share what — and only what — each division of your operation

needs.

Collaborate Workgroups enable you to create segmented groups so that the users in each
group only have access to the documents and content relevant to them.

Workgroups highlights

- Users can be placed in multiple workgroups, and users in multiple workgroups can
switch between the workgroups they are in.

Note: Admins should not assign themselves to a workgroup unless they want to lose
access to workgroups settings. Admins should use the workgroups switcher in their
user drop down menu instead.

- Once workgroups are enabled, a Global workgroup is created that holds any users/
content that haven't been assigned to a specific workgroup. The Global workgroup is
intended for admin users as well as content that should be shared with all or none of
the workgroups.

- Document templates and content can be shared with all, some, or none of the
workgroups in your org, depending on your needs for that particular document or

content.


https://test.salesforce.com/packaging/installPackage.apexp?p0=04tA0000000KNBW
https://login.salesforce.com/packaging/installPackage.apexp?p0=04tA0000000KNBW
https://test.salesforce.com/packaging/installPackage.apexp?p0=04tA0000000KPJx
https://login.salesforce.com/packaging/installPackage.apexp?p0=04tA0000000KPJx

You can use workgroups to group users according to things like location, project, or
department, and then give them access to only the documents and content they need. The
documents and content created in one workgroup will not be visible within any other
workgroup.

Enable Workgroups

- Contact support in order to enable workgroups.

Create Workgroups

1. Once enabled, open your user drop down in the top right corner and
click Administration.

Select Workgroups.

Click+ Add Workgroup.

Enter a descriptive name in the Name field.

Click Save.
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The workgroup must be saved before any users can be added to it.

1. Open the workgroup you just created.
2. In the Users dropdown, add all users who should be part of the workgroup.
3. Click Save.

Manage Workgroups

Users can be added or removed from workgroups by editing the Users list in the workgroup
settings as in the section above. You can also edit which workgroups a user is in on the User
Profile:

From the user drop down menu in the top right corner, click Administration.
Click Users.

Select the user you want to edit.

Open the Relationships tab.
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In the workgroups section, add or remove the desired workgroups for that user.



Move users from a single workgroup to another single
workgroup using Bulk Move Users

The Bulk Move Users feature is only for admins who are trying to remove users from
workgroup(s) and move them to a single workgroup. This feature does not support
moving a single user into multiple workgroups. Also, if a single user is in multiple
workgroups, using this feature will remove them from all workgroups except the
single workgroup specified in the CSV upload.

From the user drop down menu in the top right corner, click Administration.

Click Workgroups.

Click Bulk Move Users.

Select Required Columns to download the CSV with the proper column names.
Update the Username column with the usernames of user(s) you want to update.
Update the Workgroup column with the name of the one workgroup you want to move
the user(s) into.
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Move users between multiple workgroups at once using Bulk Upload

Note: In order to update multiple workgroups for a user at once, you must go into the user's
Relationships tab and remove at least one workgroup manually before using this tool. It
will not work otherwise.

Download user data for workgroups and usernames

1. From the user drop down menu in the top right corner, click Administration.
2. Click Users.
3. Click Export CSV on the right hand side of the page.

Use the Bulk Upload feature

1. In your downloaded CSV, change the Email Address column name to Email, change
the Groups column name to Permissions, and change the Workgroups column name
to Workgroup.

2. Delete the Managers column.

3. Enter the new workgroups for each user in the Workgroup column. If you want a user
to be in multiple workgroups, enter each workgroup name in a comma-separated Llist.

4. In the Attribute Matching section of the Bulk Upload page, verify that the default
names for Email, Permissions, and Workgroup match that of your CSV column names.



5. Select Choose File and select your edited CSV.
6. Check Edit Existing Records? (Matched by Email).
7. Click Save.

Using Conga Collaborate

There are several ways to use Conga Collaborate. For more information, see the topics in
this section.

General Usage

Create, share, sign, store, analyze, and manage documents online with Conga Collaborate.

Accepting a Document on Behalf of Others

You can configure your account so that a certain user can accept documents on behalf of
another. This function works only when the users are part of a Workgroup.

Configuring this Feature

To configure this feature, a System Administrator follows the steps
below

From the Account Settings view, click Roles and Permissions.

Select the group that you want to turn on this feature for.

Toggle to the Permissions screen.

Click Proposal & Template Properties.

Click the checkbox next to Accept document on behalf. The feature is now available
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to the group of users you selected.
Accepting on Behalf of

Follow the steps below to accept a document on behalf of someone
else

1. Click Accept on the Document you wish to accept on behalf of.



2. Click the Accept on behalf checkbox.
Fill in the necessary fields.
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4. Click the acknowledgment statement and sign the document. All parties will be
emailed a notification of acceptance.

Accepting or Rejecting Contract Change Requests

For any documents you own, you receive a notification each time a user or recipient submits
a Change Request.

Accept or Reject Contract Change Requests

For any documents you own, you receive a notification each time a user or recipient submits
a Change Request.

To accept or reject change requests

1. From the Contract the request appears in, click the Review Changes Call to Action
button.

2. Use the buttons in the Versions tab of the Document Information Panel to Accept or
Reject changes one at a time or all at once.

3. After you've reviewed all changes, click Submit As a New Version.

4. Select Send Email to inform the signer that the Contract is ready for review.

Adding Attachments to a Document

When you have bits and pieces that don’t belong in your document but that you want
recipients to receive with a document, use Attachments. You can attach images, files,
PowerPoint decks, and PDFs no more than T00MB.

To add attachments to a document

1. From your Documents page, select the document you'd like to add an attachment to.

2. From the Table of Contents, click Attachments.

3. Drag and drop your file or use the Add File or Cloud File buttons to select your file
from your computer or a cloud storage provider.

4. Click Open.

5. Your file appears in the document’s Attachments section, where recipients can access
it.



Adding a BCC

Collaborates’ Add BCC feature allows users to send a copy of a Collaborate document
email directly to any additional email address, such as a billing contact within your
company.

Adding a BCC recipient can be done on a case-by-case basis or a user may choose to add
a default BCC contact on the Email tab of their user profile.

To Add BCC to a Collaborate email

In the document build view, click the People tab

Click the Send Emaiil button

In the Send Email modal, click +BCC next to the Recipients field

Enter the BCC email address. If a default BCC address has been added to your user
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profile, the address will automatically populate the BCC field

Adding Content to Your Content Library

Your Content includes the Pages, images, files, and text snippets that you store to use in
your documents. The way you add Content varies a little by what you're adding. You can
add any kind of file as long as it doesn’t exceed 100 MB.

To add content to the library

1. From the Content page, click the Add New button.
Choose Pages from the dropdown menu to create your content; choose Page from
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Word to upload a Word document.

Click the Properties tab to add tags, edit privacy settings, and so on.
Click Save.

From the Content page, click the Add New button.

Select Upload Image/File from the dropdown menu.
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In the Upload window, you can drag and drop or browse your files to add what you
want.

8. Follow the prompt to set properties like tags, privacy, and owner.

9. Click Submit.

10. From the Content page, click the Add New button.

1. Select Text Snippet from the drop-down menu.



12. In the Create a Text Snippet window that appears, use the fields to add and format
your Text Snippet, name it, and choose its properties.

13. Click Add.
The Text Snippet window also gives you the option to bulk upload. Just make sure
you've put your text snippets into a CSV file with UTF-8 encoding before you bulk
upload them.

Adding Links

You can add clickable hyperlinks or e-mail addresses to your documents by following these
steps:

1. Place your cursor inside the content editor where you would like to place the link.
2. Click Insert in the Menu Bar.

3. Click Insert Link.

4. In the pop-up window, fill out these fields:

- URL: Type or paste the URL of the website or an email address.

- Text to display: Type the text you wish to display as a link in the document.

- Title: A title will appear when the link is hovered over on some browsers.

- Target: Choose None, and the Llink will open the website in the tab you are
currently in; Choose New Window, and the link will open in a new window
outside of the tab you are currently in.

- Class: Choose no class or enable iLightBox, which allows the viewer to see full-
size images without leaving the document.

Adding or Editing Users in Bulk

Add or edit users in bulk to Conga Collaborate by uploading a CSV file.
Add or edit users in bulk by uploading a CSV file. Required fields are full name and email.

Adding or editing large numbers of users one by one is time-consuming and tedious. Use the
Bulk Upload tool to quickly create new users or make mass updates to existing users.

To Bulk Add Users

From the User Dropdown menu in the top right corner, click Administration.
Click Users.

Click Bulk Upload in the top right corner.

Use the sample CSV files to determine the fields available for edit.
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Set up your CSV file according to the rules presented in the sample CSVs.



6. Review the Attribute Mapping section and confirm that you have the correct column
headers in your CSV.

7. Review the Default Values section and confirm you want to use the selected values.

8. Click Choose File and select your CSV file.

- If you do not want your users to receive confirmation emails, checkbox
beside Don’t send confirmation emaiils.

- If you want to edit existing users, check the box beside Edit Existing Records?
Collaborate will search for an email match between an existing user and a
record in the CSV file and update that user within Collaborate. This can be used
for mass updates for general information like notification preferences or time
zones.

9. Click Save. A confirmation or error message displays to let you know if the upload is
successful. If an error occurs, there is a description of the error.

Adding Required Forms

You can require document recipients to fill out any necessary webforms before they
complete the signing process. Using required forms enables you to collect billing and other
information crucial to completing a transaction right when it goes into effect.

Follow these steps to insert a Required Form from the document Build View:

1. Click the Content tab.
Select Forms. You see a list of forms available in your Content Library.

SN

. Drag and drop the desired form to the appropriate placement in your Table of
Contents panel.

Click the gear icon next to the form in the Table of Contents panel.

Click Edit Properties from the dropdown menu.

Check the box for Make Required.

Click Save.
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Adding Text Snippets

Text Snippets are bits of text that live in your Content Library so you can drag and drop
them into various documents.

Maybe you use certain pieces of text in various documents over and over (or would like to).
Make that process quick and easy by using Text Snippets. These bits of text live in your
Content Library so you can drag and drop them into various documents—after which you
can easily edit and format them from the Document Build view. (The Editing Toolbar



includes a Clear Formatting option if any unwanted formatting sticks from snippet to

document.)

Your Text Snippets can include as little copy as you like and as many as 65,536 characters
(or 64 KB).

Use these steps to add a Text Snippet to your document:

1. From the Build View of the document, you want to add a Text Snippet to, click the
Content tab on the right side of your screen.

From the panel that slides out, you will see a list of content types.

Choose Text Snippets.

Click the Text Snippet you want from the list, or use the Search Bar to find it.

Make sure your cursor is in the spot where your Text Snippet should go, and then drag
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and drop it into your document.

Archiving Templates

Focus your team on current templates by archiving old document templates. Templates
you archive aren’t deleted, and you can still find them in the archived filter.

To Archive a Template

1. From your Document List, click the checkbox next to the temqute(s) you would like to
archive.

2. Click More in the icon list that appears across the top of your screen.

3. Click Archive Document.

You can find your Archived Documents easily; just click Archived Documents in the Table of
Contents, when you're in Document View.

To Unarchive a Template

1. In Documents View, click Archived Documents in the filter panel.

2. Click the checkbox next to the Document(s) you'd like to get back into your Document
List.

3. Click the More icon from the top of your screen.

4. From the dropdown menu, click Unarchive Document.



Branding Emails

By customizing your emails within the Theme Builder, you will have the ability to change the

background color of your emails. Additionally, you will have the ability to select the logo

that will appear on the emails that you send out through Collaborate.

To Insert a Logo Image
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Click Administration.

Select Themes from the available Account Settings options.

Within your Default Theme, click on the Logo button.

Click on the Choose File button and upload the desired image for your Logo.
Click Save.

To Assign a Background Color
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Click Administration.

Select Themes from the available Account Settings options.

Within your Default Theme, click on the Layout button.

Change the Document Header to your desired brand color. This color will appear on
the background of your emails.

Click Save.

Checking Out Your Document Activity

Access details about your Collaborate document activity.

Across the top of your Dashboard runs a clear breakdown of the details of your activity

over the last running 30 day period. This refreshes constantly to reflect ongoing activity.

The Monthly Summary provides information about your

- Close rate, which is calculated by dividing acceptances by views
- Documents open, viewed, accepted, and declined

- Value of new documents

- Number of documents created

- Number of unique document views



Conditional Content

Conga Collaborate’s Conditional Content feature allows you to create content in your
documents that will show or hide based on specific criteria.

Create content in your documents that will conditionally display based on specific criteria.
The conditional content tool provides a simple point-and-click interface that enables you
to build your logic statements without code. Conditional content statements can leverage
document variables, CRM variables, metadata variables, or survey form variables.

Conditional content blocks are represented with blue dotted lines that appear as you are
drafting a document or template.

Conditional content provides Collaborate admins with a way to ensure that content is
present in a document only if it is needed, thus eliminating user error and speeding up
document creation time.

For example, many Collaborate administrators want paragraphs of content in a template
that will show only if a prospect is purchasing a specific product or if a proposal is for a
specific scenario, like a client renewal. In that case, they may create a block of conditional
content that uses conditional display logic based on Opportunity Line Item data or an
Opportunity variable coming from a Salesforce Opportunity record.

Create conditional content

1. In a template or document, put your cursor where you want to include a conditional
content block.
2. From the editor menu, select Insert > Conditional Content.
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Insert the text you wish to display in your conditional content block.

4. Click the gear icon at the top right of the conditional content block to write your
conditional logic statement. A modal will appear to guide you through writing the
logic statement.

5. Use the first drop-down to select a variable that will be evaluated.

6. Use the second drop-down to select an operator. A large number of operators are
supported, and they vary based on your variable’s data type.

7. Use the third drop-down to define a value as the operand.

8. Click Save.

Example statements:

Behavior Variable Operator Value

Show If proposal_value (Document > 10000
Variable)



Behavior Variable Operator Value

Show If Opportunity_Type (Salesforce equals New Customer
Variable)

Hide If metadata_terms (Metadata contains Auto-Renew
Variable)

When building logic statements using CRM variables, you must use variables that are
related to your launching object. For example, when launching from an Opportunity but
using the Industry field on the Account object, you need to use the variable that gets
mapped from the Opportunity up to the Account, Opportunity_Account_Industry.

Logic-based on child object data

Some Collaborate administrators may want to write logic statements that are not based
on fields on the launching object, but instead use fields from a child object of the launching
object, such as Opportunity Line Items present on an Opportunity in their CRM. In this case,
the fields are treated as a data array filled with key-value pairs. If a child object is
selected in the variable drop-down, additional logic builder fields become available.

Child object logic example:

Behavior Variable Operator A Record Where Equals
Show If OpportunityLineltem | equals PricebookEntry.Product | Gold Package
S 2.Name

In this example, the conditional content would show if any of the products in the
Opportunity Line Items on the Salesforce Opportunity record have a product name equal to
"Gold Package.”

Advanced Conditional Content

Admins can use the Show Advanced option in the Llogic builder to write more advanced logic
statements with other operators or AND/OR statements. See Advanced Conditional Logic
Statements for more information.



Collaborate does not support combining ANDs and ORs with this feature. If your use
case requires a combination of ANDs and ORs, consider enabling and using Logic
Groups. If not enabled in your account, you will need to contact support for

enablement.

Converting a Document to a Template

Convert any Collaborate document into a Template and keep it at the ready for a future
starting point. You have two options for making this happen; you can convert a document
from your Document List or from Build View.

To convert a document to a Template from your Document
List

1. From your Document List, click the checkbox next to the Proposal, Presentation, or
Contract you would like to convert into a Template.

2. Click the More icon at the top of your Document List.

3. From the dropdown menu, click Convert to Template. You can find your new Template
under the Templates filter for the type of document that you converted it from—
Proposal, Presentation, or Contract.

To convert a document to a Template from the Build View

1. From the Build View of the document you want to convert, click the Next Steps tab.

2. Click More Actions.

3. From the dropdown menu, click Convert to Template. You can find your new Template
under the Templates filter for the type of document that you converted it from—
Proposal, Presentation, or Contract.

Converting Proposalls to Templates

You can build a template from scratch or create a template from a proposal you've
already built.

To convert a Proposal into a Template

1. In your Documents view, click the checkbox next to the Proposal that you wish to

convert to a Template.



2. From the icons that appear across the top of your Document List, click the More icon.
3. Click Convert to Template from the dropdown menu.
If you're in Build View for a Proposal, you can find the Convert to Template option by
clicking the Next Steps tab and then clicking More Actions.

Copy and Paste from Microsoft Word

When copying and pasting content from Microsoft Word, Collaborate gives you control of
how much formatting from Word you want to maintain when pasting it into Collaborate’s
web-based, HTML content.

Copying and pasting from Microsoft Word is a common way to create your first
Collaborate templates. Often, existing document templates live in Microsoft Word and you
want to adapt that content to Collaborate.

Collaborates’s copy and paste functionality seamlessly translates formatting elements
found in Word into the corresponding format options in HTML. In other words, if your text is
bold, red, and size 14 in Word, Collaborate will take that styling and translate it into the
proper HTML.

When you paste text from an outside source into a document, a modal will appear giving
you an option to control how much formatting will be brought into your document. Two
important questions to ask here: 1) “"How much of the original formatting do | want to
keep?” and 2) “Do | want the content to fully take advantage of Collaborate’s Theme
Builder?”

Keep Source Formatting

Use this option when you want to keep an exact style match from Word and are not
concerned with using your Collaborate Theme Builder settings. It will attempt to keep all
Word formatting options and will override your Collaborate theme settings. This means
that if you manually styled something in Word (for example, selected a section title, made
it size 18, bold, and red), then it will take that same format in Collaborate. If you keep
source formatting, it will override all formatting from your Collaborate theme. Even if you
try to set that text as a header from your theme, the formatting you’ve copied from Word
will override your Collaborate theme format options.

Don't include images when adapting text content from Word. Copy and paste those images
in separately.
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Apply Document Formatting

This option is good for keeping some of your styling from Microsoft Word, while still
allowing you to take advantage of Collaborate’s Theme Builder. This selection will remove
formatting like font color, font, bulleted list margins, and paragraph style. For example,
you could select the relevant text that you’'ve moved into Collaborate and select a heading
style from your Collaborate theme.

Note: Don't include images when adapting text content from Word. Copy and paste those
images in separately.

Keep Text Only

Use this option when you want to copy content from Word but also have absolute flexibility
to re-style content using Collaborate’s web editor and selected theme. All formatting from
Word will be stripped from your pasted content, and you will use Collaborate’s editor and
Theme Builder to style your content. In most scenarios, we recommend adapting content
using this option.

Pasting as Plain Text will not include any images from the original copied content.

Formatting elements supported by this feature include, but are not limited to:

- Headings

- Bold

- Italics

- Underline

- Strikethrough
- Superscript

- Bullets

- Numbering

- Line spacing
- Indentation (space or tab key)
- Hyperlinks

In any of these options, your Collaborate theme will still control the overall design of your
document but might be overridden by the formatting options from Word based on the
selection you chose when copying and pasting.



In general, this article applies to copy and paste from any outside source. As was said
earlier, we recommend pasting as Keep Text Only in almost all scenarios. Some notable
exceptions are when pasting in the content that is already Collaborate content or when
pasting in a table from Word that has specific styling in it.

Creating, Editing, and Deleting Tags

Use tags to organize your documents and content so that they're easy to find. You can tag
a file, a bit of text, or any element within a document.

To manage your tags

Click Administration from your User Dropdown Menu (gour avatar).
Click Tags.

Click the New Tag button on the top right to add a tag.

Use the field that appear to name your tag and add a description
Click Save.
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To edit or delete a Tag, use the checkbox to select it from your list of Tags and then click
the pencil icon that appears in the top right to edit, the trash can to delete.

Creating a Contract

To create your contract any way you want, follow these steps

You take a fresh-start approach to building a contract, rely on a template, or work from a
Word document.

To create your contract

1. From your Dashboard or Document List, click the Create button.

2. Click the Contract on the dropdown menu.

3. The pop-up window that appears lets you choose to create your contract by
- Checking Start with a blank contract
- Checking the template you wish to use
- Uploading a Word document

After you've made your choice, you are taken to the Build view, where you can create and
publish your new Contract. Collaborate auto-saves your documents within a half-second
of any change you make.



Keeping your contract in draft form means you—and others in your workgroup—can edit it;
publishing locks in your content. You can send a contract out only after you've published it.

Creating a New Document

When you're in the Document List view, the Create button appears at the top right, of the
center section, of your screen.

Click it to start a new document. From the dropdown menu, you first click the type of
document you'd like to create.

Once your document type is selected, you'll want to choose whether you'd like to:

- Start a document with a blank document type.
- Start a document with a template.
- Upload a document from which to work.

If you wish to create a Template, you will be asked to select a document type for your
template.

Creating a New Document from Word

When creating new documents, you can upload a file from Microsoft Word to quickly
replicate content in Collaborate.

Note: Not all design/formatting elements are able to be consistently translated from Word
to HTML. Some additional editing may be required.

1. On the Dashboard or the Document list, click Create.

2. Select Proposal or Contract. The Create a Document modal then appears.
3. Click Choose Files. The File Explorer then appears.

4. Select the desired Word file. The file must have a .docx extension.

Once the file is selected, a Collaborate document will be generated based on the file’s text,
table and image content.

Individual pages will be added to the Table of Contents based on page breaks found in the
Word file. Page titles will be created based on page headings or the first 100 characters of
paragraph text.

Creating a Template

Collaborate Templates allow you to create a starting point for your documents and easily
maintain them for consistency. An administrator will build a template with pre-loaded
content and dynamic behavior that can then be used by Collaborate users over and over



again. When users build a document from a template, they can make changes to the
content within that document without affecting the template itself.

Templates give Collaborate administrators better control over what content is being
created and sent. Setting up content, logic, and permissions on your templates allows users
to create documents from those templates, streamlines document assembly, and still
allows for editing flexibility by the user.

1. Create a new Template.
- Create a template from the Dashboard: click Create. In the dropdown menu,
select Template. Give your template a name, select its type, and click Create.
- Create a template from the Templates list: click Create Template. Name your
template, select its type, and click Create.
Note: Depending on your Conga Collaborate subscription, you may
have Proposal Template, Contract Template, or Presentation Template as
template options. Proposal is the recommended document type for the majority
of use cases. The Proposal document type works well for any document that
does not require use of Conga Collaborate’s online redlining functionality. For
example, Order Forms, SOWSs, and even MSAs can be built with the Proposal
document type. Contract document type is required if you are using Conga
Collaborate online redlining.
2. Set the Template properties.
a. Open the Properties panel.
b. Open the Design tab.
c. Choose a Theme for your template. A Theme controls the general styling of the
document. If you have not yet created a theme, see Getting Started with the
Theme Builder.

Note: You can continue to customize other settings in the template's Properties tab.
However, the rest of the properties are optional and depend on your use case. See the
full list of Template Properties later in this article to learn more.

3. Add Template Content.

a. Before you start adding text, tables, or images to your template, break down
your existing document into sections and pages. Those sections and pages will
drive how you build the Table of Contents in your new template. For more
information, see Working from the Document Table of Contents.

b. Once you've built the Table of Contents, copy and paste content from your
Word document into the appropriate pages within the Conga Collaborate
template. We have some special tools to help the copy/paste process go more
smoothly. For more, see Copy and Paste from Word.



c. Use the Conga Collaborate editor to format the content you've pasted in or
insert images, tables, pages breaks, and more. For more information, see Using
the Document Editor.

d. (Optional) Add content options

- Embedded PDF Pages: Conga Collaborate content is web-based, meaning you
are creating an HTML page when you're building content. However, Conga
Collaborate also supports loading existing PDFs and PDF pages into your
documents. This works well if you have a page that is highly styled and will not
need to be edited by your users. If you'd like to add a PDF, specific PDF pages, or
other files to your template, see Embedding Files into Documents.

- Referenced Content: In some cases, you may want to create a page of content
that will be used in several templates. You can avoid re-creating and updating
the page in each individual template by creating a master version of the page
in the Conga Collaborate Content Library and then adding it to a template as
referenced content. To learn more, see Referenced Content.

- Locked Content: If you would like to lock template sections or pages from being
edited or removed in documents created off of that template, open the section
or page settings by clicking on the gear icon next to the section or page name in
the Table of Contents and editing the properties for each.

Note: As much as possible, let your selected Theme determine the styling of your
content. If you find that you are constantly changing styling within the document
itself, consider making changes to your Theme instead.
. Add Dynamic Behavior. Once you have started adding content to your template, you
can start adding Salesforce variables and logic to drive dynamic behavior
a. Open the Content panel, select Variables, and choose the dropdown containing
the type of variable you want to insert. When you place your cursor into the

document, a "+" will appear next to the variable names. Clicking this will insert
the variable. Alternatively, you can type "%variable_name" into the document,
and you will be presented with a list of dynamically filtered variables to insert
into your content. See Variables for more information.

b. Click Insert and then select Conditional Content to create sections of text or
content in your documents that will only show based on specific criteria. See
Conditional Content for more information.

c. Click the gear icon after hovering over a page in your Table of Contents to open
Edit Properties. Then click Include Logic to add Page Logic, allowing you to show
or hide a page based upon specific criteria. See Conditionally Display Sections
and Pages for more informaction.

d. Click Insert and then select Table to build a table that automatically
populates with child object data from Salesforce, such as Contracts or Products



related to a selected record. See Salesforce: Creating Auto-generated Tables

for more information.

e. If you want to update Salesforce when this document is signed or other events

occur, see Salesforce: Using the Outgoing Data Tool for more information.

5. Add Call to Action buttons.

a. If this document requires eSignature, or if you would like to allow customers to

submit questions, add the Ask a Question button or the Sign button in the top-

right of the document. For more information on Call to Action buttons, see

Including Call to Action Buttons.

6. (Optional) Add Default Taks Options. Using the Tasks panel on a template, you can

pre-set tasks that need to be completed when a document is created from the

template. Add Tasks : If an action or series of actions need to be completed before

the document is published, you can add tasks to your template. These tasks will

automatically be assigned to the set task owner when the document is created. See

Tasks Overview to learn more.

7. (Optional) Add Additional Configuration Options. There are additional template

properties that are useful to administrators.

Configuration Option

Enable Access Code

Allow PDF Downloads

Encble Coverpage

Description

Where to find it: Properties > Privacylf you want to
require that an access code be entered by any document
recipients who view your document via the Public URL,
check Enable Access Code under the Privacy tab in the
Properties.

Where to find it: Properties > OptionsWhile we typically
recommend leaving download options unchecked to
encourage recipients to view your documents online,
enable this option to allow viewers to download the
document as a PDF. Your theme will control the styling of
the downloaded PDF. If using PDF download, review
Optimizing a PDF to configure PDF output.

Where to find it: Properties > Options. If you want to
automatically include Conga Collaborate's standard
cover page, check “Enable Coverpage”. This page is
uneditable.



Configuration Option

Signature Page in PDF

DocuSign

Prevent New Pages & Sections

Enable Print Table of Contents

Tags

Description

Where to find it: Properties > Options. If you want to
automatically include a signature page at the end of
your PDF document so your document recipient can print
and sign the document with a pen, check “Signature Page
in PDF”. This signature page is uneditable without the use
of custom CSS.

Where to find it: Integrations > Electronic SignatureThis
requires enabled DocuSign integration. If you want to use
DocuSign eSignature via your integrated DocuSign
account, check this box. Review DocuSign: Integrating
with Conga Collaborate for instructions on setting up
your DocuSign integration

Where to find it: Properties > Options. If you want to
prevent users from adding new sections or pages on
generated documents, check Prevent New Pages &
Sections.

Where to find it: Properties > Options. Create an auto-
generated Table of Contents page in PDF download.
Upon checking the box, you'll be presented with more
options:

- Insert Before Page - choose where in the PDF
the ToC page will be inserted

- Start Page Numbering on Page - choose
what page to start numbering on

- Sidebar - build the ToC page using the
online ToC sections and pages

- Content - build the ToC page using
document content headers (H1, H2, H3)

Where to find it: Properties > DetailsUse tags to organize
your documents so that they're easy to find. See Using
Tags to Organize Content for more detaiils.



Configuration Option

Email Template

Set an Expiration Date

Set Template Privacy

Description

Where to find it: Properties > DetailsIf your users will send
this document via Conga Collaborate email, consider
providing standard email language by connecting an
email template. See Using Email Templates for more
information.

Where to find it: Properties > DetailsThe Expires in X
Days field allows you to have a document expire a
prescribed number of days after a generated document
has bee published. After the expiration date passes, the
recipient will no longer be able to access the document.
Note: Recipients will not lose access to Accepted
documents.

Where to find it: Properties > PrivacyTo control who
should have access to view and edit this template, set
the template visibility. Refer to Making a Document
Public or Private for more details on privacy statuses.

8. (Optional) Add Features Available by Request

Feature

Add a Custom Signature Block

Set a Template Language

Description

Where to find it: Properties > Options. If you want to
modify the acceptance message that will show for signers
and control what information they are asked to submit
while signing, add a Custom Signature Block to the
template. See Creating a Custom Signature Block for more
informaction.

Where to find it: Properties > DetailsSet the Template
Langauge to control the translation of standard Conga
Collaborate document buttons (ex: the Download
Document button will automatically be translated to the
set language), as well as to select the currency output for
currency fields in a pricing table.



Feature

Apply SFDC Variables

Allow DOCX Downloads

Share Template with
Workgroups

Survey Forms

Description

Where to find it: Integrations > Salesforcelf you want to
“burn in” your Salesforce variables as text upon document
creation, check this option. All variables will be
automatically added to the document as standard,
editable text. Generally, this feature is utilized when users
desire the ability to edit auto-generated pricing tables.
Note: When using this feature, users cannot Refresh
Variables.

Where to find it: Properties > OptionsWhile we typically
recommend leaving download options unchecked to
encourage recipients to view your documents online, check
this option to allow viewers to download the document as
a Microsoft Word document. This feature requires that a
configured Word .dotm file be uploaded to your theme.
The .dotm file will control the default styling of the Word
output file. Review Download to Microsoft Word for more
information about creating your .dotm file.

Note: HTML2Word must be enabled.

Where to find it: Properties > PrivacyShare your template
with the appropriate workgroups so they will have access
to use the template. See Managing Workgroups for more
informaction.

Note: Workgroups must be enabled.

Where to find it: Properties > Formstack. Connect a
Formstack Survey Form to capture information from the
document creator. This Survey Form data can then be
used to populate the document with form submission
data. For more information on using a Survey Form with
your document, see Formstack: Using a Form in a
Document.

9. (Optional) Add Additional Document Creation Options



Document Creation Option Description

Template Mapping and Auto CRM Integration settings using an integrated CRM and

Publishing you would like a template to be automatically selected
based upon CRM data, consider setting up Salesforce:
Template Mapping. Additionally, if you want users to
be presented with a ready-to-send document, turn on
Auto-publish to remove the step of manually
publishing the document.

Content Library Where to find it: Contentlf your document creators will
need access to additional images, files, text snippets, or
pages in order to build their complete document,
consider building out your Conga Collaborate Content
library so users can easily find the right content at the
right time. Create standalone content to be used with
this template as needed. For more details, read Adding
Content to Your Content Library.

10. (Optional) Add Additional Document Recipient Experience Options

Document Recipient Description
Experience Options

Page-by-Page Acceptance Where to find it: Section and page properties
rather than requiring an entire document be accepted,
recipients can select specific pages or sections of the
document to be accepted with their eSignature. For
example, present two order form options and let the
recipient choose which one to accept. Only pages that
are selected will appear in the Signed PDF. See Setting
Up Page-by-Page Acceptance for more information
about page-by-page acceptance.
Note: Page-by-Page Acceptance is only compatible
with Conga Collaborate eSignature.



Document Recipient
Experience Options

Collect Recipient Information
Using Forms

Description

Where to find it: Integrations > FormstackPresent forms
for recipients to complete before or after signature. For
example, collect details about a project team before
an SOW is signed, or collect billing information
immediately after eSignature. For more information on
collecting recipient informattion in a document, see
Formstack: Using a Form in a Document.

1. (Optional) Add Advanced CRM Integration Options

Advanced CRM Integration

Option

Quote Pages

Product Pages

Outgoing Data

Description

Where to find it: Salesforce integration settings. If you
are utilizing standard Salesforce Quotes and want to
dynamically create a page to highlight each Quote on
an Opportunity, configure the template to auto-build
Quote Pages. See Configuring Quote Pages for more
details.

Note: This option is for Salesforce integration only.

Where to find it: Salesforce integration settings. Use
Product Pages to create a page for each child record on
your launching object. This feature is very similar to
Quote Pages but works with any object and child object
instead of just Quotes. Refer to Configuring Product
Pages for more details.

Note: This option is for Salesforce integration only.

Where to find it: CRM integration settings. Configure
Outgoing Data rules in your Conga Collaborate CRM
Integration Settings page to trigger field updates in your
CRM based upon events in Conga Collaborate. For
example, configure an Outgoing Data rule to
automatically update your Opportunity Stage to Closed
Won when the document is accepted. See Outgoing Data
Tool for more information on configuring Outgoing Data
rules.



Creating and Editing Tables

You can create a quick-and-easy table or go all-star advanced with extensive
customization options in your Conga Collaborate documents.

Create standard tables quickly and easily or use extensive customization options to
format table properties like border, border color, background color, and table width.

Tables are used in a multitude of ways in Collaborate, including:

- Displaying contact information
- Displaying products in an auto-generated table
- Displaying information in a grid with no borders

1. Insert a Table.
a. Within the document editor, open the Table dropdown
b. Hover over Insert Table.
c. From the Grid, select the number of rows and columns for your table.
2. Edit Table Properties. Use Table Properties to set overall dimensions and configure the
table's appearance.

Settings like border color, border width, and background color must be set at
the individual cell level. Changing them here will not do anything.

General Tab

- Width - For best compatibility with different-sized devices, always use a
percentage. To set a percent value, you must type in the percent sign - 20%, for
example.

- Alignment - Table alignment on the page (None, Left, Center, Right)

- Height, Cell spacing, Cell padding - should always be blank.

- Caption - Creates a table header that only appears when the table does.
Useful when creating an auto-generated table or putting show/hide logic
around a table.

- Class - sets the table as a striped table or an auto-generated table.

Advanced Options Tab

- Style - CSS language for styling your table cell. This is updated based on your
selections in the other parts of the Table properties menu. If you are
comfortable with CSS, you can also insert your own stylings here.



- Border color and Background color - See note above.

Document Recipient Geolocation Tracking

If a recipient has viewed a document online, geolocation information is available for the
last location where the document was viewed.

To view this information

1. Open the full Tracking Report for the document
2. In the Recipients tab, see the Last Location column where the city and state display
3. Click on the location to open in google maps

Download to Microsoft Excel

Along with the download options for PDF, PowerPoint, Zip (PDF and attachments), and MS
Word Docs, you can also download files in Excel.

©® Thisis a Beta Feature and is only available by request.

Along with the download options for PDF, PowerPoint, Zip (PDF and attachments), and MS
Word Docs, you can also download files in Excel. Currently, only information in tables is
included in Excel downloads.

Instructions to download to MS Excel

1. From within an unpublished document, click Properties (located on the right-side
toolbar) and scroll down until you see Document Options.

Check the Allow XLSX Downloads box.

Navigate to the Table of Contents.

Click Download Document.
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Click Microsoft Excel to download your document.

Download to Microsoft Word

Downloading your Conga Collaborate documents to Word gives you more control on how
you would Llike to deliver your documents to your clients.



In order to setup this functionality, you must be a System Administrator. Additionally, you

must contact your account manager to establish this ability within your account. Once

Download to Word has been setup within your account, this functionality will be available

for all users.

Downloading your Collaborate documents to Word gives you more control on how you

would like to deliver your documents to your clients. This functionality was designed to

improve our customers’ workflows and processes. Downloading your documents to Word is

still in Beta, and our developers are working to improve our ability to do this process. If you

have any other questions about this feature, please reach out to your account manager.

To Create a Word Template
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Open a Word document.

Save the document as a .dotm format using Save As.

Open your Default Theme within Collaborate.

Click the Show Advanced button.

Click the Content button so that you can see the different Heading and Paragraph
styles.

Within Word, click into your Styles Pane so that you have access to your Heading and
Paragraph styles.

Begin the process of matching your Collaborate styles with your Word styles.
Example: If your Heading 1in Collaborate is Helvetica, your Heading 1in Word must
also be Helvetica.

. When you make changes within your Styles Pane, ensure that you are clicking on the

Add to template checkbox.
Continue going through this process until all of the styles within your theme builder
match the styles within your Styles Pane.

. Once you have finished making the necessary styles changes, save your Word

document (Remember, this must be in the .dotm format).

. Within your Collaborate Theme Builder click on the Word Beta tab.

Upload your newly created Word template file.

Do not change the Normal style within your Word Styles pane. Doing this will break
your Word download ability.

Once you have completed your Word Template, you will be able to download your

Collaborate documents to a Word formatt.



To Download Your Documents to Word

1. Open a Collaborate document you would like to download to Word.
2. Click into the Properties tab on the right-hand side of your document.
3. Click the Options tab.

4. Click Enable Word Download.

Duplicating a Document

Collaborate enables you to duplicate your documents.

To Duplicate a Document

1. From the Documents page, click the checkbox next to the document you’d like to
duplicate.

2. Click Duplicate at the top of the Document List (itt looks like two sheets of paper).

3. Your document duplicate appears in your Document List as “Copy of [Document

Name].”

If you are already in the document that you want to duplicate, click the Properties
tab and the Duplicate Button appears at the top of the Properties window.

Editing Fonts in a Theme or Document

We recommend setting your font in the Theme Builder, so you can control your brand and
have consistent document output. While this is a job for a system administrator, further
editing (color, styling, size) can be done by your users within their documents.

To Edit Fonts in a Theme

From your Administration view, click Themes.

Click the Edit pencil icon to edit a Theme.

Click Show Advanced to see more Theme options.

Select your font from the list of available fonts (you can edit the font for your
paragraph text, headers, buttons, table of contents, etc).

Click Save.

Add this Theme to your Template or Document by selecting it in the Properties Tab.
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To Edit Fonts in a Document

1. From whichever document you wish to edit, click on the content to make the Editing
Toolbar appear. Here you will find editor options to style your text.

2. Click Format.

3. From the dropdown menu, click Headings or Font Size to make your changes.

Editing Images While in a document

You do not have to leave your Collaborate document to edit an image. Our Editing Tools
give you the power to resize, crop, apply filters, and otherwise manipulate images right
from the page.

You can access the editing tools by double-clicking an image within any document. Click
the Edit Image button to reach your editing screen. From there, you can manipulate the
image with these options:

- Crop

- Resize

- Orientation
- Brightness

- Sharpen

- Contrast

- Color Levels
- Gamma

- Invert

Editing Tables

You can edit a table from whatever document it's in. Just right click on the table to bring up
an editing window. In order of how they appear in the menu, here’s a rundown of the options
you have for modifying tables.

Editing Table Cells

Hovering over Cell gives you three more options:

- Cell Properties: configure elements such as cell size, type, color, content alignment,
and background and border color.



- Width: Set in pixels or a percent value. Collaborate recommends using
percentage values as it lets you set dynamic proportion of the row that the cell
(and its column) will occupy.

- Height: Set in pixels.

- Cell type: Choose normal data cell (none) or a header cell, which may be styled
differently based on your Theme settings. Setting cells as header cells also
removes the border in between header cells.

- Scope

- H Align: Move cell elements left, right, or center.

- V Align: Set cell elements to appear top, middle, or bottom.

- Class: For cells containing auto-generated content, incoming data will be
formatted to match the selected class

- Merge Cells - merge the selected cells into one.
- Split Cell - split the selected cells into one cell.

Advanced Cell Properties

The Cell Properties editor also contains an Advanced tab that lets you configure these
additional options:

- Style: CSS style definitions that create the visual look of your cell.
- Border Color and Background Color: Use one of the following methods to set border
and background colors

- Select your color by clicking into the color text box and then choosing from the
color palette.

- Enter the RGB value in the text box, in the rgb(nn, nn, nn) format, where nn is a
numeric value on a scale from 0 to 255 representing the red, green, and blue
channel. For example, you'd enter rgb(00, 00, 255) for blue.

- Enter your color’s hexadecimal RGB value in the modal, using the format
#nnnnnn, where each pair of nn is the hexadecimal representation of the RGB
values for red, green, and blue, respectively. For blue, enter #0000ff.

Editing Table Rows

Hovering over Row in the table context menu gives you several row edit options:

- Insert Row Before

- Insert Row After

- Delete Rows

- Row Properties - clicking Row Properties gives users the following options:
- Edit Row Type (header, body, footer)
- Alignment (none, left, center, or right)



- Height
- Advanced Row Properties - manipulate style, border color, and background
color.
- Cut Row
- Copy Row
- Paste Row Before
- Paste Row After

Editing Table Columns

The Column option lets you insert columns before or after the current column as well as
delete columns.

Deleting Tables

To delete the whole table and its contents, use the Delete Table option.

Embedding Files into Documents

You can add PDF, doc, docx, ppt, pptx, xls, or xlsx files to your Conga Collaborate
documents by following these steps

Any file that you upload becomes part of your Content list.

Add a PDF, doc, docx, ppt, pptx, xls, or xlsx files to your Collaborate documents by
following these steps:

1. From the document into which you want to embed your file, click the Content tab.
2. Choose Files from the dropdown menu.

3. Drag and drop the file you want into your document'’s Table of Contents.

4. Available drop zones appear in yellow, and your target drop zone becomes green.

Embedding Media

Collaborate allows users to easily add videos and other media in documents

To Add Media to Proposals

1. From YouTube, Vimeo, Wistia, or wherever you found the media you want to embed,
click Share or Embed to get the source code. If the code is unavailable, you can use an
IFrame to embed your content.



2. Copy the complete source code.

3. Within the document that you want to embed content into, make sure your cursor is in
the spot where you want your video to appear, and click Insert Video in the editing
toolbox at the top of the page.

4. In the pop-up window, paste your media source code that you copied in Step 2.

5. Click OK.

To Add Media to Presentations

1. From YouTube, Vimeo, Wistia, or wherever you found the media you want to embed,
click Share or Embed to get the source code

2. Copy the complete source code.

3. Within the presentation document, click Insert Video in the editing toolbar at the top
of the page.

4. Click Add.

Paste the embed code into the Video URL field at the top of the page.

6. To view the video in build mode, double click in the video frame.
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Only media with an HTTPS URL can be embedded into your documents. You can
sometimes contact your source website to get a secure link if one isnt
automatically available.

Enabling Print Table of Contents

Collaborate’s Print Table of Contents feature automatically creates a table of contents
page in the PDF or Word document that users can click through to navigate to specific
pages of the document.

The Print Table of Contents includes the section name, page title, and associated page
numbers, and you can include it when you print a document.

To Enable Print Table of Contents

1. From the Build view of your document, click the Document tab.

2. Scroll down to Document Options and click the arrow.

3. Click the checkbox next to Enable Print Table of Contents on the far right side. This
enables a separate page for your Table of Contents.

4. Choose where you wish to insert your Table of Contents in print.



Enabling Proposal Download Formats

A system administrator can choose which file formats users may utilize for documents

created and shared through Collaborate.

To enable the formats

1.
2.
3.

From the User Drop Down Menu (gour avatar), click Administration.

From the menu on the left, click the Account Settings icon.

Select the formats you want to enable (PDF, Word, PowerPoint, or ZIP) under Proposal
Download Formats.

Click Save.

Filtering your Document List

When you're in Document List view, a list of filters appears in the Table of Contents panel

to help you quickly find what you're looking for.

These filters include:

- Saved Searches

- All Documents

- My Documents

- Recent Documents: Click the gear icon to choose a time frame.

- Last 7 Days

- Last 30 Days

- Last 60 days

- Last 6 months

- Archived Documents

- Presentations

- Presentation Templates

- Proposals

- Proposal Templates

- Contracts

- Contract Templates

- Drafts: Unpublished documents

- Open: Published documents that haven’t been accepted or declined
- Pending Approval: Documents awaiting approval, which can no longer be edited
- Accepted: Documents that have been accepted by your client



- Declined: Documents that have been declined by your client

Click any of these filters to place a search operator into our advanced search bar. You can
combine these filters to create custom search filters.

Finding Content with Filters

When you are in the Content view, you can easily find the content elements you are looking
for by using the filters in the Table of Contents panel on the left.

Click on an attribute from the list to find:

- My Content

- Recent Content (Click the gear to specify a time frame.)

- Expired Content: any content that has passed your chosen expiration date; can still
be reinstated

- Content in Draft form: new content that haasn't been published

- Content Type: Image, File, Text Snippet, Pages, Slide Content

Search for files by any one category, or combine them for a custom search, which you can
save. Use any of your saved searches by clicking the option at the top of the Table of
Contents panel on your Content page. (You can also access saved searches from your
Documents view.)

Font Manager in Conga Collaborate

An overview of the Font Manager in Conga Collaborate and how to use it to add new fonts
to your platform.

Collaborate gives administrators the ability to search and load Google fonts into your
Collaborate account. Loaded Google Fonts will be available in your Collaborate Theme
for use in Collaborate Proposal or Contract document types. You will keep access to the
default Fonts Collaborate offers today.

Visit Google Fonts to see a selection of Google Fonts available. A font must have an “Open
Font License” to be loaded in Collaborate.

To add a Google Font to your Collaborate account

1. Open your Collaborate Administration panel and select the Font Manager.

2. Type into the Font Manager search bar to select the Google Font you wish to load.

3. The Regular (400 weight) variation of the Font is included by default, and you can
select additional Font variations by checking the box next to each variation.


https://fonts.google.com/

4. Click Add Font.
5. You will see the newly added Font showing on your Font Manager Llist

To Edit or Remove a Google Font from the Font Manager

1. Open your Administration panel and select the Font Manager.
2. From the list of added Fonts, you may click to Edit this Font to add additional
variations or you may click to Delete the Font from the Font Manager.

To use a Google Font in your Collaborate Documents
(Proposal and Contract document types)

1. After adding a Google Font to your Font Manager using the steps above, open your
Administration panel and select Themes.

2. Select a Theme and click Edit to enter the Theme Builder.

3. Using the tools on the right side of the page to edit your theme, you will now be able
to see your loaded Fonts when you open a list of available Fonts. The Fonts you have
loaded into your Font Manager will show at the top of the Font list followed by the
default Fonts Collaborate offers. Select the Font for the appropriate area of your
Theme and click Save.

4. The Font selections made in the Theme will impact documents using this Theme.

5. You can refer to these support article for additional details on editing Fonts and
Themes:

Getting Started with the Theme Builder

Editing Fonts in a Theme or Document

We suggest limiting each Collaborate Theme to no more than 3 different fonts for
optimal document load time.

Format Dates Using Conga Collaborate Document
Scripting
Format dates in Conga Collaborate with Document Scripting.

Collaborate gives you the ability to set how dates are displayed within Collaborate using
the scripting method to_formatted_date(). Adjusting the different parameters sets dates to
appear just as you want them in your documents or templates.



Just as with any document scripting method, use only lowercase letters for your variable
names, and begin and end with the statement with {{double braces}}.
Available parameters:

- %A - displays the full day name (example: Saturday)
- %B - displays the full month name (example: May)

- %d - displays the day of the month as a number

- Y%om - displays the month as a number

- %y - displays the year

You can format dates in the following ways:
05/08/2017 {{opportunity_closedate.to_formatted_date("%m/%d/%Y")}}

In the example above, uppercase Y displays a four digit year. To display a two digit year,
change the capital Y to a lowercase y.

05/08/17 {{opportunity_closedate.to_formatted_date("%m/%d/%y")}}

The above examples force a two digit month and day. To display single digit days and
months when appropriate:

5/8/2017 {{opportunity_closedate.to_formatted_date("%-m/%-d/%Y")}}

You can also use hyphens instead of forward slashes as well as change the order in which
the pieces of your date appear:

2017-05-08 {{opportunity_closedate.to_formatted_date("%Y-%m-%d")}}
Finally, if you want the full day, month, date, and year displayed:
Monday, May 8, 2017 {{opportunity_closedate.to_formatted_date("%A, %B %-d, %Y")}}

Generating a Cover Page

Collaborate can auto-generate a cover page for any proposal you create. This page
includes the proposal name, author name, client name, and delivery date. Enable the
feature to use our auto-generated cover page; if you would rather create your own custom
cover page, leave the cover page feature off and use your first content area to draft your
own.

To enable the auto-generated cover page

1. From the Build view of the document you want, click the Properties tab.
2. Scroll down to Document Options, and click (or unclick) the checkbox next to Enable
Cover Page. Your change saves automatically.



How Do | Change a User to an Administrator?

If you are a system administrator you have this ability to change a Collaborate user to an
administrator. This is accomplished from the Administration view.

To change a Collaborate user to an administrator

Click on the User Drop Down Menu (your avatar).
Click Administration.

Click Roles and Permissions.

Click on the Administrators group.

Click Add User.

Select the user you would like to add to this group.
Click Add User.
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Resetting a Password

To change a user's password

1. Open your user dropdown in the top right corner of the screen.

2. Click User Profile.

3. Inthe Change Password section, enter your current password, create your new
password, and then confirm it. Be sure to follow any password rules that your admin
may have set up.

4. Click Save.

If you forgot your password, go to your account login page and select Forgot Your
Password?. Password reset instructions will be sent to the email address associated with
your user.

How to Find and Replace Text in a Document

Say you decide your Face Kick program should take on a somewhat gentler name. You can
make that happen quickly with Find and Replace.



To find and replace text in a document

1. From the document, you wish to search, click on any page to make the Editing
Toolbox appear.

2. Click the Edit button.

From the dropdown menu, click Find and Replace.
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4. Enter the text you would like to search in the Find field, and if you would like to
replace it, enter that new text in the Replace With field. Use Match Case or Whole
Words to add further specificity.

5. Click Find. Your search results are highlighted in gray, and the current selection is
highlighted in blue.

6. You can click Prev or Next to cycle through the found text

- Replace: replaces the single selection highlighted in blue

How to Format Currency

Format currency in Collaborate documents.

You can use the following formula to convert variables into currency within your documents
or templates:

{{ number_to_currency(variablename) }}

The variable name must be lowercased and also must begin and end with {{ }}.
For example, you might use the following syntax:

Second_Number = 1000.32

Input: {{ number_to_currency(second_number) }}

Return: $1,000.32

This defaults to $ as the unit and a comma as the delimiter.

You can change a unit by using unit: X"

Input: {{ number_to_currency(second_number, :unit=>"&pound” )}}
Return: £1,000.32

You can change delimiters by using delimiter: “X"

Input: {{ number_to_currency(second_number, :delimiter=>".") }}
Return: $1.000.32

Combine unit and delimiter changes like this:



Input: {{ number_to_currency(second_number, :delimiter=>'/, :unit=>'¢") }}
Return: ¢1,000.32

You can add precision as well:

Input: {{ number_to_currency(second_number, :precision=>3) }}

Return: $1,000.324

How to Use Saved Folders in Conga Collaborate

Conga Collaborate allows you to use and create saved folders with filters so that you can
quickly locate your content in the document build view.

To access a saved folder

1. Open the Document Build View.
2. Under the left-hand side content panel, click Saved Folders.

To create a saved folder

1. Go to the Content tab.

2. Set a filter with your required criteria. For example, you might set a filter that
searches for all content tagged with "North America Sales Kickoff".

3. Click Save as Folder.

4. Enter a name for your folder.

5. Click Shared if you want your folder accessible to others in your organization and
leave it unchecked if you want the folder private and viewable only to you.

6. Click Save.

When you create a shared folder, select filter options that are specific to your content. For
example, some of the filter options include the ability to search by type, owner, and tags.
We recommend utilizing tags as one of the best ways to easily filter content. When you
create tags, avoid generic tags like "Sales Kickoff" and use something more specific to group
your content, like "North America Sales Kickoff".

To edit or delete a folder

1. Go to the Content tab.
2. Click Folders on the left-hand search panel.
3. Click the pencil icon to the right of the folder to edit.



4. Click on the trash bin icon to the right of the folder to delete.

In-Line Commenting

In-Line Commenting allows Contracts users and their clients to communicate back and
forth immediately within their documents. This allows for better communication and more
informed changes when you are working on your contracts.

Additionally, this In-Line Commenting will drastically decrease the number of email
exchanges that take place between you and your clients because you will be able to
communicate almost instantaneously through Collaborate.

To Utilize In-Line Commenting

1. Create and send your contract to your client.

2. Your client can click the Change Request button.

3. Highlight text or images, or double-click an area of text or images and the Comment
functionality will become available in the editing toolbar.

4. Click the Comment button.

Enter your comments within the pop-up box that appears.

6. Hit enter when you are done making your comments. Your comments will now appear
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on the right-hand side of your contract.

The contract owner will see these comments come through on the document, and they will
be able to respond to them immediately. This allows for improved back and forth dialogue

and editing.

Inserting and Removing Page Breaks

If you choose to include the PDF option along with your Conga. Collaborate document, you
can ensure a quality output by inserting page breaks via the content editor.

Page breaks force a new page when downloading to PDF from a Collaborate document.

Separate Collaborate content pages do not automatically force a page break in PDF
download, so it is necessary to insert page breaks at the end of pages to ensure that each
distinct Collaborate page starts as its own PDF page. In addition, since Collaborate
content pages can be as long as you want them to be, you might want to force a page
break in the middle of a Collaborate content page when it is downloaded to PDF.



To insert page breaks

Open your document.

Place your cursor where you would like a page break inserted.

Click Insert from the Menu Bar.

Click Page Break. You will see two dotted lines representing your page break inserted

> w N~

on the page.

To remove a page break

1. Click the page break you want to remove such that your cursor sits on or just below
the page break.

2. Click the left arrow on your keyboard.

Press Shift+Enter.

4. Make sure your cursor is on or below the page break and hit backspace.
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Inserting Images into Documents

After you upload image files, they live in your Content Library, where you can easily pull
them into documents. We prefer the Content Library system because adding an image by
its URL leaves you open to losing your image if the URL changes.

When an image reaches your Content Library, it stays there until you decide to remove it.

(Collaborate provides unlimited storage.)

To insert images by gallery

1. From the document, you would like to add an image to, click on a content area to
bring up the editing toolbox.

2. If you are in a presentation, click Image and then click Add to access the image
gallery and select. If you are in another kind of document, click Insert and then
click Insert Gallery.

3. Select the image(s) you would like to include.

4. Click Ok.

To insert images by dragging and dropping

1. From the document, you would like to add an image to, click the Content tab.
2. Click Images and a gallery of the images in your Content Library appears.



3. Drag and drop the images you want into your content page.

You can edit any of your images from within your documents by double-clicking on the
image.

Inserting Variables into Content

Variables are pieces of data that inform the dynamic behavior of a document.

This article discusses how to insert variables into a document, template, or content asset to
create text that is dynamic-- meaning the text can change based on data provided to
Collaborate. For more information on specific types of variables, see the Variables
overview article.

Variables streamline the document creation process. For example, variables can drive
showing or hiding specific pages in a document, showing or hiding specific paragraphs, or
autocompleting sections of text, tables, and other information.

To insert variables into your content

1. In a document, template, or content asset, click the Variables panel on the right side.

2. You will see a drop-down list showing the types of variables available to you. Expand
the categories or search the variables by name using the search bar at the top.

3. The most commonly used type of variable is a field from your integrated CRM.
Expand the Salesforce or Dynamics CRM category, for example, to see fields that you
have mapped from your integrated CRM.

4. Place your cursor in the document content where you'd like the variable to appear.

5. Click the + sign next to the variable name to add the variable to the document.

You can also type the “%"” sign in your document to pull up a list of variables while
creating content. As you type after the “%" sign, the list of variables will be filtered
based on what you type.

Viewing Variables

Variables inserted into a template or content asset will display the field name highlighted
in gold. This indicates that when a document is created from that template or contains
that page, the variable will auto-complete with data from that field.

Variables on a draft document will display the actual variable value, if available. A
variable displaying “No Value” indicates that your document does not have an associated
value for that variable.



Formatting Variables

After you insert a variable in a document, template, or content asset, you may change the

format in which the variable will display.

For example, you may want to ensure that any variables that contain dates display in
specific month/day/year format or that URLs appear as active links. Or, if you have a
number variable that should be formatted as money, you can enter a unit type, the type of
delimiter you would like to appear, and the number of decimals you would like to be

displayed.

To format a variable

1. Click on the variable. A menu appears above it displaying the variable name and
type.

2. Click the > icon near the variable name.

A second menu opens that allows you to select the type.

4. The type drop-down allows you to specify the variable’s data type. The supported
options include string, image, link, iframe, date, and number. Each data type has its
own formatting options which will appear automatically once a specific type is
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selected.

It is best practice to format these types of variables in templates so that users do
not have to reformat variables when creating live documents.

Making a Document Public or Private

For any of your Documents, Presentations, Templates, pages of content, or Content, you
can determine who does what by changing the privacy settings.

By default, Collaborate standard users cannot edit visibility settings, and their documents
and Content are marked as Private. To change these settings, create a custom role and
enable the permission “Allow the ability to make library items public.” This will default their
documents and Content to the public and will allow them to edit visibility settings.

Visibility settings differ based on whether or not your account is using workgroups. If
workgroups are not enabled, then you have two settings, Private and Public:



Private - You can see and edit the item, along with anybody designated as your
Manager in the Conga Collaborate user hierarchy.
Public - Every user can see and edit.

If workgroups are enabled, then you have three settings:

- Shared with no workgroups - You can see and edit the item, along with any user

designated as your Manager in the Collaborate user hierarchy.

- Shared with all workgroups - Every user can see and edit.

- Shared with some workgroups - Users in the selected workgroups can see and edit,

along with any user designated as your Manager in the Collaborate user hierarchy.

There are three locations from which you can edit the visibility settings of a document or

content element:

To edit visibility from the Document list

1.
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Click on the Icon Box of the document on which you would like to change the visibility
settings.

Select the Edit button that appears in the top right-hand corner of the page.

Click on the Privacy dropdown.

Select one of the privacy settings as described above.

Click Save.

To edit visibility from the Content library

1.

Click on the thumbnail of the content element on which you would like to change the
visibility settings.

Select the Edit button that appears in the top right-hand corner of the page.

Select one of the privacy settings as described above.

Click Save.

To edit visibility from a Document of piece of Content

1.
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Open the document or content element on which you want to change the visibility
settings.

Open the Properties panel.

Navigate to the Privacy section.

Select one of the privacy settings as described above.



Migrating from Proposals to Documents

Where once you relied on TinderBox Proposals, now you're getting the job done in Conga
Collaborate Documents.

Migrate your Conga Collaborate document records from the Octiv Proposal object to the

Octiv Document object.

The Octiv Document object provides more flexibility in creating documents and will be the
object supported and upgraded in future managed package releases. The Octiv Proposal
object will not be removed for legacy customers, but updates will not be made to it going
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Pre-Migration Preparation

There are a couple of things that you must check before migrating your proposals:

1. If you have created custom fields on the Octiv Proposal object, make sure that you
create those same fields on the Octiv Document object

2. Check that your users have permissions to Read and Write to the Octiv Document
object and also that they have Read/Write permissions on all the fields on the Octiv
Document object

Export Octiv Proposal data

You can use whatever data loader tool you like, but we recommend dataloader.io. The
instructions below apply specifically to dataloader.io, but also work with Salesforce Data
Loader with some slight tweaks due to the different user interfaces.

Click New Task, then select Export

Search for and select Octiv Proposal

Click Next

Add filter criteria. If you have a large volume of Octiv Proposal records, use filter
criteria to run the migration on a batch of test records to make sure you complete the
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process correctly before migrating your entire set of records. Some suggestions for
filter criteria:
- Document Status
- Created Date
- Related Opportunity Stage
5. In the left-hand field selector panel, choose all Octiv Proposal fields
6. Click Next


https://dataloader.io/
http://dataloader.io

7.
8.

Click Save & Run
After the job is finished, save/download the export file

Prepare Export File for Creating Octiv Documents
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Open the export file you created in the Export Octiv Proposal data section
Copy the values in the column Created By ID

Add a column to the right of Created By ID

Paste the values copied in step 2 into the new, empty column

Rename the column Owner ID

Save this file as a CSV

Import Octiv Documents via dataloader.io
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In dataloader.io, click New Task, then select Import

Select the Insert operation

Search for and select Octiv Document

Click Next

Drag and drop the CSV file from the Prepare export file for creating Octiv

documents section, or simply click Upload CSV and select the file from your computer
Find Proposal Name under Source Header, and click Select under Salesforce Field

. Select Document Name. If you have created custom fields on either the Octiv Proposal

or Octiv Document object, ensure that those columns in the CSV are mapped to their
corresponding fields on the Octiv Document object

Click Next

Click Save & Run

. Verify that Documents were properly created by refreshing the report from the Export

Octiv Proposal data section.

(Optional) Delete Octiv Proposals via dataloader.io

Migrating Octiv Proposal records to Octiv Document records does not delete the old

Proposal records. If you wish to delete these old records, follow these steps:

> w N~

o o

In dataloader.io, click New Task, then select Delete

Search for and select the Octiv Proposal object

Click Next

Drag and drop the export file you built in the Prepare Export File for Creating Octiv
Documents section, or simply click Upload CSV and select the file from your computer
Click Next. The screen asks which column contains the IDs of the records to be deleted
Select the row with Source Header Record ID
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7. Click Next
8. Click Save and Run

Repeat this process as necessary until you've migrated all of your Octiv Proposal records to
Octiv Document recordes.

Monitoring user sign-ins
How often are your users signing in to Conga Collaborate? Let us tell you.

If you're a System Administrator, you can find this information from the Administration view.
Just click Users and the User List appears, along with each user’'s most recent sign-in and
total sign-in count.

Conga Collaborate Document Signing Experience

Conga Collaborate utilizes the power of e-signature tools to make sending and signing
online documents easy and streamlined. You can determine the level of access to a
document, track the status of individual signers, and easily adjust signer order - all from
within Collaborate. This article will explain the permissions you can give to document
recipients as well as the different signing experiences available through Collaborate and
DocuSign.

To learn about how to send documents to recipients, see the article Delivering Online
Documents to your Recipients

Set Recipients' Permissions

With the Collaborate document signing process, you can easily specify what level of
access each person has for a document that is shared with them. Below are the recipient
permissions by document type(s) on which those permissions are available:

Proposals & Contracts

Signer - recipient can sign the document Can add signers - recipient is allowed to add other
signers to the document Can add collaborators - recipient is allowed to add other people
to view the document (but not sign)



Contracts Only

Can redline - recipient is allowed to redline and make change requests to the text of the
document

Adding Multiple Signers

When using the Add Salesforce Contacts button, all signers will default as
Collaborators regardless.

Collaborate has two signing experiences depending on the type of document you are using
(proposal or contract) and whether or not you have DocuSign. This section will walk
through the signing experience with multiple signers in scenarios where you sign with and
without DocuSign.

Proposals without DocuSign

When DocuSign is not enabled you can still add multiple signers to a document using the
built-in Conga Collaborate e-signature tool, but Collaborate defaults to a “first come, first
sign” approach. This means that whoever signs the document first will sign it for everybody
listed as a signer on the document. This workflow is useful if, for example, you have multiple
sales directors who can all sign off on a document and you only need one signature from
the group.

Alternatively, Collaborate supports setting signer order in cases where you need multiple
signatures for a document.

Once this is turned on, follow these steps to set signer order:

1. On the template, in the Properties panel in the Document Options section, check the
box “Require ALl Signers for Acceptance”

2. Either on the template (if you want the signers to be on every document generated
from that template) or on a generated document, add people as recipients as
described earlier in this article

3. Set the signer order by putting the desired order number in the “Signer Order” text field

Once signers have been added to a document, you can change signer order by clicking on
the drop-down arrow next to the recipient’s signer number and choosing a different position.



Proposals and Contracts with DocuSign

If DocuSign is enabled in your account, signer order is enabled by default. Add recipients as
described earlier and set their signer order. Signer order can still be changed by clicking on
the dropdown arrow and choosing a different position.

In signing documents both with and without DocuSign, signer order cannot be changed once
a signer has clicked the “Accept” button.

Restoring Deleted Recipients

Recipients can be deleted at any time before they use their unique URL to view the
document and Conga Collaborate will not keep any record of those recipients being added
to the document. However, if recipients have viewed the document and you now want to
delete them, Collaborate will mark those recipients as deleted but keep record of them on
the document. Their unique document URLs will be invalidated and they will no longer be
able to view the document. If at some point you want to add them back as a recipient on
the document, you can do so by going to the People tab and clicking Restore on the
recipient’s business card. This will re-activate the unique document URL and allow them to
view or sign the document (depending on the permissions you gave them originally).

Reinstating a user who has been locked out

Password mishaps can lead to a user being locked out of Conga Collaborate, and a
system administrator may need to unlock that user.

To unlock a user

From the User dropdown menu, select Administration.
Click on the Users icon.

From the options on the right, select Locked Users.
Click on the user profile you intend to unlock.
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In the upper right corner, click the Unlock User button.

Repeatable Pages

Repeatable pages provide flexibility for content managers by allowing for multiple
templates for a page.



Conga Collaborate has the ability to create a page or section for each child record on a
launching object. For example, if launching off of an Opportunity in Salesforce, users can
make a page or section repeatable so that a generated document has a new page or
section for each product on the Opportunity. This is very similar to how Collaborate creates
auto-generated tables to display the products on an Opportunity, but this feature instead
creates a page for each product instead of a row in a table.

Repeatable pages provide flexibility for content managers by allowing for multiple
templates for a page. For example, suppose a content manager wants to have two layouts
with different formatting and images for his repeatable page dependent on the location of
the client. He could create two repeatable pages with different layouts and then hide the
page that doesn’t apply to the client’s location.

Creating Repeatable Pages

To set up repeatable pages, follow these steps:

1. On a template, click on the gear icon next to the page title of the page you want to
make repeatable.

2. Go to the Repeatable tab.

Select the data source for the page.

4. Select the Render Page Contents checkbox (Render Page Contents makes it so that
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Collaborate replaces the variable names with their actual CRM values. If you want
to see the variable names instead of their CRM values, leave this box unchecked).

5. Populate the repeatable page with content. In order to use variable names, follow
these steps:

- Open up your CRM integration settings by going to Administration >
Integrations and selecting your CRM.

- In the Incoming Data section, open up your launching object dropdown and
scroll down to the Child Relationships list that corresponds with the data
source for your repeatable page.

- Copy the variable names into your repeatable page, surrounded by {{ double
brackets }} Ex: {{PricebookEntry.Product2.Name}}

Making a section repeatable removes the Repeatable tab from individual page properties.
Pages can still be set as repeatable by turning off repeatability for the section and setting
the page as repeatable, then re-enabling repeatability for the section.



Repository: Document Linking

Create relationships between documents by using the Document Linking feature within
Conga Collaborate. This tool associates documents with each other through relationships
that you define.

When using the repository features of Conga Collaborate, document linking makes is much
easier to find documents that are related to each other in some way. By having all linked
documents available in one location, you can quickly see which documents amend others,
see parent-child relationships between documents, or find supporting documents for a high-
level client contract.

To link documents

1. Navigate to the Documents tab.

2. Select the checkbox next to the document you would like to associate with another
document.

3. In the sidebar on the right, below Document Relationships, click Select Option and
select a relationship type (the relationship options are managed by your Conga
Collaborate system administrator and are fully customizable).

4. Click Search Documents to select the secondary document.

5. Click Add.

Both documents will show up in the Document Relationships area, with their relationship
displayed as you defined. Both documents will be clickable so that you can quickly pull up
and view related documents.

Repository: Document Upload

Documents can be added to the repository at any time and are viewable by all users in
Conga Collaborate.

Navigate to the Documents tab
Click More, Upload External Documents
Click Choose file (the current maximum file size limit is 1I00MB)
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A new window will open where you can navigate to the file to add to the repository.
Click Open
Click the drop-down titled Metadata Template and select Import.

o

A new list of metadata attributes will be displayed. Based on the field type, type in
text, select from a drop-down menu or enter a date. This step is important because



adding the appropriate metadata values here will allow you to search for the
document in the future.
7. Hit Submit to finish the import

Repository: Document View / Download

Once a document has been located through a metadata or keyword search, there are two
actions you will likely want to perform: Viewing and Downloading.

Document View

Navigate to the Documents tab

Click the document you would like to view from the list

Click View Document

A new window will open where you can view the document

Once you are done viewing, click the X to return to the document Llist
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Document Download

1. Navigate to the Documents tab
2. Click the document you would like to view from the list
3. Click the download icon (this will open a new window allowing you to save a copy to

your computer)

Routing documents to internal people

Our templates enable you to put processes in place by setting up notifications for
colleagues who need to review or sign your documents. Instead of adding these recipients to
each document, you can ensure every document you create, through a template, will pull
over the correct internal recipient information and land in the right hands.

To add recipients to your templates

1. From your Documents view, use the menu on the left to navigate to the template you
want.

2. With the template open, click the People tab.

Click Add People.

4. From the pop-up window, you can add the people associated with the template and
set their role, if they are a signer you can also set their signer order.

- To add a new signer, click Add, fill out the fields for your signer’s name and
contact information and ensure you select “Yes” under Signer.
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- To add a non-signer, fill out the contact info fields and ensure you select “No”
under Signer.
5. Click Done.

Your changes will apply to all documents created from that template.

Searching in Conga Collaborate

Collaborate search gives you the ability to find documents or content through three
methods: keyword search, advanced search, or pre-defined search filters. You can also
create and save custom search filters for later use.

Often times your Collaborate library is too large to manually find the documents and
content you need. Using search allows you to quickly narrow down the list using document
attributes, predefined filters, or previously saved searches.

Collaborate has several default search filters that can be found in the left-hand panel of
the Documents and Content libraries.

Document default filters are:
All Documents

My Documents

Recent Documents
Archived Documents
Deleted Documents
Proposals

Proposal Templates
Document Status

Content default filters are:
All Content

My Content

Recent Content

Expired

Drafts

Images



Files

Snippets

Pages

Custom and advanced searches can be created using the instructions in these articles:
Use search operators to narrow results

Filter results using the advanced search tool

Sending contract change requests

Document owners and recipients use change requests to easily negotiate a contract and its
terms right on the document, without having to circulate a marked-up version of the
document. You never lose any part of the process; a history of changes shows the day and
time each change was made as the document moved toward its final form. The document
owner is notified any time a change request is submitted and can then approve the
changes (or not).

Depending on whom you’ve sent your contract to, you can send a change request to all
recipients, including those outside your organization, or just to internal users.

To create a Change Request

1. In the published Contract you want to edit, click the New Change Request call to
action button OR go the Versions tab in the Document Panel.

2. Edit your document; changes are highlighted as you make them. You can turn off the
highlights by clicking the checkbox next to Highlight Changes in the Document Panel.

3. Click Submit for Approval in the Document Panel. (Or Cancel Change Request if you
have a change of heart.) The contract owner receives a notification that a change is
ready for review.

Whenever you're making or reviewing a Change Request, you have an option to comment.
Click Show next to the Comments icon at the bottom of the Document Information Panel.
You'll then see all comments regarding that change—and a text box that enables you to
add your own.

Setting up a Change Request Approver

Prevent contract anarchy by assigning Change Request Approvers. These users receive
notifications of proposed contract changes so that they can accept or reject those
changes.



To set up different Signers and Approvers in your contract

1. Within the contract, click on the People tab.

2. You'll find a Change Request Approver label; click the Select button directly below it.

3. Click on the name of whomever within your organization you want to be notified to
accept or reject changes.

Switching Document Size

In an effort to switch to a wider, more modern document size of 816px, we have rolled this
option out for new clients and our existing clients have the option to switch to the new
document size at their own will. This is the size document you would see when you open up
a Google doc, for example.

If your Conga Collaborate account was created prior to March 2017, your documents may
show a smaller than 816px size. If so, as a Conga Collaborate Administrator, you can go
into your Account Settings and change to the larger document size.

We recommend checking all your templates after updating this setting as they may look
different - we don’t want you to have any surprises.

Tasks overview

Tasks allow for seamless collaboration. You can set Tasks for internal use within your
Conga Collaborate documents.

Any document owner can set a Task and assign it to another internal user with a deadline.
If you assign a Task, you're notified when it is completed. All users will see tasks assigned to
them, on their dashboard, when they first log into Conga Collaborate. Managers will also
be able to see a list of their direct reports’ tasks.

A document that contains Required Tasks can not be published until all Tasks have been
completed.

To create a task

1. From the Build View of the document you wish to add a task to, click the Tasks tab.
2. From the Tasks panel, choose New Task. You can now set

- A Description of your Task.

- The Assignee who will complete the Task.



- The Due By date.

- Whether the Task is Required.

- Comments about your Task.
3. Click Assign Task.

You can create multiple Tasks for multiple Assignees. The Assignee just clicks the checkbox
next to an assigned Task when it has been completed, and the document owner is notified.

The filters panel

The Filters panel displays any filters defined for the view. You can set the filter values and
see the resulting change in the Report View panel.

To hide the Filters panel, click the icon in the top left corner of the panel. Click the same
icon on the minimized panel to expand it again.

Tracking documents

You can check in on your documents by choosing to be notified by email or text when a
client opens a document, accepts a document, signs a document, and so on.

What's going on with your documents? You can check in to find out—or stay on top of
changes by choosing to be notified by email or text when a client opens a document,
accepts a document, signs a document, and so on.

Tracking data on documents is only available after a document has been published. It is
account-wide and up to date when you view it.

To see your tracking data

1. From your Document List, click on the document you wish to view.
2. Click Track along the Navigation Bar. You see the following data:
- How many times the document has been viewed.
- Who last viewed it.
- Amount of time it was viewed (in minutes).
- Age of the document.
3. Click View Full Report to drill into the single document data. You will see further
tracking data, including:
- Document Status
- Total Views
- Total Value
- Days to Close



- Comments

- Tabs that enable you to get details about

- Recipients, including views, page views, and time spent

- Content, including who's viewing the page—and for how long

- Activity, which provides a running list of what’s happening with the document

You can also access tracking information by clicking the title of the document.

Using anchor text

Anchor text tags are hyperlinked words or phrases that, when clicked, take you to a certain

place on the same page.

You can use this feature on a single page of content; you cannot have an anchor that links
to another page in the document.

To create an anchor text tag

1. Place your cursor in front of the content where you’d like the recipient to land after
clicking the related anchor

Click Insert in the Menu Bar

Click Anchor

Name your anchor and click OK (a small anchor appears in your content)

Place your cursor where you’d like the Llink to your anchor to go

From the Insert dropdown menu, click Insert Link. In the pop-up window, you see a field
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for Anchors

~

Select the name of your anchor
Click OK
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Using Email Templates

Email templates can be created for system events, such as Document Accepted, Document
Declined, or Task Assigned, or you may want to have different email templates for different

document types.

Conga Collaborate emails are completely customizable. Email templates can be created
for system events, such as Document Accepted, Document Declined, or Task Assigned, or
you may want to have different email templates for different document types. For
example, if you're sending out a contract, the email you craft will be different than when
you're sending an introductory proposal.



You must be a system administrator to edit System email templates and create Shared
templates.

Create Templates - System Administrator

To create email templates

1. Go to Administration > Email Templates
2. Click Create
3. Select Template Type
- Personal will make the template private to your user
- Shared will give all users access to the template. If workgroups are enabled,
this will share the template across all workgroups.
4. Fill out Template Name, Subject, and Body. You can insert variables into your email
template:
- Click Insert Variable
- Choose variables from the Document, Recipient, or CRM tabslf you launch
documents from multiple objects, your template can only contain variables
that relate back to your launching object.

Create Templates - Standard User

Standard User email templates are automatically set to Personal.

To create email templates

1. Go to User Profile > Email Templates
2. Click Create
3. Fill out Template Name, Subject, and Body. You can insert variables into your email
template:
- Click Insert Variable
- Choose variables from the Document, Recipient, or CRM tabslf you launch
documents from multiple objects, your template can only contain variables
that relate back to your launching object.

Set Default Email Template for Document Templates

You can set a different email template for every document template in your library. If you
don't set an email template for a document template, the document will default to the
standard Conga Collaborate email template.



To set the default email template

1. Navigate to the Properties of the document template
2. Select the appropriate email template from the drop-down menu

You must have the ability to edit the document template in order to set the default email
template. When setting the default email template, you will only have access to email
templates that are shared, so that you cannot set a default template that others can't
use.

Choose Email Template When Sending Document To
Recipients

To choose from the email templates available to send a document
instead of using the Conga Collaborate or template default

1. On a published document, add recipients and then click Send Email
2. Choose your desired email template from the Template drop-down

Using referenced content

For content that's likely to change, use Referenced Content to easily update pages and
slides across templates. Referenced Content enables you to:

- Give your team immediate access to the most up-to-date content

- Easily maintain accurate, approved, and up-to-date document templates
- Improve content management

- Ensure brand and messaging consistency

- Reduce the time and effort required to distribute content

Referenced content is available in all three document types - presentations, proposals, and
contracts.

For proposals and contracts

1. From your Document List, open the Template that will include your Referenced
Content

2. Click New Page

3. Choose Page from Content



4. Choose the page of content you want from your Content Library in the pop-up
window

5. Click the checkbox next to Add Page as Reference

6. Click Add Page

For presentations

1. From your Document List, open the Template that will include your Referenced
Content

Click New Slide

Choose Slide from Content

Choose the Content Slide you want from your Content Library in the pop-up window
Click the checkbox next to Add Slide as Reference

Click Add Page
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Whenever you'd like to update your Referenced Content, do so by making changes to the
master copy in your Content Library. You can access the page or slide content through the
Content list in Conga Collaborate. In addition, for proposals and contracts, you can click
on the yellow header on the referenced page in a Template. Your changes will apply to any
Template that includes that piece of Referenced Content.

You can also see which templates use the content by selecting the page or slide content
and looking at the information window on the right-hand side of the screen.

Using show/hide logic for pages and sections

You can apply show/hide Llogic to whole content pages or sections by using Boolean
statements. The upcoming sections give you the steps to make it happen—and some
examples to follow.

Setting up Logic Statements

To enter logic for a page or section

1. Hover over the page or section title in the Table of Contents panel and click the gear
icon.

2. Click Edit Properties.

3. Enter the boolean statement at the bottom of the pop-up window in the Include Logic
field.



Page Logic Examples

Document Scripting requires you use only lowercase letters. In the upcoming example, the
actual variable is Opportunity_Name, but when using the .include? method, you use
opportunity_name.

Single Variable

- Opportunity_Name = “Test Opportunity”

- You can check whether a variable includes certain text by using the following method:
opportunity_name.include?(“Test”)

- Result: Because our Opportunity_Name includes the text “Test” the example
returns true.

Arrays: Include

- The method .include? on an array looks for an exact match of the value in the
variable you're searching. If no exact match can be found, the method will return:
false and the content will “hide”

- products = [{Name = “Test product”}, {Name = “GenWatt 1000”}, {Name = “Product 2"}]

- Results:products.include?(*Name”, “product”) = content will NOT
showproducts.include?(“Name”, “Test product”) = content will showproducts.include?
(“Name”, “GenWatt 1000”) = content will showproducts.include?("Name”, “GenWatt”)

= content will NOT show

Arrays: Like

- The method .like? on an array determines whether the value is contained in the
variable you are searching.

- products = [{Name = “Test product”}, {Name = “"GenWatt 1000"}, {Name = “Product 2"}]

- Results:products.like?(“Name”, “product”) = content will showproducts.like?("Name”,
“Test product”) = content will showproducts.like?(“Name”, “GenWatt 1000”) = content
will showproducts.like?("Name”, “GenWatt”) = content will showproducts.like?

(“Name”, “Products”) = content will NOT show

Using tags to organize content

Attaching a tag to a document or piece of content makes it—and similar files that share
the tag—easier to find. Conga Collaborate gives you default tags, and you can create your
own. Users also have the ability to search, by tags, right from within the document. When
you use the search bar, you have the ability to see all the tags your administrator used to



organize the content. This also includes the ability to select more than one tag from the

pick list to refine your search results.

To attach a tag

Documents

1.
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From the document you want to tag, click the Properties panel on the right, then find
the details tab.

When you click into the Tags field, your existing Tags appear.

Click the one you want, or use the field to create a new Tag.

Your change is autosaved by Conga Collaborate.Content

From the Content view, select the content you wish to Tag.

Click the pencil icon at the top of the page to open the Editing panel on the right.
Use the Tags field to add a new Tag or choose from the existing Tags.

Conga Collaborate autosaves your change.

Using the account default email feature

As a system administrator, you can create and select an email template to be applied by

default when any Conga Collaborate user sends a document to a recipient.

To configure an account-wide default email template

1.
2.
3.

Click Administration on the User Drop Down Menu (your avatar)

On the new page that appears, click the Email Templates button

If you'd like to create a new email template, click the Add button and continue to step
4. If you'd like to choose from the list of existing emaiil templates, skip to step 7

Click the Shared option at the top of the page. This will later allow you to select this
as the default template for all users

. Fill in the Template Name, Subject and Body fields, using the Insert Variables tool to

populate the subject and body if you'd like

Click the Save button

Click the gear icon next to your new shared template, then select the Make Default
option on the related drop down menu. In the Type column of the Email Template list,
you'll now see that the template has been updated to “Shared Default”

Using the archive feature

Use these steps to archive a document



Just because you haven't used a document in a while doesn’t mean you won’t. You can get
older documents out of your way (and off your Document List) by archiving them for
safekeeping—just in case. You have unlimited data storage in your account, so there’s really
no need to lose any of your content by deleting.

Your Archived Documents are not accessible from their published URL, so be sure not to
archive anything you want your clients to continue to have access to.

Use these steps to archive a document—or to archive several at a time:

1. From your Document List, click the checkbox next to the document(s) you'd like to
archive.

2. Click More in the icon list that appears across the top of your screen.

3. Click Archive Document.

You can find your Archived Documents easily; just click Archived Documents in the Table of
Contents when you're in Document View.

When you're ready to bring a document out of an archived state, follow these steps:

1. In Documents View, click Archived Documents in the Table of Contents panel.

2. Click the checkbox next to the Document(s) you'd like to get back into your Document
List.

3. Click the More icon from the top of your screen.

4. From the dropdown menu, click Unarchive Document.

Using the Document Panel

When editing a document or template, the document panel will give you many options to
customize, share, and design your document. It can be found on the right hand side of the
document build view. This article will introduce you to the options available and how to use
them. Next Steps The Next Steps tab will always help you get to the next phase of your
document workflow. Whether you are still building, ready to send, or waiting for signatures,
the Next Steps tab will let you know where you are in the process. When you select this
menu, you will see drop down options for each step in the process and will be able to kick
off the next step from here. Properties The Properties tab is made up of five different menus
that will help you customize your document as needed. Each of the five menus are
described below with the options available in them.

Details - The details tab is a place for the document owner to edit information about this
document. Items that can be edited within this tab are Title, Client, Description, Tags,
Template, Owner, Value, Expiration Date, and any Document Relationships. The values you
place in this tab can also be added into the document as variables during the document



build by clicking the Content tab, clicking Variables, and then selecting Document
variables. Simply drag and drop them into the document as needed.

Design - A main benefit of Conga Collaborate documents is being able to style them
according to your company’s brand preferences. This style is controlled by a Theme. Now,
you can access any themes you have available to choose from in this Design tab. Simply
use the drop-down menu to select which theme you would like to apply to your document.
Remember, your access to Themes is controlled by your Admin, so let them know if you don’t
think you are seeing what you need here.

Metadata - A third tab available in Properties is the Metadata tab, if enabled in your
account. Here we can add important information about this document that others may
need to use to search for or report on later. Metadata templates need to be set up by an
administrator, but, once they are, users can use the drop-down menu to choose which
metadata they need to apply to their document.

Privacy - We take privacy seriously, so we wanted users to be able to control these settings
quickly and easily. In this tab, users can enable an access code for their document, share it
with specific workgroups or simply make it public or private.

Options - The last tab under the Properties menu is Options. In this tab, users can allow for
a PDF download of their Conga Collaborate document, enable a Cover page, add a
Signature Page to the PDF download, and enable the Table of Contents to print. ALl of
these options change the download behavior of your Conga Collaborate document.

Integrations This tab allows users to manage all of their integrations for the document or
template in one place. When users click Integrations, on the right-side document panel, they
can see a list of their integrations for that document. These can be toggled off and on as
needed. For example, if you are connected to Salesforce, you will see which Salesforce
record your document is connected to. If you need to change which Salesforce record you
are connected to, you can use the drop-down menu, or search. Other common integrations
users can manage here would be Docusign and Formstack for eSignature and Form
services. Content Here users can access Files, Images, Pages, Text Snippets, and Variables
to add into their document, or they can add new Content with the Add New button at the
top of this menu. This allows for commonly used pieces of Content to be used across your
organization and updated in one place. For more information about Content, see our
support article on the topic. Version Menu Conga Collaborate allows users to create
multiple versions of their documents. The New Version button is readily available at the top
of this menu along with a drop-down menu to see other versions of the document. This is
also a great place to double check whether you are working on the most current version of
a document. Download Button The Download Button will sit at the bottom of the Document
Panel, under all of the other tabs available. This will allow for a download of your online
document by you or your customers, if needed.



Using the Conga Collaborate Message Center

Communicate with other users or teams through the Conga Collaborate Message Center,
which you find by selecting your User Profile on the top right of the page.

Access your message inbox by clicking the Message Center icon; it’s the one that looks like
a speech bubble. The icon keeps a running tally of your messages, and you’ll be notified
when new messages arrive—as well as when comments, alerts, and tasks apply to your
documents.

Depending on your account settings, you may also receive corresponding notifications in
your regular email inbox for document alerts and tasks. Conga Collaborate activity feed
comments and Message Center messages do not also trigger emaiils.

The conversations you have in the Message Center are time-stamped and searchable.

Just click the New Message button when you're in the Message Center to start a
conversation. Click on a message in your inbox to read or reply. You can add attachments
to the messages you send

Using versions

Our Versions feature lets a document owner make changes without losing previous
incarnations of a document. You can use it to:

- Create a new version of a published document or template without having to share a
new Llink.

- See a summary of all changes made to a document by checking the version history.

- Access previous versions of the document.

Create a New Version

To create a new version

1. Click the Versions tab.

2. Click Create New Version. Your document is saved in its current state as a past
version.

3. Edit to create your new version.

4. When finished, you can save the current state of your document by clicking Finalize
New Version.



If your document includes a required task, you can’t finalize the new version of your
document until the required task has been completed.

Compare Versions

For any document that exists in more than one version, you can compare those versions to
see what has changed.

To compare versions

1. Click the Versions tab.

2. Click the Versions dropdown bar and choose a version.

3. Click Compare.

4. Select another Version to compare. In the content area, you see
- Content added, highlighted in green.
- Content deleted, in red strikethrough.
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. Click Stop Comparing when you want to return to your Document.

Cancel New Versions

To cancel a new version

A document must be published in order to use the cancel version functionality.
Click on the Versions tab.

Click the Create New Version button.

Click the Cancel New Version button. Doing so deletes the version of the document
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that you were working on.

If you click the Finalize New Version button, you can no longer cancel the new version of
your document.

Voiding a document

If a document no longer represents a valid agreement, a document in an Open or Accepted
state may be voided by the document owner.

To accomplish this task

1. Open the build view of the document you wish to void.
2. Click to expand the Properties tab.



3. Click the Status bar at the top of the Properties tab to reveal the option to Mark as
Void.

By voiding a document, recipients can no longer view or sign it. Recipients will not receive an
email notification from Conga Collaborate that the document has been voided. Once
voided, a document cannot be returned to an Open or Accepted state.

Working from the Document Table of Contents

From the Table of Contents you can add file attachments, download the document as an
offline PDF or Word document, and toggle document preview on and off.

The Table of Contents displays your document structure. Located on the Lleft side of the
screen, it contains the sections and pages that make up the document. From here you can
also add file attachments and toggle document preview on and off. As an administrator,
this is also where you would set section and page properties on your Templates.

You can use the Table of Contents to present content in ways that improve client
interaction with your documents by having control of where a page displays, what its title
is, and which pages are grouped in a section.

Whenever you're in the build view of a document, the Table of Contents (ToC) configuration
panel appears along the left-hand side of your screen. The ToC is where you develop the
outline of your document, including sections, content pages, and attachments.

To add sections to your document

1. Click New Section.

2. Name your section. The title can be changed later by hovering over the section name,
clicking on the gear icon that appears, and choosing Edit Title.

3. Drag your section to its desired location. By default, the section will be created at the

end of the ToC. You can change section order by dragging it above or below other

sections in the ToC. Add Pages to your Document

Click New Page.

Choose from three options:

Blank Page - inserts a blank page of Conga Collaborate content into your document

Page from Content - opens a modal where you can choose to:
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Insert a page of Conga Collaborate Content that you have built and saved in your
Content library
9. Embed a file you have uploaded to Conga Collaborate



10. Insert a Formstack form page into your document (requires an enabled Formstack
integration)

1. Cloud Content - allows you to insert a file from any cloud storage services you have
connected to Conga Collaborate

12. Name your page. The title can be changed later by hovering over the page name,
clicking on the gear icon that appears, and choosing Edit Title.

13. Drag your page to its desired location. By default, the page will be created after the
page you have selected when you add the new page. You can change page order by
dragging it above or below other pages in the ToC.

The Preview pill can be toggled on and off to preview CRM variables (such as auto-
generated pricing tables) and preview the finalized version of your document as your
recipients will see it.

The Attachments section allows you to add files to your document from your computer, a
connected cloud storage service, or files in your Conga Collaborate Content library.
Attachments are not included as pages in the online or downloaded version of the
document. **Exception: PDF attachments can be included in the eSignable PDF if using the
DocuSign integration for eSignature.

Working from your document panel

When you're in Build view of a document, a Document Panel appears on the right side of
your screen.

The tabs you see there vary slightly according to your document setup and whether you're
in draft mode or have published your document. The following sections introduce you to the
actions available through this panel.

Next Steps
From this tab, you see your document status and actions appropriate to that status.
From the Draft section, you can:

- View Actions

- Publish the Document
- Click More Actions to
- Archive

- Convert to Template
- Delete

- Duplicate

From the Published section, click View Actions to:

- Manage Versions (takes you to the Versions tab)



- View Tracking (takes you to the Tracking tab)
- Manage People (takes you to your People tab)

From the Accepted section, you can:

- See which Version you're in

- View Acceptance status

- Download a Signed PDF
Document

From the Document tab, you can:

- View the URL of the Document

- Click View to see the published version

- Edit Title

- Edit Client

- Edit Description

- Add Tags

- Add Theme

- Edit Language

- Edit Owner

- Edit Value

- Edit Expiration Date

- Edit Privacy

- Edit Document Options

- Enable Access Code

- Allow PDF downloads

- Enable Coverpage

- Enable Print Table of Contents

- Signature Page in the PDF
Versions

From the Versions tab you can:

- Compare Versions of your document
- Add a Change Request (or create a new Version in draft form)
- Switch to a different Version.

People

From the People tab, you can:

- Send email
- Add recipients
- Select who can approve Change Requests



- Change Signer Order
Content

From the Content tab you can add or insert:

- Images

- Files

- Documents

- Text Snippets

- Forms (if you've enabled forms on your account)

When hovering over Images, Files, and Page Content, click on the “eye icon” on the left-hand
side to expand the Content for a larger preview of the content.

Track

This tab enables you to see tracking information such as when the document was created,
updated, and published. It shows you a record of document activity, and you can take a
much deeper dive into activity by clicking the View Full Report button.

E-Signature

Use E-Signature functionality in online Collaborate documents.

Adding a Custom Signature Block to Your Document

When you have created a custom signature block for gathering data from your clients, you
can then add it into your document. Custom signature blocks will appear in the signature
modal when a client is signing with Colloborate eSiganture. Data entered in your custom
signature blocks will then be visible in the signed PDF version of the Collaborate document.

To add your custom signature blocks into your Collaborate
documents

1. Select the Document to which you want to add a custom signature block.
2. Click the Properties tab.

3. Click the Signature Block field and select the custom block you'd like to use.
4. Bingo! Your document is ready to publish and send.

Collaborate and Conga Sign Integration FAQs

What types of tags can | add to documents?



Conga Collaborate allows you to easily use all standard Conga Sign signature tags
except for writing back tags. Collaborate integration with Conga Sign recognizes standard
Conga Sign tagging syntax in addition to standard DocuSign tagging syntax.

How can | add a custom text field?

Add a custom text field using the appropriate Conga Sign custom text tagging syntax in
your Collaborate document.

Example custom text tagging syntax: \customtextl {"label":"Address"}\
If | don't add a signature tag to my document, what happens?

If a user creates a Collaborate document integrated with Conga Sign and no tags are
added to the document, Collaborate automatically adds a standard signature tag for
each identified signer in the Collaborate document.

Can | add signature and initials tags in places other than the signature page?
Yes, Conga Sign tags are available to be added anywhere in a Collaborate document.
Can | upload a PDF to Collaborate and send for signature?

Yes, users can upload a PDF to Collaborate through the Content Library and then add
Conga Sign tags to the PDF document on a new page.

Can | get my signed documents into Salesforce?

Yes, using Conga Collaborate's Outgoing Data Tool users can automatically send the
Signed PDF to a Salesforce record as a Salesforce Attachment. User can always access a
signed document through the Collaborate documents related list.

Salesforce Files is not supported at this time.

Conga Sign: Integration with Conga Collaborate

This document reviews the initial setup and integration of Conga Sign with Collaborate.

Conga Collaborate features seamless integration with Conga Sign to create a simple yet
powerful e-signature solution within the Collaborate platform. Send and track your online
Collaborate documents for electronic signature with features including one-click
signatures, a full audit trail for each document, custom text tags, and more.

You must contact Conga Support and provide the name of your Collaborate org to
begin using the Conga Sign integration.



Integrate and Send a Collaborate Document with Conga Sign

To leverage Conga Sign's e-signature platform with a Conga

Collaborate document.

The steps below detail enabling Conga Sign on a generated document, but you can follow

these same steps (up through step 6) on a template in order to ensure that all documents

created from that template use Conga Sign by default.

1.

After Conga Support confirms the enablement of the Conga Sign integration for your
Conga Collaborate org, navigate to the Document Llist in your Collaborate org.
Open and access an existing Proposal or Contract, or create a new Proposal or
Contract.

Click the Integrations icon on the right-hand side.

Integrations O
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4. Select the Conga Sign radio button.

5.

- Use the Conga Sign tagging syntax to reference Conga Sign tags
including Signature, Initial, Recipient, Name, Title, Email, Date, Company,
and Custom Text. For more information on tagging syntax, see Using signature
and custom tags and List of Conga Sign signature tags.

- Users can also add the Signature and Initial tags by navigating to the Content
icon in a Proposal or Contract. In the Content section, toggle open the Variables
section. From the Variables section, toggle open the ESignature section and click
the + button next to the tags to add either tag into a Proposal or Contract.

- Use white text font for each tag. This ensures that recipients do not see Conga
Sign tagging syntax during the signature process.Add Conga Sign Tags to the
document with Conga Sign tagging syntax.

Important: Conga Sign integration with Collaborate does support required and
optional tags, but you must set it using tagging syntax.
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14.

If there is not already an Action associated with the Collaborate document, add
the Accept action, select Conga Sign for the Electronic Signature field, and click Save.
On the right-hand side, click Next Steps.
Click the Publish Now button.
Click Add People under the Step 2 section.
- Select existing recipients from the Search People field or fill out the First Name,
Last Name, Email Address fields to send the document to a new recipient.
- Select Yes for the Signer? radio button to designate an individual as a Signer.
- Fillin the appropriate value for the Signer Order field to determine the order in
which the signer receives to document for signature.

- This field is only required if there are multiple signers.

- If there are multiple signers pre-tagged in the Collaborate document,
ensure that their Signer Order value corresponds to the intended tag. For
example, if Person A is intended to sign first and correspond to
the \signaturel\ tag located at the top of the Collaborate document,
ensure that you assign Person A the Signer Order value of 1.

. Click Next after adding the signer(s).
. Click Send Email Now.
. Click Include all recipients to ensure that all identified recipients receive the

Collaborate document and signature requests.

Use the +BCC, Template, Subject, and Message fields to customize the email that
recipients receive.

Click Send.

The Signing Experience with Collaborate and Conga Sign

After sending a Collaborate document integrated with Conga Sign, recipients receive an

email in which they can open and access the Collaborate document.

Once a recipient clicks the View Document button, the sender is notified via email that the
recipient has opened and viewed the Collaborate document.

In the Collaborate document, the recipient is prompted to review the content and click a

call-to-action, such as Accept. The Collaborate document then takes the recipient to the

Conga Sign signing user interface.



Collaborate

eSignature Adoption and Terms

Please view the electronic record disclosure before proceeding.

CHOOSE STYLE DRAW

Confirm your name and choose signature style. * Are required fields.

* Full Name * Initials
John Smith JS

View Additional Styles

By clicking agree, you agree to use and accept electronic signatures for this document. Agree and Start Signing

In the eSignature Adoption and Terms section of Conga Sign, the recipient has the option to
choose between various signature styles or to draw their own signature. Once the recipient
is satisfied with their signature style, they can click the Agree and Start Signing button to
proceed with signing the Collaborate document.
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Sign Document ancel lransaction omplete signing
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Recipients simply click the Conga Sign tags to fill out their signature or initials. For other
fields such as Title and custom text tags, recipients must click the tags and type in the
relevant information. When all required tags are complete, the recipient completes and
returns the document by clicking the Complete Signing button.

Upon all signers completing the signature process, the sender and recipients are notified
and may view the final signed document as an online Collaborate document or download
it as a PDF file.

(' The signed document is not completed until all designated signers have signed. If
there are multiple signers that have not yet signed, the document will not show as
complete to the sender and preceding signers.

149 Copyright ©2022 Apttus Corporation. All rights reserved.



Audit Trail and Tracking the Signature Process

The sender and recipients receive helpful status updates throughout the signature process,
including email updates that detail who has viewed the document, who has signed the
document, and completion of all signatures.

In addition to email notifications, the sender and recipients may see the current status of
the signature process by viewing the online document from the initial email message.
Senders may also see a more detailed signature history of the document by accessing the
Audit Trail in Collaborate. The audit trail is easily accessed by clicking a completed
signature or initial tag in the final PDF document. Senders can access the audit trail and
the final sighed document from the document record in Collaborate as well.

For more information about the Collaborate and Conga Sign integration, see Collaborate
and Conga Integration FAQs and the Using Conga Collaborate with Conga. Sign video.

Creating a Custom Signature Block

Our proprietary eSignature tool enables you to customize the information you receive from
clients when they sign your documents. The eSignature can be set up only by a system
administrator after it has been enabled by Conga Collaborate.

To create a custom signature block

Click the User Drop Down Menu (your avatar)
Click Administration
Click Signature Blocks
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Click New Signature Block (this takes you to an Add Signature Block page, where you
see fields you can add and label; Name your block)

o

Click Add Field for each field you want in your signature block

o

Label each field so that the information you're asking for is clear

7. Choose the form the entry will take by choosing from the Field Type box to the left:
text, email, phone, number, or date

8. Check out the Preview to make sure you have set up exactly the signature block you
wanted. Make any changes in the fields; clear a label field to delete it

9. When you have it right, click save. You can always go back and edit by clicking Edit

from your Signature Blocks page

You can create custom signature blocks to fit any common situation and place them into
your documents as necessary.


http://videos.conga.com/detail/video/6002300853001/collaborate-sign-demo?autoStart=true&q=Collaborate%20Sign%20Demo

DocuSign: Adding multiple signers

With DocuSign, you can add multiple signers to a document, specify signer order, and

assign DocuSign signer roles.

Permissions Needed: All users can add signers

Feature Requirements: Requires DocuSign to be enabled for your account.

Adding multiple signers

To add multiple signers to a document

1.
2.

Open your document.

If you are on a contract type document, skip to step 3. Otherwise, follow these steps:
Open the Integrations panel to ensure that the DocuSign box is checked.

Open the People panel.

Click Add People.

Enter recipient information and assign signer order. Add as many recipients as you
wish by clicking Add Another Recipient and set signer order for each. You can edit
signer information after it has been added to the document by clicking on the gear
icon in the recipients’ contact card:

If a proposal includes post-acceptance forms, you'll see a checkbox when you add signers

to control whether that signer can fill out those forms.

Notes about using multiple signers:

- Document signers must use their unique, individual links to access and sign the

document. Using the document’s public URL will allow the signer to review the
document but does not give signing access.

- You can still add recipients who are not signers, called collaborators. Collaborators

have read-only access.

- A document will be marked as Declined when any single signer declines.
- The document’s owner gets an email notification when the document has been signed

by all signers.

- Signers receive individual email notifications when it is their turn to sign, as well as

confirmation emails after they have signed the document.



DocuSign: Integrating with Conga Collaborate

Integrate DocuSign into your Conga Collaborate account in order to access a powerful,

full-featured e-signature platform. You can capture client signature and initials using

standard DocuSign tags. You can also collect other client information within Conga

Collaborate by using custom DocuSign tags that you define.

Integration Features

The DocuSign-Conga Collaborate integration gives you:

- Signature block placed at the end of your document automatically

- E-signature variables that allow you to dictate where your client signature and

initials will go

- Signed PDF of the document that includes the e-signable Attachments

- Email notifications for when your document is viewed and signed

- Ability to create custom DocuSign tags that allow our clients to enter information

into your Conga Collaborate document - Note: Available with DocuSign Pro only

- Send on Behalf - improves record accuracy by automatically setting Conga

Collaborate document owners as owners of the corresponding DocuSign envelopes

- Certificate of Completion - attaches extra information about the signer to the signed

PDFBefore you Begin

-+ You need System Administrator permissions. Integrating DocuSign with Conga

Collaborate

To enable the integration

o
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From your user drop-down in the upper right-hand corner, go to Administration.
Integrations

DocuSign.

Enter your DocuSign Username and Password.

If you are using a demo DocuSign account, select Demo Endpoint.

Check the box for Send on Behalf.

Note: In order for this feature to work, the end user must have the same email address
in both Conga Collaborate and DocuSign.

Click Show Accounts.

Select the account you wish to integrate with Conga Collaborate.

Click Connect.

Note: Your DocuSign Administrator MUST perform the connection with your DocuSign



account (if a standard DocuSign user connects the integration, DocuSign will only
recognize the integration user as someone who is creating envelopes inside of
DocuSign).

Using Conga Collaborate’s DocuSign integration

To enable DocuSign for the document/template

1.
2.
3.
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Open your document or template.
Click the Integrations panel.
Select DocuSign in the Electronic Signature section. Adding signature variables By
default, Conga Collaborate adds a signature block at the very end of the document.
If you would like your client to sign or initial the document in other places:
Open the Content panel.
Select Variables.
Click ESignature.
Add specific DocuSign variables to where you would like DocuSign tags placed
throughout your document. Conga Collaborate supports the following DocuSign tags
by default:
Note: To add tags for additional signers, insert /s#/ into the document, where # is
replaced with the number of your signer

- /sl/ adds a signature field for signer 1

- /il/ adds an initial field for signer 1

To add signers and designate signer order

Open the People panel.

Click Add People.

Enter recipient information and assign signer order. You can edit signer information
after it is added to the document by clicking on the gear icon in the recipients’ contact
card:

Signing the document

Once the client reviews and clicks Accept, the signature process moves into DocuSign. The

client follows the on-screen directions to complete the signature process. After signature is

completed, both the signer and the document owner receive email notifications indicating

that the document is signed.



Generating e-signable attachments

Conga Collaborate document attachments can be included in the e-signable DocuSign
envelope:

1. Open your document and click Attachments at the bottom of the Table of Contents
panel.

2. Click Add File to upload from your desktop or click Cloud File to download from a
configured cloud storage service.

3. Choose your attachment and upload it.

4. Beside your attachment, check the Include in ESignable PDF checkbox.

5. Repeat Steps 2 and 3 with as many files as you'd like to attach to your Conga
Collaborate document.

DocuSign: Recipient redlining permissions

You can determine who can make change requests to a contract document.

Sales reps can determine which recipients can make and submit change requests to a
contract document. The redlining permission in Conga Collaborate gives recipients
permission to redline independent of their signer status. Reps have the option to add
collaborators who can or cannot redline, as well as signers who can or cannot redline.

Permissions Needed: All users can add signers and set redlining permissions

Feature Requirements: Redlining is only available with contract type documents.

To assign redlining permissions

From within the contract document, click the People panel.
Click Add People (or edit a recipient previously added to the document).
Click Advanced Permissions.
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Check (or uncheck) the box next to Can redline. Default settings give redlining
permissions to all signers; non-signers default to no redlining permissions.

DocuSign: Retrieving Certificate of Completion and
Signature Information

Offers detailed information related to a signer’s digital identity and document activity



DocuSign’s Certificate of Completion offers detailed information related to a signer’s
digital identity and document activity. You may choose to include this information from
DocuSign with each accepted document’s PDF download.

Permissions Needed: Conga Collaborate System Administrator

To retrieve a digital certificate with each document
download

1. From your user dropdown, go to Administration > Integrations > DocuSign.
2. Click to select the checkbox next to Include Certificate of Completion with Signed PDF.
3. Click Save.

All documents executed using DocuSign will now include the Certificate of Completion at
the bottom of the PDF download.

DocuSign: Sending Multiple Quotes

Send multiple quotes in one document and allow a customer to select options and sign with
DocuSign.

To add multiple quotes within a document

Add your quotes within the Table of Contents of your document
Click on the Wheel icon located to the right of a quote
Select Edit Properties. A Page Properties window appears
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Click Allow Acceptance with Overall Proposal Agreement underneath the Acceptance
header

o

Ensure that the Include this content with the e-signature button is also selected
Click Save
7. Repeat steps 2 through 6 with any additional quotes that you are adding to your

o

document

Publishing and sending a document to a client gives them the ability to accept your
quote(s) from within the proposal by choosing a quote from the Table of Contents—or after
clicking the Sign/Accept button.

DocuSign: Using Custom Tags

You can use custom tags to collect additional information from your clients, like purchase
order #, title, address, phone, etc..



Conga Collaborate automatically adds a signature field for each one of your Signers at

the very bottom of the document. If there are additional places within the document you

would like to receive a signature (or initials), you can utilize Custom Tags (or Custom Fields,

if you are using the new DocuSign experience).

To create custom tags using DocuSign Classic
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In your DocuSign account, click the user icon in the upper right corner
Click Preferences
From the menu on the left, look for Member Options and choose Custom Tags
Click Add to create a new custom tag
- Fill out the Label field with a descriptive name
- Choose the Type of the field. In most cases where custom signer input is required

the type will be Text Box

- Check the “Shared” checkbox in the “The Form Field is” section. Optionally, you

can make the field required here as well

- Fill out the Anchor field by following the instructions in the “Creating Anchor/

AutoPlace Text” section below. Follow these steps to create custom tags using
the new DocuSign experience:

In your DocuSign account, click the user icon to the upper right corner
Click Go to Admin
From the menu on the left, look for Signing and Sending and choose Custom Fields
Click Add Field to create a new custom tag
- Fill out the Name field with a descriptive name
- Choose the Type of the field. In most cases where custom signer input is required

the type will be Text Field

- Check the “Shared” checkbox. Optionally, you can make the field required by

checking “Required field”

- Fill out the AutoPlace Text field by following the instructions belowCreating

Anchor/AutoPlace Text Anchor Text and AutoPlace Text are functionally the
same things, but simply have different names depending on which version of
DocuSign you are using. The following section will use the name Anchor text, but
the instructions apply to both. Anchor text is recognized as an input area within
a document executed through DocuSign. Anchor text needs to follow the
following format:\fieldname{r}\ For example, if you create a field named
Example Tag, the anchor text could be \exampletagf{r}\ (you can make it be
whatever you want but we recommend mirroring the name of the tag). The “{r}’
of the anchor text acts as a variable for signer order. Within Conga



Collaborate, the {r} is to be replaced with the number of the signer you want to
fill out that field:
9. To offer the custom tag to the 1Ist signer in our example, enter \exampletagl\ into the
Conga Collaborate document
10. To offer the custom tag to the 2nd signer, enter \exampletag?\ into the Conga
Collaborate document

The last step is to change the color of the anchor text so it doesn’t show in the signable
document. DocuSign recommends changing the font color of anchor text to the same color
as the page background of the PDF (normally white). When the recipient of the document
clicks the Accept button on your Conga Collaborate document, a DocuSign window
appears with the PDF version of your document. The PDF will include input areas wherever
you've placed anchor text.

Conga Collaborate Document Signing

Conga Collaborate utilizes the power of e-signature tools to make sending and signing
online documents easy and streamlined. You can determine the level of access to a
document, track the status of individual signers, and easily adjust signer order - all from
within Conga Collaborate. This article will explain the permissions you can give to
document recipients as well as the different signing experiences available through Conga
Collaborate and DocuSign.

To learn about how to send documents to recipients, see the article Delivering Online
Documents to your Recipients

Set Recipients' Permissions

With the Conga Collaborate document signing process, you can easily specify what level
of access each person has for a document that is shared with them. Below are the recipient
permissions by document type(s) on which those permissions are available:

Proposals & Contracts

Signer - recipient can sign the document Can add signers - recipient is allowed to add other
signers to the document Can add collaborators - recipient is allowed to add other people
to view the document (but not sign)



Contracts Only

Can redline - recipient is allowed to redline and make change requests to the text of the
document

Adding Multiple Signers

Conga Collaborate has two signing experiences depending on the type of document you
are using (proposal or contract) and whether or not you have DocuSign. This section will
wallk through the signing experience with multiple signers in scenarios where you sign with
and without DocuSign.

Proposals without DocuSign

When DocuSign is not enabled you can still add multiple signers to a document using the
built-in Conga Collaborate e-signature tool, but Conga Collaborate defaults to a “first
come, first sign” approach. This means that whoever signs the document first will sign it for
everybody listed as a signer on the document. This workflow is useful if, for example, you
have multiple sales directors who can all sign off on a document and you only need one
signature from the group.

Alternatively, Conga Collaborate supports setting signer order in cases where you need
multiple signatures for a document.

Once this is turned on, follow these steps to set signer order:

1. On the template, in the Properties panel in the Document Options section, check the
box “Require All Signers for Acceptance”

2. Either on the template (if you want the signers to be on every document generated
from that template) or on a generated document, add people as recipients as
described earlier in this article

3. Set the signer order by putting the desired order number in the “Signer Order” text field

Once signers have been added to a document, you can change signer order by clicking on
the drop-down arrow next to the recipient’s signer number and choosing a different position.

Proposals and Contracts with DocuSign

If DocuSign is enabled in your account, signer order is enabled by default. Add recipients as
described earlier and set their signer order. Signer order can still be changed by clicking on
the drop-down arrow and choosing a different position.



In signing documents both with and without DocuSign, signer order cannot be changed once
a signer has clicked the “Accept” button.

Restoring Deleted Recipients

Recipients can be deleted at any time before they use their unique URL to view the
document and Conga Collaborate will not keep any record of those recipients being added
to the document. However, if recipients have viewed the document and you now want to
delete them, Conga Collaborate will mark those recipients as deleted but keep record of
them on the document. Their unique document URLs will be invalidated and they will no
longer be able to view the document. If at some point you want to add them back as a
recipient on the document, you can do so by going to the People tab and clicking Restore on
the recipient’s business card. This will re-activate the unique document URL and allow them
to view or sign the document (depending on the permissions you gave them originally).

Conga Collaborate eSig: Creating multiple quotes

Forget sending multiple documents and going back and forth to discuss options. You can
create multiple quotes in Salesforce, generate them into a Conga Collaborate document
and quickly send them to prospects. Your prospects choose which quote they wish, accept
the document, and sign the chosen quote all within the same document.

To create quotes within a document in Salesforce

1. Click Opportunity.

2. Create New Opportunity.

3. Select the account (your prospect) who will receive the quotes.

4. Fill out all the necessary fields. These vary according to your organization.
5. Click Save. Your Opportunity screen appears.

6. Scroll down to Quotes.

7. Click New Quote.

8. Create a quote name (Option 1, in this example).

9. Click Save. Your Opportunity screen appears.
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Click Add Line Item under Quote Line Items. (Ensure that you have set up your price
book.)

11. Select all products you wish to include in this quote.

12. Click Select.

13. Provide quantities and apply any discounts.

14. Click Save. Quote Option T appears under Quotes.



15. Create as many different quotes as you wish using this process, then click New Conga
Collaborate Document. You see the Build view of a document with your Quote
information.

After you edit and publish your document, the prospect can accept and sign whichever
quote he or she wants. The signed PDF that the prospect receives shows only the selected
quote, and all data syncs to Salesforce.

In your Salesforce account, you see the accepted data as soon as the document is
accepted.

View Documents Awaiting My Signature

Internal signers will see all of the documents awaiting their signature.

Internal signers, those signers who are within your organization, will now be able to see all
of the documents awaiting their signature. This feature will be on automatically and
doesn’t require any Conga Collaborate administrator intervention.

Users will simply need to log in and will see this in their dashboard view. Now users with
multiple documents to sign don’t have to worry about missing them or finding the email
alert to sign.

Forms

Use forms in an online Collaborate document.

Forms: Using formulas for number fields

You can set a default number for a number field. For example, you can set the standard
price for a Service Cost and for an Additional Computer Monitor by selecting the field with
the double arrows. The panel gives you a field where you can set the Default Value.

A rep can change this value when filling out the form; otherwise, it remains the default
value.

Number fields can be combined into mathematical equations. The result of these equations
will be set as the default value. For example, the Subtotal can be the sum of the value in
the Keyboard Fee times the value that is placed in for the Keyboard Quantity. Or the Total
can be the sum of all of the Subtotal Fields.



Formstack: Integrating with Conga Collaborate

Conga Collaborate has easy to connect integration capabilities with Formstack.

To connect your Conga Collaborate account to Formstack

From the User Drop Down menu, Click Administration

Click Integrations

Select Authorize Formstack

Enter your Formstack login credentials with the highest level of permissions

Click the green Authorize button in the left-hand corner to grant access to the API
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request

Conga Collaborate authenticates the Formstack integration once it is granted access.

Formstack: Pre-fill form fields with Salesforce or
document variables

You can bring Conga Collaborate data into an embedded Formstack form by mapping
fields.

Pre-fill an embedded Formstack form using Conga Collaborate or Salesforce variables.

When a client fills out a Formstack form within a Conga Collaborate document, it is helpful
to have certain fields on the form pre-populated with data that you previously captured.

1. Within the template or document build view, open the Content panel and
select Forms from the drop-down menu.

2. Drag the form into the Table of Contents on the left side of your screen.

3. Select the gear icon that appears when you hover over the form page name and
click Edit Properties.

4. In the Variable Name dropdown, select the variable you would like to use.

5. In the Form Field dropdown, select the form field that you would like to receive the
variable value.

6. Click Add Mapping.

Repeat steps 4-6 for as many variables as you want to map into the form.



Formstack: Setting up a Form

You'll likely use certain common fields in your Formstack forms over and over. For those—
and for anything else you might want—you can build your form with manual entry fields,
drop-down menus, or checkboxes.

To set up a form in Formstack

1. Create a blank form in Formstack
2. Click the Build tab
3. Add sections based on however you would like to organize your fields (section fields
live in the left-hand panel - find them under Structural Fields within the Fields tab).
You may, for example, want sections for:
a. Contact information
b. Product options
c. Pricing
4. Drag and drop fields into your sections - choose from short answer fields, drop-down
lists, checkboxes, or number fields

Formstack: Using a form in a document

In order to use a Formstack form just attach it to your Conga Collaborate document.

Using forms with Conga Collaborate documents is made simple by our powerful integration
with Formstack. This article will discuss the different options available for using forms and
the benefits of each.

Forms are a great way to gather data with Conga Collaborate documents. They can kick
off the next process in a workflow or simply allow for a deeper analysis of your customer's
needs. The below options are some ways for forms to fit into your workflow.

Options for using a Formstack form in your Conga Collaborate document:

1. Survey - if you want Conga Collaborate users to enter information for the document
when the document is created and then have that information available as variables
to use on the document. This can only be configured on a template.

2. New, separate page in your document - if you want to pre-fill fields on the form using
Salesforce data.

3. Embedded within an existing page - if you want the form to have Collaborate
content on the page with it.



4. Post-acceptance form - if you want your recipient to fill out the form after accepting
a document.

To add the form as a Survey:

1. In the template build view, open the Integrations panel.
2. In the Formstack section, click Choose.
3. Select your form and then click Assign Survey.

Once a form is added as a Survey, open the Content panel in the build view, select the
Variables dropdown, and the click Survey to see the variables available from that form.
These variables can be added to your document using the % tool or the drag and drop
method.

To add the form as a new page

1. Within the template build view, open the Content panel and select Forms from the
drop-down menu.

2. Drag the form over to the Table of Contents and insert it as a new page. To add the
form to an existing page:

3. Within the template or document build view, open the Content panel and select
Forms from the drop-down menu.

4. Drag the form you need into the current page. The form will insert wherever your
cursor is located.

You can manually edit the height and width of the iframe containing the form in the source
code editor.

To add a post-acceptance form

Add a new section to your Table of Contents.

Open the Content panel and select Forms from the drop-down menu.

Drag the form over to the Table of Contents and insert it into your new section.
Click the gear icon next to your new Section title and select Edit Properties.
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Check the box next to Display section once the document is accepted.

You can only use post-acceptance forms if you are using Conga Collaborate’s e-signature
tool.

Salesforce

Integrate online Collaborate documents with Salesforce.



Connect a Salesforce Integration

Integrate Conga Collaborate with Salesforce to bring the power of your CRM to your
document generation process.

Conga Collaborate’s integration with Salesforce supports the following versions:

- Unlimited
- Enterprise
- Professional

Conga Collaborate's robust integration with Salesforce allows users to create documents
from data-driven templates, thereby reducing document creation time, eliminating user
errors, and ensuring content consistency. Additionally, integrating Conga Collaborate and
Salesforce increases adoption of both platforms, keeps systems in sync, and provides a
fluid end-to-end document workflow.

- Install & Configure Salesforce Managed package
- Edit Page Layout of Launching Object

Salesforce: Contact and Signer Mapping

Conga Collaborate administrators can automatically assign document signer roles and
permissions based on contact records or other contact fields in Salesforce. Conga
Collaborate calls this Contact and Signer Mapping.

Contact and Signer Mapping gives Conga Collaborate administrators a way to automate
the signing process by assigning default signer roles and permissions to a Salesforce
contact, rather than having to add recipients and set roles and permissions each time a
new document is generated.

This feature is not intended to be used to assign a specific person to always be a
signer (example: Signer 2 is always the CEO, John Doe). Specific default recipients
and their permissions can be set on the template level. Rather, these features allow
an admin to map Salesforce contacts to be added automatically to a Conga
Collaborate document with a specific set of recipient permissions.

For example, many Conga Collaborate administrators want the primary contact on an
Opportunity to be the first signer for their documents, or they may want to add all
contacts in a certain role (Technical Buyer, Legal Counsel, etc) to a document as signers.



To configure Contact fields

Determine where your contact info will come from by choosing the launching object and
fields you would like to use to add recipients on your Conga Collaborate document.



1. From your user dropdown in the top right corner of the screen, go
to Administration » Integrations - Salesforce > Edit
2. Scroll down to and expand the Contacts areaq, in the section labeled Manage

Manage Features

Attachments

» Product Settings
» Quote Settings
» Email

~ Contacts

Select Launching Object

Select Launching Object

Features.

3. Choose your document launching object, usually Opportunity, Lead, or Account.

4. Choose the appropriate referenced fields or child object you would like to use to
create the recipients on your Conga Collaborate document. In this example, we will
be selecting the OpportunityContactRoles object, and then the Contact referenced
field.

5. Choose the Salesforce fields that you would like to populate the First Name, Last
Name, and Email Address of your recipients. In this example, we will be selecting the
First Name, Last Name, and Email fields from the Contact object.

v Contacts

Select Launching Object

Opportunity

ent

+ [Referenced Fields - Referenced Fields
0 Account

Contact Owner

CreatedBy CreatedBy

L L

OpenActivities
OpportunityCompetitors
o

Feeds

Histories
OpportunityHistories
OpportunityLineltems
OpportunityPartnersFrom
Shares
OpportunityTeamMembers
Partners

ProcessInstances
ProcessSteps -

Contact Field Mapping

First Name

First Name

Last Name

Last Name

Save

6. Click Save.
7. Repeat this process for as many launching objects as you use for your documents.

Now that you have configured your contact fields, you can automatically assign contacts,
roles, and permissions using Contact Mappings.



This feature is used to mayp signers only. If you want to add contacts as collaborators, then

you only need to complete the steps in the above section. You will still need to click Add

Salesforce Contacts when adding recipients to the document.

To map your Contacts

1.

12.
13.

From your User dropdown in the top right corner of the screen, go

to Administration > Integrations > Salesforce > Edit.

Scroll down to the section labeled Contact Mappings.

Select the object that you would like to use. In this example we will use the
"OpportunityContactRole" object that we mapped earlier.

This feature only works with contacts mapped as a child object of your
launching object. You cannot use it with contacts found in lookup fields from
your launching object.

Select the field that you would like to use to filter contacts that get added as
signers. In this example we will use the "Primary" field.

Select the appropriate value by which you want to filter your contacts. In this
example we will use "True", to automatically assign the Primary Contact as the first
signer.

Choose the sorting field you would like to use. This will determine the signer order of
your recipients (if multiple contacts meet your filter criteria).

Assign the appropriate permissions for the signer:

. "Auto Import Upon Document Creation" - when the document is created, all of the

Salesforce contacts that are both associated with your launching record and meet
your filter criteria will be added to the document.

. "Can Add Signers" - gives the signer permission to add additional signers to the

document.

. "Can Add Collaborators" - gives the signer permission to add additional

collaborators to the document.

. "Can Redline" - gives the signer permission to redline the document. (Contract

document type only)
Click Save.
Repeat this process for as many launching objects as you use for your documents.

To make sure the correct signers are being added to your

contract

1.

Navigate to your launching object in Salesforce, in this example, the Opportunity.



2. Create a document.

3. Open the People panel on the right side of the document editor. If you selected "Auto
Import Upon Document Creation" during signer mapping, you will notice that all
contacts meeting your filter criteria have been added as signers, with the signer order
determined by the Sort field. In our example, the Primary Contact on the Opportunity
would have been added as Signer #1. If "Auto Import Upon Document Creation” was
not selected, then you will need to add recipients by clicking Add People and then Add
Salesforce Contacts. All contacts that meet your filter criteria will then be added as
signers with the permissions you selected.

Creating Documents Integrated with Salesforce

This Solution Guide will walk Conga Collaborate administrators through the complete List
of tasks required to set up a Conga Collaborate solution that allows users to:

- Launch a document from a Salesforce record

- Auto-generate content in the document based on Salesforce data

- Share the document with a recipient via email sent directly from Conga Collaborate
- Allow a recipient to sign electronically using Conga Collaborate e-Signature

- This solution works well for a variety of use cases. Some common examples include:

- Send an NDA for execution

- Deliver a standard new business proposal

- Create and send renewal or upsell documents to your customers

Generating documents from Salesforce provides several benefits to your organization:

- Create customized documents more quickly using data from Salesforce records

- Reduce errors by automatically customizing documents based on Salesforce data

- Easily view documents associated with a record on related lists in Salesforce

- Work within one system by generating documents with Conga Collaborate inside
Salesforce and keep both systems in sync

- Save time from routine tasks by having Conga Collaborate update fields in
Salesforce based on document activity (such as updating Opportunity Stage to
Closed/Won when a document is signed)

Below are the typical steps an admin should take to build a fully integrated Conga
Collaborate template. In this example, we're assuming that you're modeling your template
off of an existing MS Word document.



Step 1: Configure the Salesforce Integration

1. Install Conga Collaborate in Salesforce: If you have not already done so, start by
connecting your Salesforce and Conga Collaborate environments. For instructions on
installing Conga Collaborate in a Salesforce sandbox or production org and
connecting the environments, see Connect Salesforce Integration.

2. Install Buttons and Lists on your Launching Object: Your Conga Collaborate
document will be launched from and relate back to specific records in Salesforce.
Once you determine your document launching object, install the Conga Collaborate
buttons and lists on that object page layout. Check out Install Octiv Buttons and
Lists for more information on determining your launching object and adding buttons
and lists to your layout.

3. Map Salesforce Data into Conga Collaborate: Once you know your document
launching object, take a look at the document you're planning to build and determine
which parts of the document could be dynamic, meaning:

- Where would you like the text in the document to merge in Salesforce fields?
(example: customer name)

- Where would you like text or pages to show or hide based on Salesforce data?

- Where would you like tables to present sets of data from Salesforce? (example:
pricing table with product info)

Consider annotating your existing Word or PDF documents with notes on the specific
Salesforce fields that will drive the dynamic behavior of your document in Conga
Collaborate and how they are related to your launching object. Then, follow the Mapping
Incoming data article to map your Salesforce fields to Conga Collaborate so they're ready
to use.

Step 2: Build a Conga Collaborate Template

After setting up your Salesforce integration, build a Salesforce-integrated template. For an
even more detailed walk-through, you can check out the full length Creating Conga
Collaborate Templates article.

Start a New Template

1. There are two ways to create a template:
a. From the Dashboard, click the Create button. In the dropdown menu, select
Template. Give your template a name, select its type, and click Create.
b. From the Templates list, click Create Template. Give your template a name,
select its type, and click Create.



2. Open the Properties panel, open the Design tab, and choose a Theme for your
template. A Theme controls the general styling of your document. If you haven't
created a theme yet, check out our Creating Conga Collaborate Themes article.

3. If this document will be signed electronically or if you'd like to allow customers to
submit questions, add the Ask a Question button or the Sign button in the top-right of
the document. For more information on Call to Action buttons, see our Call to Action
button article.

Add Content to your Template

1. Before you start adding text, tables, or images to your template, break down your
existing document into sections and pages. Those sections and pages will drive how
you build the Table of Contents in your new template. For more information, see

Create Pages/sections structure in the TOC.

2. Once you've built the Table of Contents, copy and paste content from your Word
document into the appropriate pages within the Conga Collaborate template. We
have some special tools to help the copy/paste process go more smoothly. For more,
see Copy and Paste from Word.

3. Use the Conga Collaborate editor to format the content you've pasted in or insert
images, tables, pages breaks, and more. For more information, see Using the Editor. As
much as possible, let your selected Theme determine the styling of your content. If you
find that you are constantly changing styling within the document itself, consider
making changes to your Theme instead.

Add Dynamic Behavior

Once you've started adding content to your template, you can start adding Salesforce
variables and logic to drive dynamic behavior:

1. Open the Content panel, select Variables, and choose the dropdown containing the
type of variable you want to insert. When you place your cursor into the document, a
“+" will appear next the variable names. Clicking this will insert the variable.
Alternatively, you can type "%variable_name" into the document, and you will be
presented with a list of dynamically filtered variables to insert into your content. See
Variables for more information.
2. Use Insert -
3. Conditional Content to create sections of text or content in your documents that will
only show based on specific criteria. See Conditional content for more information.
4. Use the gear icon next to a page in your Table of Contents to open Page
Properties and add page include logic, allowing the page to only show based on

specific criteria. See Conditional sections/pages for more informaction.



5. Use Insert -

6. Table to start building a table that will automatically populate with child object
data from Salesforce, like contacts or products related to a launching record. See
Pricing Tables for more informaction.

7. If you would to update Salesforce when this document is signed or other events occur,
see Outgoing Data for more informaction.

If you don’t see the Salesforce fields you need to build your dynamic behavior, refer to
the Mapping Incoming data article. For even more detailed information on creating
templates within Conga Collaborate and optional additional configurations, go to
Creating Conga Collaborate Templates.

Step 3: Test your Template

During and following the build of your template, ensure that you are testing! Your testing
will follow a similar workflow as the sample document in the video at the top of this
article. In brief, follow these steps to test a typical document workflow:

CREATE

1. Login to Salesforce and navigate to your launching object.

2. Go to the Octiv Documents related list and click New Document. If you have not set
up Template Mapping, you will need to select the document you'd like to create.

3. Turn on Preview in the document Table of Contents and review the document content,
confirming the dynamic behavior you have configured is working as desired.

CUSTOMIZE

1. Turn off Preview to manually edit any unlocked pages or sections of the document.
2. If your workflow includes adding content from the content library or leveraging tasks,
test to ensure that the desired editing process can be executed successfully.

SHARE

1. Open the Next Steps tab and click Publish to finalize the document for sending.

2. Click Add People and follow the prompts to send the document.

3. Use the email you received to open the document and review it. While testing, we
recommend opening in an incognito window so that your current session doesn’t
recognize you.

4. Test the document’s Call to Action buttons (ex: Ask a Question or Accept), and if
needed, go through the process of electronically signing the document.



5. If you have set up Outgoing Data rules, (ex: upon Acceptance, update Opportunity
Stage to Closed Won) confirm updates were made appropriately in Salesforce.

TRACK

1. On your Salesforce launching object, review the Octiv Documents related list to
confirm the document is accessible and the document data has updated.

2. Click on the document name to open the Conga Collaborate document, and then
open the Track panel and select View Full Report to review the tracking information.

We recommend sitting down with a group of pilot users who are adaptable to new
technology and have them test as well. Record feedback and make revisions following user
testing.

Step 4: Deploy Your Solution

Formal deployments look different in every organization, the important thing is that users
are notified, trained, and have the proper incentive to use their new process.

If you have questions about how to deploy your new process to your team, check out our
Deployment Guide for more informaction.

Install Conga Collaborate Buttons and Lists in
Salesforce

The Conga Collaborate Document buttons and Conga Collaborate Document Related List
allow your users to create documents from directly within Salesforce and view and access
lists of Conga Collaborate documents related to specific records inside Salesforce.

Launching documents from Salesforce and storing records of documents back to Salesforce
increases adoption of both your Salesforce and Conga Collaborate platforms, keeps both
systems in sync, and provides a fluid end-to-end document workflow.

Permissions Needed
Salesforce permissions to edit page layouts and objects
Determine Your Launching Object

Before you start, determine your document launching object. This is the Salesforce object
that you wish to launch documents from and relate documents back to in Salesforce.



Opportunity and Account are the most common Salesforce launching objects. However,
Conga Collaborate supports launching from the Opportunity, Account, Lead, Case, and
Contact objects by default. You can also launch from other objects, including custom
objects, with some additional setup. Below are instructions for both scenarios.

Many Conga Collaborate admins desire to launch some document templates from one
object type, and some document templates from another. Conga Collaborate works well in
this scenario. NDAs and MSAs, for example, are often launched from an Account record
whereas proposals, quotes, or order forms are often launched from Opportunity records.

Because launching objects are critical to determining how variables are mapped and logic
statements are written in documents using Salesforce logic, Conga Collaborate
recommends avoiding trying to launch one template from multiple objects types, such as
launching a Scope of Work from both an Account AND an Opportunity object.

Install Conga Collaborate buttons and related list on the Account, Case, Contact, Lead, or
Opportunity objects

1. Open the editor on the page layout for your respective object.
2. Using the editor palette, add the New Document button to the layout.
3. Click Related Lists and add the Octiv Documents related list to your layout.
4. Customize the related list by adding fields to display; we recommend:
- Document name
- Created Date
- Last Modified Date
- Last Viewed
- Status
- Value
- Views
5. Choose how you'd like your list to be sorted; we recommend sorting in Descending
order by Last Modified Date.
6. Save your changes. You may be prompted to apply the changes; if so, click Yes.

Install Conga Collaborate buttons and the related list on other standard objects or
custom objects

Open the object settings for the Octiv Document object.
Create a new field on the object.
In Data Type, select Lookup Relationship. Click Next.
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From the dropdown menu, select the object you'd like to lookup to. This will be your
launching object for creating Conga Collaborate documents. Click Next.

5. Enter the Field Label and Field Name (without the __c) of the object you chose and
click Next. The Field Name must exactly match the Object Name name of the object
you are relating to Conga Collaborate Documents. (Optionally, you can make the



field required, set the deletion action, and create a lookup filter. We also recommend
writing a good description for future documentation purposes.)

6. Make sure the Lookup field is marked as visible to all profiles and not marked as read
only. Click Next.

7. Optionally add the lookup field to the Octiv Document page layout. End users will
never see this layout, so adding it is purely up to your preference. Click Next.

8. Create a related list label. We recommend Conga Collaborate Documents.

9. Add the related list to your lookup object page layouts as necessary. Click Save.

To verify that setup was completed correctly, go to the parent object and select a record.
On the record detail page, the new related list should appear with a New Document
button. Click the button, and a new Conga. Collaborate Document should open within your
Salesforce window.

Launching a document from a Salesforce record

When the Conga Collaborate managed package is installed in a Salesforce instance, a
New Document button will become available from the launching object that your Conga
Collaborate Admin has chosen. Many Conga Collaborate customers elect to launch
documents directly from this button rather than using the Conga Collaborate interface to
create them.

Use the Conga Collaborate managed package for Salesforce to create, edit, publish, and
send documents all from directly within Salesforce.

Keep users working in one system to improve efficiency, help ensure data accuracy, and
reduce user fatigue from using too many software systems.

1. Populate the proper data in Salesforce.

2. Create a new document using either the Octiv Documents related list or the custom
New Document button.

3. Edit and share your document.

Check out the video below to learn more about launching, customizing, and sending Conga
Collaborate documents using Salesforce.

Salesforce: Adding contacts to documents

Add your Salesforce contacts when emailing a document through Conga Collaborate. You
can easily import the contact information for contacts related to your launching object.
This feature works on any object in Salesforce, but when launching from the Opportunity or
Account objects Conga Collaborate will by default pull contact information from the
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Contact Roles related list on each object, while a custom object that uses a lookup to an
account will pull all the Account level contacts. Contact your relationship manager if you
do not see this feature in your account.

Reduce the time your users have to spend entering recipient information in a document by
quickly and easily adding it from your Salesforce data.

1. Confirm that contact mapping has been configured in your Conga Collaborate
account.

2. Create a document from your launching object.

3. Open the People panel on the right side of the document editor.

4. Add recipients by clicking Add People and then Add Salesforce Contacts.

For each launching object, you can configure either 1(one) lookup field or 1(one) related list
from which to pull contact(s).

Salesforce: Adding the Conga Collaborate Document
related list and buttons to page layouts

Conga Collaborate document buttons and the Conga Collaborate Document related list
allow you to quickly generate documents and easily view which documents are associated
with a particular Salesforce record.

Add the two standard Conga Collaborate buttons and the Conga Collaborate related List
to your launching object page layout.

Due to legacy naming conventions, the related list is named “Octiv Documents” on the
Opportunity, Account, Contact, Case, and Lead objects.

The two standard buttons have different purposes:

- New Document - Creates a new Conga Collaborate document related to your
launching record

- Add Existing Document - Allows users to associate previously created Conga
Collaborate documents with the particular record

The Conga Collaborate Document related Llist enables you to see all Conga Collaborate
documents associated with a particular record. You can also edit and delete documents
directly from the related list.

Permissions Needed: Salesforce permission Customize Application
Related Articles:

- Adding buttons to objects
- Adding documents to objects
- Associating a record to a Conga Collaborate document



Relating objects to documents

Salesforce Classic users

1.

w

Navigate to a record from your launching object (in most cases this will be an
Opportunity)
Click Edit Layout in the upper right of the screen
In the layout editor, click Buttons
Add the two buttons labeled Add Existing Document and New Document to the
Custom Buttons section of the page layout
In the layout editor, click Related Lists
Add the Conga Collaborate Documents related Llist to your screen
Edit the fields displayed in the related list by clicking the wrench icon just above the
list title
Select the fields that you would like to add to the list, we recommend:

- Document name

- Created Date

- Last Modified Date

- Last Viewed

- Status

- Value

- Views
Choose how you'd like your list to be sorted. We recommend sorting by Last Modified
Date in Descending order

. Click OK
. Click Save. You may be prompted to apply the changes to all user layouts; if so,

click Yes

Salesforce Lightning users

1.

A

Navigate to a record from your launching object (in most cases this will be an
Opportunity)

Click the gear icon in the upper right-hand corner of the screen

Click Edit Object

Click Page Layouts

Select the page layout you want to change

In the layout editor, click Mobile & Lightning Actions

Add the two buttons labeled Add Existing Document and New Document to the
Salesforce Mobile and Lightning Actions section of the page layout. There are two



New Document buttons available. You need to add the one with the name
“tinderbox__new_tinderbox_document”
8. Follow steps 5-11 from the Salesforce Classic section above

Salesforce: Associating a Record to a Conga
Collaborate Document

You don’t have to leave Conga Collaborate to associate a document with a Salesforce
object such as an Opportunity, Lead, Account, or Contact.

Associate an already-created document with a Salesforce record from within Conga
Collaborate itself. You can associate a document in this way for the Opportunity, Lead,
Account, or Contact objects.

Sometimes it is useful to associate a document with a Salesforce record from within Conga
Collaborate itself. For example, while building and testing a new version of a template, you
might want to connect it directly with a test Opportunity without having to go into
Salesforce to create a document.

Confirm that your user is authorized to connect to Salesforce:

1. In your user dropdown in the top-right corner, click User Profile
2. On the General tab, scroll down to the Salesforce section and select Authorize Octiv
Salesforce Access

If successful, a success message and the connected Salesforce org ID will be displayed.

Connect a created document with a Salesforce record

1. From within the document build view, open the Integrations panel.

2. Next to Salesforce Opportunity, click Search.

3. In the pop-up window, select your Salesforce object. Opportunity, Lead, Account, and
Contact are available.

4. Search for your desired record.

o

Select your record and click Assign. A success message should appear.
6. Click Refresh Variables to reload the document with data from your selected
Salesforce record.



Salesforce: Changing a Dcument's Related Salesforce
Record

You may want to assign Conga Collaborate document to unique or different objects
(usually an opportunity).

Re-assign an already-created Conga Collaborate document to a different record in
Salesforce.

Some example use cases:

- Document was created on an incorrect record and significant edits have been made,
so you don’t want to start from scratch with a new document.

- Document was created from a Contact record, and then that person leaves the
client’s company while editing the document and you want to associate it with your
new client contact.

Confirm that your user is authorized to connect to Salesforce:

1. In your user dropdown in the top-right corner, click User Profile.

2. On the General tab, scroll down to the Salesforce section and select Authorize
Collaborate Salesforce Access.
Note: If successful, a success message and the connected Salesforce org ID is
displayed.

To associate a document in Draft with a different record

From within Conga Collaborate:

1. Open the document you wish to assign to a different record.
2. Open the Integrations panel.
3. Remove the CRM Integration ID.

From within Salesforce:

Navigate to the record that you wish to add your document to.

Click Add Existing Document.

Click the checkbox next to the document(s) you want.

Click Add to Opportunity.

Select Done Adding. You can now find these documents in your related list of Conga

o w N~

Collaborate documents associated with the record.



To associate a Published document with a different record:

Open the document.

Open the Integrations panel.

Remove the CRM Integration ID.

In Salesforce, navigate to the record that the document is currently associated with.
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Delete the document from the related list and ensure to select the option to keep the
document in Collaborate.

o

Navigate to the new record you want to associate the document with.
7. Click Add Existing Document.
Note: Add this button to the Page Layout if it is not yet located on the Page Layout.
8. Click the checkbox next to the document you want to add to the record.
9. Click Add to Opportunity.
10. Select Done Adding.
The document is now added to the record’s related list.

Salesforce: Configuring Product Pages

Product pages allow you to automatically create individual pages within a Conga
Collaborate document for each child record on your launching object.

Using product pages, you can design a full-page that uses dynamic content associated
with a product to create individual pages for product offerings. Product pages also allow
you to access grandchildren records off of your launching object, so you could display the
Quote Line Items associated with each Quote on an Opportunity.

If you are using the standard Quote object in Salesforce, use the Quote
Pages feature.

This is an advanced feature that requires knowledge of auto-generated content as well as
a good understanding of how data is structured within Salesforce and interpreted in Conga
Collaborate.

Permissions: Conga Collaborate System Administrator This article will use the following
example to guide you in setting up product pages: We have set up an Opportunity
hierarchy where we have a parent Opportunity custom object and a related child
Opportunity object. We want to create a document that launches from the parent
Opportunity record and contains one page for each child Opportunity record, complete
with data from the child Opportunity record and the child’s Opportunity Product data.
Terminology: In this scenario, the parent Opportunity custom object will be the document
launching object (where you click the New Document button), and the child Opportunity



object will be the data source for the product page (the product page launching object).

Each child Opportunity will contain Opportunity Products, which act as grandchild records

of the launching object. The terms launching object and product page launching object will

be used throughout this article, so make sure you understand which is which in your use

case. Mapping Data for Product Pages Product page variables must be mapped in their

own object, otherwise known as the product page launching object, within the Salesforce

Integration page. Follow these steps:

1.

From your user dropdown in the top right corner, go

to Administration > Integrations > Salesforce > Edit.

Select your product page launching object in the Incoming Data section. In our
example, this would be the standard Salesforce Opportunity object.

Map the fields you want to use that live on that object.

Map child-level product page variables to use as auto-generated content. In our
example, these would be fields that are on the Opportunity Products object.
Confirm the setup of your product page mapping. In our example, it would be: Parent
Opportunity variables mapped as their own launching objectChild Opportunity
variables mapped as their own launching objectOpportunity Product variables
mapped as children of the child Opportunity

Creating Product Pages Product pages are created as content pages within your Conga

Collaborate Content library. Follow these steps to build a product page template:
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Go to Content.

Click +Add New button.

Click Page.

Add the content for your product page.Add static content - text, images, links, etc.Add
dynamic Salesforce content.Insert product page launching object variables in
{{double braces}}. In our example, these would be fields on the Opportunity
object.Insert product page child variables within [square brackets] and use the
appropriate data-source. In most use cases, this involves creating an auto-generated
table. In our example, these would be fields on the OpportunitylLineltems object.
Name your product page. Naming a product page is one of the few scenarios in which
you can use variables in the title of the page. Child object variables are often
included in a page’s name to differentiate the pagesDetermine the field in Salesforce
that will name your page. This must be a field on the product page launching object
(in our example, the Opportunity object)Make sure the field is mapped in the
Salesforce Integration pageCopy and paste the APl name of the field into your
product page title surrounded by {{double braces}}



13.

17.

For example, if your child Opportunity name variable was Name, you could name
your page Product Option - {{Name}} or just {{Name}}. In the latter example, if you
had two child Opportunities with the names of New Business and Renewal, the
product pages in your generated document would be named New Business and
Renewal, respectively.Configuring Product Pages Product pages are configured within
the Salesforce Integration settings in Conga Collaborate. Follow these steps to set up
Product Pages:

From your user dropdown in the top right corner, go

to Administration > Integrations > Salesforce > Edit.

In the Manage Features section, click on the Product Settings tab.

Fill out the Product Section Title field. This names the section within your Conga
Collaborate document where you want product pages to be createdlf you type in the
name of a current section of your template, the generated product pages will be
added to that section.If you type a new section name, this section will be added at
the end of your generated document.

. Check the Create Product Pages checkbox.
. Choose a Page Template. Select the Asset page you built in the Creating Product

Pages section

. (Optional) Define a page include filter. This filter lets you include only pages for child

records that meet the filter criteria. Using our example of the Opportunity Hierarchy
from earlier, you might set a filter where a product page for the child Opportunities is
only included if that child Opportunity has a stage of Proposal Creation Example
syntax: Stage == 'Proposal Creation'

Select your child object in the Custom Line Item Object Name field. In our example, it
would be Opportunity.

. Type in the Salesforce APl name for the field that holds the ID of the parent object to

the object you selected in step 7. This would be something like ParentOpportunitylD in
our example. No brackets are included around the APl name.

. (Optional) Define the field on your child object by which to sort the product pages

within the document.

. Select your document template from the list on the right. You can select multiple

templates by Ctrl+clicking the templates you want to use.
Click Save.

Mapping Templates Product Pages only work when template mapping is enabled for the

template you chose in step 10 above. Reference the article for more information on how to

do this. Launching your Document Once all the above steps have been completed, create a

document from within Salesforce. If everything was configured correctly, your generated

document will contain a page for every child record on your launching object and each

page will be populated with the content and data you defined in your Content page

template.



Salesforce: Configuring quote pages

If you've enabled standard Quotes within Salesforce, you can create a page of content in
Conga Collaborate for each quote, and your document recipient can accept each of these
pages individually.

Quote pages allow you to quickly generate documents with multiple price points or
packages, and your client can choose the option he or she wants.

You will create a page in your Content library that contains all the relevant content and
variables from Salesforce to build out your quote page. This content page acts as a
template for each Quote. When a document is generated, a separate page is created for
each Quote record that is connected to the launching object from which you create your
document.

For example, if you have three pricing options on your Opportunity, you can create three
Quotes on the Opportunity in Salesforce, each with its own pricing structure, line items, and
so forth. When you create a Conga Collaborate document off of that Opportunity, you will
see three new pages created from the quote pages template that display all of the
variables and line items from each quote.

You must be a system administrator to configure quotes.

Mapping Quote Fields

When mapping the fields that you want to use in your quote page, choose Quote as your
launching object and map all of your fields (Quote fields, Quote Line Item fields, etc.)
through the Quote object.

Creating Quote Pages

Follow these steps to build a quote page template:

1. Inside Conga Collaborate, go to the Content tab.
2. Click Add New.
3. Select Page.
4. Add the content for your quote page:
- Add static content - text, images, links, etc.
- Add dynamic Salesforce content:
- Insert Quote object variables within {{double curly brackets}}.



- Insert Quote Line Item object variables within [square brackets] and use
the appropriate data source. In most cases, this involves creating an
auto-generated table.

5. Name your quote page. Naming a quote page is one of the few scenarios in which you
can use variables in the title of the page. Using a variable in the page name allows
users and recipients to easily differentiate the pages.

Determine the field in Salesforce that will name your page. This must be a field on the
Quote object.

Make sure the field is mapped in the Salesforce Integration settings.

Copy and paste the APl name of the field into your quote page title surrounded by {{double
curly brackets}}.

For example, if your Quote name variable was Name, you could name your page Quote
Option - {{Name}} or just {{Name}}. In the latter example, if you had two Quotes with the
names of Pricing Set A and Pricing Set B, the quote pages in your generated document
would be named Pricing Set A and Pricing Set B, respectively.

Configuring Quote Pages

Determine where and how your quote pages land in your documents. Quote pages are
configured within the Salesforce Integration settings in Conga Collaborate. Follow these
steps:

1. From your user drop-down in the top right corner, go to Administration > Integrations
> Salesforce > Edit.
2. In the Manage Features section, click on the Quote Settings tab.
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From the Quote Settings menu, check Create Quote Pages.
4. Fill out the Quote Section Title field. This names the section within your Conga
Collaborate document where you want your quote pages to land.
- If you type in the name of a current section of your template, the generated
quote pages will be added to that section.
- If you type a new section name, this section will be added at the end of your
generated document.
5. Choose a Quote Template. Select the Content page you created in the Creating
Quote Pages section.
6. (Optional) Define a page include filter. This filter lets you include only pages for
Quotes that meet the filter criteria. You might set a filter where a quote page is only
included if the Quote has a value greater than $10,000. Example syntax: Amount >=
10000



7. Click Sync Accepted Quote if you want the recipient's accepted Quote page to be
automatically synced with your Opportunity. This feature pushes client selections
within the document back to Salesforce.

8. (Optional) Assign your Conga Collaborate document a value based on a field on the
accepted Quote.

9. Select your document template from the list on the right. You can select multiple
templates by Ctrl+clicking the templates you want to use.

10. Click Save.

Mapping Templates

Quote pages only work when template mapping is enabled for the template(s) you chose in
step 9 above. Reference this article for more information on how to do this.

Launching Your Document

Once all the above steps have been completed, create a document from an Opportunity
within Salesforce. If everything was configured correctly, your generated document will
contain a page for every Quote on your Opportunity and each page will be populated with
the content and data you defined in your Quote page template.

In order to refresh variables on Quote pages, you must click the dropdown on the Refresh
Variables button and select Refresh Variables and CRM Pages. This will pull in any
updates you have made to your Quotes in Salesforce.

Salesforce: Creating Auto-generated Tables

Auto-generated tables allow users to quickly create tables in their documents that
leverage sets of data from a CRM or other integrated system. You must be integrated with
a CRM or other data source to leverage auto-generated tables in Conga Collaborate.

Conga Collaborate administrators can use an auto-generated table to create dynamic
tables that display a set of child records related to your document’s launching object. For
example:

On a template that launches from a CRM Opportunity record, create a table that
populates with data from the Opportunity Product line items.

On a template that launches from a CPQ Quote record, create a table that populates with
data from the Quote line items.



On a template that launches from a CRM parent Account record, create a table that
contains a list of child Account locations and address information.

In the above examples, the auto-generated tables use child object data. Some
administrators may be interested in creating tables that access data from grandchildren
objects. For example, launching a document from the Opportunity record that needs to
gather data from a related quote object (child) and the quote line items on that quote
(grandchildren). In these cases, the tables must be built using advanced auto-generated
content attributes, Product Pages, or Repeatable Pages.

Creating an Auto-Generated Table

In this example, we'll create a pricing table in a template that uses data from
OpportunityLineltems on an Opportunity record in Salesforce. The Opportunity is the
document’s launching object, and the OpportunityLineltems object (child object) acts as the
source of data for the table.

Step 1: Create your table

Within a page, click Insert - > Insert Table from the editor toolbar.
Create a table that has three rows and as many columns as you need.
Right-click on the table and click Table Properties.
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Within the Table Properties modal, change the class to Pricing Table. This changes
your table from a regular, static table into an auto-generated table that will allow
you to set a data source, insert variables, and generate rows dynamically based on
the data entering the table.

5. Click Ok.

6. Make the top row a Header row so that the headers stay static and are not repeated

with the rest of the table:

7. Right-click into the top row of your table and open the Row Properties.

8. In Row Properties, change the Row type to Header.

9. Click Ok.

10. In order to include a summary total of all products, set the last row of your table as
a Footer row so that the total does not repeat when your table is generated with
actual data:

11. Right-click into the bottom row of your table and open the Row Properties.

12. In Row Properties, change the Row type to Footer.

13. Click Ok.



Step 2: Give your table a data source

1. Refresh the page and hover over the table you've created. A gear icon will now
appear in the top-right corner of the table.

2. Click the gear icon to open the Pricing Table settings.

3. Select a Data Source for your table. The data sources available are dependent upon
the child objects you have mapped from your launching object(s) in your CRM
integration settings. In this example, our data source is OpportunitylLineltems, which
was mapped through the document launching object, the Opportunity.

Step 3: (Optional) Sort and filter your table

Pricing Table settings also support sorting and filtering the data in your table. For example,
you might create two tables, one filtered to only include products that have a recurring
cost and one filtered to only include products that have a one-time cost.

To filter your table

1. Click on the gear icon on the upper right-hand side of the table to open the Pricing
Table settings.

2. Click Add Filter. This will open the logic builder.

3. In the Variable dropdown, choose the variable you would like to filter by. The options
available in the dropdown are dependent upon the child object variables you have
mapped in your CRM integration settings page. Example: Product Family

4. Choose your desired operator from the Operator drop-down.
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Enter the value to which you would like to compare your variable. Example: Services

6. Choose a data type that matches the type of the value to which you are comparing.
Default = String.

7. Click Save.

You can click Show Advanced and write more advanced expressions, including using ANDs
or ORs. For more information, see Advanced Conditional Logic Statements.

To sort your table

1. Click on the gear icon in the upper right-hand corner of the table to open the Pricing
Table settings.

2. Choose the value you want to sort by from the Sort By dropdown menu. The options
available in the Sort By dropdown are dependent upon the child object variables you
have mapped in your CRM integration settings page.

3. Click Save.



Step 4: Fill in your table

Now that you have set the table class, data source, and header and footer row properties,

you are ready to fill in your table with variables that will display in each repeated row:

1.
2.
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Type your column headers into the cells in the header row.

In the middle Body row, type % into a cell to get the dropdown list of
OpportunitylLineltem variables to choose from. Select the variable you'd like to
appear in that column. If you don't see the variable you are looking for, it may not be
mapped to Conga Collaborate. When your table generates with real data, it will
create one row for each record found in the data source, with each row containing the
values for one unique record.

Create a total in the footer row using aggregate functions. Aggregate function
syntax: [FUNCTION_NAME(variable_name)] Aggregate functions only work in footer
rows. In this example, we'll use [SUM(TotalPrice)].

Set Cells to show data in your desired format.

Right click on the cell.

Click Cell Properties.

Set the cell Class to show data in a certain format, such as Currency. Cells with a
class of Currency will automatically format with USD currency, or will format as
determined by the document’s language (found in document properties if enabled).

Step 5: Test your table

Now that you have created a pricing table in your template, launch a new document from

your CRM environment using that template. Turn on the Preview toggle in your Table on

Contents in order to see the auto-generated table populate with OpportunitylLineltem

data.

Advanced auto-generated content

Conga Collaborate is capable of auto-generating content from arrays of data in more

complex ways than is possible solely from the Pricing Table editor. For example, you might

want to dynamically group products and totals by product family. This is doable but

requires advanced auto-generated content attributes. For more information, refer to Auto-

generated Content or contact support.



Salesforce: Creating Buttons for Custom or Non-
Default Objects

While Conga Collaborate automatically creates buttons for the Opportunity, Account,
Case, Contact, and Lead objects, you can create custom buttons for any object in
Salesforce in order to easily launch documents off of that object.

Create custom buttons for any object in Salesforce in order to easily launch documents off
of that object.

Note: This article assumes that you have already created a custom Lookup relationship
between the Collaborate Document object and your launching object. If you haven’t done
this, reference this article.

Conga Collaborate automatically creates buttons for the Opportunity, Account, Case,
Contact, and Lead objects, but if you want users to have buttons available at the top of
their layout to create documents on any other object, you will need to create custom
buttons on those objects.

For adding buttons to the Opportunity, Account, Case, Contact, or Lead objects, reference
this article.

The two buttons you can add to objects are the New Document button and the Add Existing
Document button:

- A New Document button creates a Conga Collaborate document and links the newly
created document to the launching object.

- An Add Existing Document button attaches a Conga Collaborate Document to a
record other than the one from which it was originally created.

To create these buttons in Salesforce Classic:

For a custom object

1. Enter Salesforce setup by going to Setup » Create » Objects »Your Launching Object.
2. Navigate to the Buttons, Links, and Actions section.
3. Click New Button or Link and proceed to Step 1.

For a standard object

1. Enter Salesforce setup by going to Setup » Customize » Your Launching
Object » Buttons, Links, and Actions.



2. Click New Button or Link and proceed to Step 1.

To create these buttons in Salesforce Lightning

Navigate to Setup.

Click the Object Manager tab.
Search for your object and select it.
Click Buttons, Links, and Actions.
Select New Button or Link.
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Continue to Step 1 below.
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Assign the Label, Name, and Description for your button. These instructions use two
example suggestions for the Label (New Document and Add Existing Document), but
you can name the button whatever you want.
- Label: the text a user will see on the button.
- Name: automatically populated with text from the Label field as soon as you
click out of the Label field. This can be customized if desired.
- Description: a note for other Salesforce Admins about what this button does.
Set Display Type to Detail Page Button.
Set Behawvior to Display in existing window without sidebar.
Set Content Source to URL.
Input the following text into the editor, replacing LAUNCHING_OBJECT with the object
you're launching from (for example, Quote):
- For the New Document button: /apex/tinderbox__create_document?
sObjectType=LAUNCHING_OBJECT&recordld={!LAUNCHING_OBJECT.Id}
- For the Add Existing Document button: /apex/tinderbox__add_document?
sObjectType=LAUNCHING_OBJECT&recordld={!LAUNCHING_OBJECT.Id}
6. Click Save.
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Salesforce: Enabling attachments

You can pull whatever files you've put into your Notes & Attachments section of an
Opportunity or other Salesforce object into your Conga Collaborate proposal. After you
move them, these files appear as Attachments to your document. They're updated when
you click “Refresh Variables”.

Only a System Administrator can enable this function.
Follow these steps to add Salesforce attachments to your account capabilities:

1. From your Administration view, click Integrations.
2. Choose Salesforce.
3. Scroll down to Manage Features.



4. Click Attachments.
5. From the dropdown menu, click the checkbox next to Enable Attachments.

You can specify which files you want pulled into your proposals by specifying a pattern
(e.g., .pdf) in the File Name Pattern field. If you don’t set parameters, all files are pulled as
attachments. You will also want to include a “wild card” in front of your file type if you'd
like to have a specific name as part of what'’s attached (e.g., *.pdf if you want to have any
PDF file; OR *signed.pdf if you only want PDF names that end with “signed”).

Salesforce: Auto-publishing documents

The auto-publish feature for documents created through Salesforce and Conga
Collaborate saves time by enabling reps to select a template, build, and publish a
proposal with one click.

Generate and publish a document with a single click.

Save time by reducing the number of clicks required to publish a document, or use auto-
publish to lock down content that you don't want reps to edit.

From your user dropdown in the top right corner, go to Administration.
Select Integrations.

Choose Salesforce.

Click Edit.

Scroll down to the section labeled Assign Template.
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When setting up template mapping, select the Auto-Publish checkbox.

When a document is launched from Salesforce, you will be presented with a published
document that is ready to be sent to recipients.

Salesforce: Granting access to Conga Collaborate

Follow these steps to grant Salesforce access to Conga Collaborate

Before the Conga Collaborate support team can help you set up your Salesforce
Integration, we need access to your Salesforce account. The safest way for you to enable
that is by using the Salesforce Grant Access feature. No account credentials change hands,
changes made show up in an audit trail, and the feature doesn’t allow the outside user to
make changes to vital data like your passwords or users.

To grant Conga Collaborate access to your Salesforce account, you must first install the
Conga Collaborate Managed Package.



Follow these steps to grant access:

1. In Salesforce, click the User Menu option next to Setup at the top of the screen (Your
name).

Click My Settings.

Click Personal.

Click Grant Login Access.

Open the Conga Collaborate Support menu and choose the length of time you’ll
grant access. We recommend one month.

Click Save.

. Notify your Conga Collaborate account manager that access has been granted.
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Salesforce: Integration and installation overview

Integrate Conga Collaborate with Salesforce to bring the power of your CRM to your
document generation process. Conga Collaborate’s integration with Salesforce supports
the following versions:

- Unlimited
- Enterprise
- Professional

Build data-driven documents using Salesforce objects to streamline document creation by
lowering edit time, reducing errors from manual copying of information, and creating more
standardized templates that reps can quickly get out the door. Drive data from Salesforce
into a document or push data back to Salesforce based on events in Conga Collaborate.
Use the flexibility of Salesforce reports to view detailed information on the performance of
your Conga Collaborate documents.

Permissions Needed: Conga Collaborate and Salesforce System Administrator

Step 1: Install the Conga Collaborate Managed Package in
Salesforce.

1. Loginto the Salesforce org where you want to install Conga Collaborate.

2. To begin the package installation in a production Salesforce Org, click here.

3. To begin the package installation in a sandbox Salesforce Org, click here. Conga
Collaborate sandbox environments are also supported for this integration. If you are
interested in setting up a Conga. Collaborate sandbox to connect to a Salesforce org,
please contact Support.

4. Choose security settings for the package install. We recommend Install for All Users.


https://login.salesforce.com/packaging/installPackage.apexp?p0=04tA0000000KPJx
https://test.salesforce.com/packaging/installPackage.apexp?p0=04tA0000000KPJx

5. Click Install in the bottom right of the content area.
6. After installation completes, enter your Conga Collaborate URL in the Octiv URL field.
7. Click Save.

Step 2: Connect your Conga Collaborate environment to
Salesforce.

1. Open a new browser tab and log into your Salesforce Org.

2. Open a second browser tab and log into your Conga Collaborate account.

3. In Conga Collaborate, from your user dropdown menu, go to Administration >
Integrations > Salesforce > Edit

4. Select the Production or Sandbox environment for connection.

5. Click Connect Salesforce.

© You must be logged in directly as the user you would like to use as the integration
user. You are unable to connect on behalf of another user by utilizing the Grant
Account Login Access feature of Salesforce. Your internal Integration User must be
the one to click Connect to Salesforce.

A green checkmark appears next to the Salesforce logo and a confirmation message
displays to indicate a successful connection. You can verify that Conga Collaborate is
connected to your Salesforce environment by checking the Salesforce Organization ID at
the top of the page and confirming that it matches the Salesforce Organization ID of your
Salesforce environment.

Salesforce: Relating objects to Conga Collaborate
documents

Relating objects to Conga Collaborate documents.

Add lookup fields to the Octiv Document object in order to use Conga Collaborate
documents on any object in your Salesforce org.

The Conga Collaborate managed package creates relationships from the Octiv
Documents object to five standard Salesforce objects: Opportunity, Account, Case,
Contact, and Lead. You can create documents from these objects out of the box with no
additional configuration. Adding the lookup fields gives you the ability to create documents
from other objects (including custom objects) and allows you to create a custom

button and show a related list of documents on that object.




Follow these steps to create a custom lookup field in Salesforce Classic:
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12.

Go to Setup

In the settings pane on the left-hand side of the page, go to Build => Create =>
Objects

Click Octiv Document

In the Custom Fields & Relationships related Llist click New

In Data Type, select Lookup Relationship and click Next

From the dropdown menu, select the object you'd like to relate to Octiv Documents
and click Next

Enter the Field Label and Field Name (without the __c) of the object you chose and
click Next. Note: The Field Name must exactly match the Object Name name of your
custom object. (Optionally, you can make the field required, set the deletion action,
and create a lookup filter. We also recommend writing a good description for future
documentation purposes.)

Make sure the field is marked as visible and not read-only for all profiles and

click Next

Check the Add Field box next to the Document Layout page layout and click Next

. Create a related list label. We recommend Octiv Documents <Custom Object Name>
. Confirm that the related list is being added to your desired page layouts using the

checkboxes next to the page layout names
Click Save

Follow these steps to create a custom lookup field in Salesforce Lightning:
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Go to Setup

Select the Object Manager tab

Search for Octiv Document in the Quick Find bar

Click Octiv Document

Click Fields & Relationships

Click New

In Data Type, select Lookup Relationship and click Next

From the dropdown menu, select the object you'd like to relate to Octiv Documents
and click Next

Enter the Field Label and Field Name (without the __c) of the object you chose and
click Next. Note: The Field Name must exactly match the Object Name name of your
custom object. (Optionally, you can make the field required, set the deletion action,
and create a lookup filter. We also recommend writing a good description for future
documentation purposes.)

. Make sure the field is marked as visible and not read-only for all profiles and

click Next

. Check the Add Field box next to the Document Layout page layout and click Next



12. Create a related list label. We recommend Octiv Documents <Custom Object Name>

13. Confirm that the related list is being added to your desired page layouts using the
checkboxes next to the page layout names

14. Click Save

To verify that setup was completed correctly, go to the parent object and select a record.
On the record detail page, the new related list should appear with a New Octiv Document
button. Click the button, and a new Conga. Collaborate Document should open in your
Salesforce window.

Salesforce: Setting up approvals

You can set up tracking and approvals workflows in Salesforce. A system administrator
can enable and configure this feature of your Salesforce-Conga Collaborate integration.

Enable Chatter Approvals

Log into Salesforce, and then follow these steps to enable Chatter Approvals:

1. Go to Setup

2. In the Quick Find menu on the left, use the drop-down arrows to go to Build >
Customize > Chatter > Chatter Settings

Click Edit

Check Allow Approvals

Click SaveEnable Feed Tracking for Custom Objects

Go to Setup
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In the Quick Find menu on the left, use the drop-down arrows to go to Build >

Customize > Chatter > Feed Tracking

8. Choose Conga Collaborate Document from the Object panel on the Lleft. If you
became a customer in 2015 or later, you should be using Conga Collaborate
Documents. Contact Global Support if you're unsure of which object to use.

9. Check Enable Feed Tracking (there are default fields in the approval process already
checked, if your approval depends on other fields, make sure those are checked)

10. Click SaveCreate a Chatter Post Template

1. Go to Setup

12. In the Quick Find menu on the left, use the drop-down arrows to go to Build > Create >
Workflow & Approvals > Post Templates

13. Click New Template



19.
20.
21.

22.

23.
24.

25.

26.

27.

28.

Select the object you want to post for approval. If you became a customer in 2015 or
later, you should be using Conga Collaborate Documents. Contact Global Support if
you're unsure of which object to use.

. Click Next

. Give the Template a Name and, if you like, a description

. (Optional) Check Default if you want to use this Template for all related posts

. Select up to four fields you want to include on the Chatter post (an example preview

can be seen by clicking the box to the right)
Click SaveCreate an Approval Process
Go to Setup
In the Quick Find menu on the left, use the drop-down arrows to go to Build > Create >
Workflow & Approvals > Approval Processes
From the drop-down menu next to “Manage Approval Processes For”, select the
Object for which you want to manage approvals. If you became a customer in 2015 or
later, you should be using Conga Collaborate Documents. Contact Global Support if
you're unsure of which object to use.
Click Create New Approval Process
Select either Jump Start Wizard or Standard Setup Wizard. The Jump Start Wizard
allows you to fill in basic information quickly.
Under Approval Process Information, give the Approval Process a Name, and assign
an Email and/or Post Template to be used for notifications
Under Specify Entry Criteria, set the following criteria:

- Field: Conga Collaborate Document: Status

- Operator: equal

- Value: Pending ApprovalYou can use additional criteria, but Conga Collaborate

depends on the Pending Approval status

Under Select Approver, choose one of the following Conga Collaborate-supported
options:

- Automatically assign an approver using a standard or custom hierarchy field

- Automatically assign to queue

- Automatically assign to approver(s)
Click Save.

You can use additional criteria, but Conga Collaborate depends on the Pending Approval

status. The Approver options supported by Conga Collaborate are the “Automatically

assign” options. There is not a way to choose the approver through the Conga Collaborate

interface at this time.



Further Configuration Options

The above sections get you going, but on the Approval Process edit page you can follow

these steps to further configure your approval options:
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Click the Edit drop-down

Enter Name and Description

Specify Entry Criteria

Select Approver Field and choose the desired Automated Approval Routing

Record Editability Properties. You may want to allow the assign approver to edit
records during the process.

Choose Notifications Templates. Choose to notify approvers via email and/or chatter.
Choosing a template enables this feature.

Set Approval Page Layout. The Post Template (created in the previous section) is for
Chatter only. This Page Layout is for the full Approval Page displayed when the
Approver logs into Salesforce.com

Select Initial Submitters (a good default Submitter is the Opportunity Owner that the
Conga Collaborate Proposal is attached to)

Salesforce Outbound Messages

In order to send messages to Conga Collaborate when an Approve, Reject, or Recall action

is performed, configure the actions in Salesforce. You do this in Outbound Messages.

Follow these steps to configure this feature:

1.
2.

3.
4.

Go to Setup

In the Quick Find menu on the left, use the drop-down arrows to go to Build > Create >
Workflow & Approvals > Outbound Messages

Click New Outbound Message

Select the Object you want to use in the Approval Process

If you became a customer in 2015 or later, you should be using Conga Collaborate

Documents. Contact Global Support if you're unsure which object to use.

Approve Publish Outbound Message

1.
2.

Enter a Name and optionally a Description
Enter the Endpoint URL as client Conga Collaborate domain + /salesforce + /approve
(e.g., https://example.Conga Collaborate.com/salesforce/approve)


http://salesforce.com/
https://example.octiv.com/salesforce/approve

3. Select a Salesforce SysAdmin user to receive the messages to avoid permission-
related issues. The only required field to send is tinderbox__TinderBoxId__c.
4. Click Save

Reject Publish Outbound Message

1. Click the Clone button on the Approval Outbound Message to create the Reject
message

2. Change all instances of Approve to Reject and select the same fields to send

3. Click Save

Recall Publish Outbound Message

1. Click the Clone button on the Reject Outbound Message to create the Recall message
2. Change all instances of Reject to Recall and select the same fields to send
3. Click Save

Assign Outbound Messages to Approval Process

1. Go to Setup
2. In the Quick Find menu on the left, use the drop-down arrows to go to Build > Create >
Workflow & Approvals > Approval Processes
3. Select the Approval Process you created earlier to assign actions to it. From this
screen you can specify Initial Submission Actions, Approval Steps, and Final Approval,
Final Rejection, and Recall Actions. You may include any actions of your own in any of
the phases but the Conga Collaborate outbound messages must be assigned to the
appropriate action.
4. For each of the Final Approval, Final Rejection, and Recall Actions:
- Click Add Existing.
- Select Outbound Message as the search option.
- Select the appropriate message from the Llist.

Optional Email Approval

If you're using an Email Notification, you can also enable email responses to be processed
and APPROVE or REJECT the requested approval.



Steps in Conga Collaborate

Your last step is to adjust user permissions in Conga Collaborate.
Conga Collaborate administrator can follow these steps to adjust the user permissions:

1. From the user drop-down in the upper-right corner, go to Administration > Roles and
Permissions

2. Select the role that contains your approvals users. Only custom permissions roles can

be edited. If you haven't created a custom role yet, select Create New Role in the

upper-right corner

Click Permissions

Enter Publish into the search bar

Disable the permission “Publish proposal”

Enable the permission “Request approval to publish”

Click Save
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Salesforce: Setting up BCC email for Opportunities

A system administrator can enable users to trigger Conga Collaborate to save a copy of
an email directly to Salesforce by using BCC.

Configure Conga Collaborate to BCC document emails to Salesforce by attaching an
email to the activity history of the related Salesforce Opportunity.

This feature is only compatible with Leads, Contacts, and Opportunities. It will not work if
you are launching off of a different object.

Save copies of the emails sent to your document recipients directly onto the related
Salesforce record to allow history tracking of communication with your recipients.

Salesforce Setup

1. From your personal settings, enter Email to Salesforce in the Quick Find box, then
select My Email to Salesforce.

2. Add the email address that is associated with your Conga Collaborate account
in My Acceptable Email Addresses.

3. In the My Email to Salesforce section, copy the Email to Salesforce Address.

4. Under Email Associations, check Automatically assign them to related salesforce.com
records.

5. Select Opportunities.
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6. Click Save.
Conga Collaborate Setup
7. In Conga Collaborate, open your user dropdown in the top right corner.
8. Select User Profile.
9. Open the Email tab.
10. Paste the copied Email to Salesforce Address from above into Default Email BCC.
1. Click Save.

Usage

Once configured, you will have the option to add your Email to Salesforce Address as a
BCC any time you send email from Conga Collaborate. When choosing which email
addresses to send to, click +BCC and your Email to Salesforce Address will be populated in
the BCC dialog.

Salesforce: Template mapping

Template mapping allows you to automatically choose Conga Collaborate template
based on an object or field in Salesforce.

Automatically choose a Conga Collaborate template based on an object or field value in
Salesforce.

Use template mapping to limit which templates are available to your users as well as to
streamline document creation by removing the template selection step.

You must be a Conga Collaborate system administrator in order to configure template
mapping.

From your user dropdown in the top right corner of the screen, select Administration.
Open Integrations.

Choose Salesforce and click Edit.

Scroll down to the section labeled Assign Template.

Choose your launching object.

Select your Salesforce field and the value of that field.
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Select the Conga Collaborate template you want to use based on the selections
made in steps 2 and 3

(Optional) Turn on Auto-Publish.

9. Click Add.

o

You can also select a Salesforce object without choosing a field. Doing so prompts Conga
Collaborate to use your chosen template any time a document is launched from that
object.



Finally, you can map the same template using different sets of criteria, even if launching
from the same object. The template that is selected is based on the specificity of your
mapping criteria. This means that if you're launching from an Opportunity and have two
sets of Opportunity mappings, Conga Collaborate chooses the more specific option. For
example, if you have mapped a template to the Opportunity object only and mapped
another template to a specific Opportunity stage, Conga Collaborate pulls the template
associated with the Opportunity stage because that mapping is more specific.

Salesforce: Using Salesforce email inside Conga
Collaborate

This feature enables you to use Salesforce email instead of Conga Collaborate email to
send your prospect a published document.

To configure this feature you must be a Conga Collaborate system administrator

Enabling Salesforce Email

Enable Salesforce email by following these steps:

From your user dropdown, go to Administration > Integrations > Salesforce > Edit.
In the Manage Features section, open the Email dropdown.

Check the box next to Enable Email.

Click Save.
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Finding the Email Template ID

The Email Template ID field allows you to auto-select a Salesforce email template, and
the ID is found within Salesforce. Follow these steps to find the template ID:

1. In Salesforce, go to Setup > Communication Templates > Email Templates.

2. Open your desired email template.

3. Inthe URL for your template, find the 15 character string of numbers and capital
letters - this is your template ID.

4. Copy the template ID and paste it int0 the Email Template ID field within the Email
dropdown in your Salesforce integration settings within Conga Collaborate.

5. Click Save.



Using Salesforce Email

After enabling email, you can send a Salesforce email from your document to your
recipients. Follow these steps to send a Salesforce email:

1. Create or open your document
2. Open the People tab
3. Click Salesforce Email

This will open the Salesforce email editor, where you can select an email template,
customize the message, and choose your recipient. The default recipient will be the record
marked as Primary Contact in the Contact Roles related list.

Adding the Document URL and Access Code to the Salesforce Email

Use either of these methods to include the document URL and access code (if you've
enabled it) in your email:

Copy the URL and access code and include it in the email

1. Copy the public document URL (from the Properties tab) and access code
2. Click the Salesforce Email button
3. Paste the URL and access code into the appropriate places in the email message

Using the Conga Collaborate Outgoing Data tool, push the document URL and access code
back to your launching object when you publish a document

1. Create Salesforce fields for both the document URL and access code on your
launching object.

2. Configure Outgoing Data rules to populate those fields with the URL and access code
upon publishing your document.

3. Add both Salesforce fields to your Salesforce email template. These fields will be
automatically be populated when you create your Salesforce email.

Salesforce: Using the Incoming Data Tool

The Incoming Data tool lets you select the fields from Salesforce you want to have
available in your Conga Collaborate documents.

Conga Collaborate’s integration with Salesforce allows you to leverage the power of CRM
data in your Conga Collaborate documents. The Incoming Data tool lets you select the
fields from Salesforce you want to have available in your Conga Collaborate documents.

Our Salesforce integration allows you to select fields from as far down as grandchild
objects of your launching object, as well as a maximum of five levels up from the launching



object. Going five levels up the object hierarchy is the maximum that Salesforce allows for
data accessed through the API.

Using Salesforce fields in your documents streamlines document creation by reducing
editing time, eliminating errors from manual copying of information, and enforcing usage of
standardized content that reps can quickly get out the door.

Permissions Needed: Conga Collaborate System Administrator
Feature Requirements: Salesforce Integration

1. From your user dropdown, go to Administration > Integrations > Salesforce > Edit.

2. Scroll down to Incoming Data.

3. Under Incoming Data, select the object from which you will be launching Conga
Collaborate documents.

4. All the fields on that object will appear; click the checkboxes for the fields you want
to have available. This is called mapping fields.

5. Click Save.

6. You can also map fields from objects related to the launching object. For example, if
you choose Opportunity as your launching object, the following fields will be
available:

- All fields that live on the Opportunity object

- All fields on objects related to the Opportunity through a lookup field (Account,
Opportunity Owner, etc.). You can go a maximum of five levels up the object
hierarchy using this method.

- The Opportunity’s child objects (Opportunity Line ltems, Opportunity Contact
Roles, Quotes, etc.).

- The Opportunity’s grandchild objects (Quote Line Items, etc.). To get to
grandchild objects, you will need to first select the child object (like Quotes), and
then select the grandchild object.

7. Click Save on every object that you are selecting fields from before moving on to the
next object. After clicking Save, a dropdown will appear with all the fields you have
mapped, organized by launching object.

If you make changes in your Salesforce org data structure, make sure to update the
Incoming Data field mappings in Conga Collaborate to reflect any changes you have
made.

Some examples of mapping changes you may need to make:

If fields were removed from your Salesforce org that were mapped to Conga Collaborate,
make sure to delete those mappings in Conga Collaborate in order to avoid document
creation errors.



If the APl names for fields have changed in your Salesforce org, make sure to re-map those
fields in Conga Collaborate.

Considerations for Incoming Data and Salesforce Permissions

Salesforce field-level security permissions are extremely important to think about as you
are mapping incoming data to Conga Collaborate. Any Conga Collaborate user who
generates a document from Salesforce must have view or edit permission to any Salesforce
field mapped to their document’s template in the incoming data area. For that reason, as
you are mapping incoming data, you can choose to map fields to all templates, or you may
find it beneficial to map fields to only specific templates that a specific user set is using,
thus eliminating the need to possibly alter field-level security permissions in Salesforce.

Salesforce: Using the Outgoing Data Tool

The Conga Collaborate Outgoing Data tool allows you to push information back into
Salesforce. Outgoing Data rules can be triggered by system events and automatically
make field updates on any editable field on your Salesforce launching object.

Outgoing Data removes manual steps by automatically updating fields on your Salesforce
launching object. This allows you to reduces Salesforce management time and mitigate
user error. For example, you might update the Opportunity Stage to Closed Won upon
document acceptance.

Create an Outgoing Data Rule

Go to Administration

Integrations

Salesforce

Edit

Scroll down to the Outgoing Data section.
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Select the Conga Collaborate event that you want to trigger the update of your
Salesforce record. These events take place within Conga Collaborate and include:

- Created

- Publish

- Accept

- Decline

- Create New Version

- Finalize Version

- Ask a Question

- First View

- Formstack Form Submission



- Email Sent
- Request Approval
- Void

7. (Optional) Select a template. If you do not select a template, the rule will trigger for
all templates when the Conga Collaborate event criteria is met. If you do select a
template, the rule will only apply to the selected template.

8. Select the Salesforce object and field you want to receive your data. Use the first
drop-down menu to select from every editable Salesforce object in your account. After
you select an object, you can select any editable field that lives on that object.

9. Select the Conga Collaborate dynamic data that will map to the assigned field, or
define a static value to be used every time.Depending on the data type of the
Salesforce field you select, different dynamic Conga Collaborate values will be
available to push to Salesforce. See the Available Objects for Outgoing Data section
below for a more detailed explanation.

10. Click Add to finish creating the rule.

Available objects for Outgoing Data

Outgoing Data can update fields on your launching object and the Octiv Document object.
It cannot update fields on parents of your launching object or children of your launching
object.

When selecting the Octiv Document object, look for its APl name, tinderbox__Document__c.

Additionally, Conga Collaborate can use Outgoing Data to push back a PDF or Word file of
a Conga Collaborate document to the standard Notes & Attachments Llist on a Salesforce
record (described in the example below).

Example Use Cases

Update the Closed Date of an Opportunity when a document is
accepted

A common use of Outgoing Data is to update the closed date of an Opportunity based
upon document acceptance. Follow these steps to update the Closed Date of an
Opportunity:

Select Event: Accept.
Select the appropriate Template.
For Object, choose Opportunity.

Hw N —

For Field, choose Close Date.



5. For Value, select Proposal Field - Proposal: Closed At (DateTime).
6. Click Add.

Attach the PDF or Word file of a Conga Collaborate document to a
Salesforce record

If using the standard Notes & Attachments object, you can push the PDF or Word file of a
Conga Collaborate document as an attachment to a record in Salesforce. Once the rule is
triggered, the file will be added to the Notes & Attachments related list on the record.

This feature is not compatible with Salesforce Files.

In this example, we will push a document’s PDF to an Opportunity when the document is
created:

Select Event: Created.

Select the appropriate Template.

For Object, choose Attachment.

For Field, choose Body.

For Value, select Proposal Field - Proposal: PDF.
Click Add.
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Update the Status Field on the Document record when an email is sent

In some use cases, it is helpful to see in Salesforce when a user sends an email from the
Collaborate Document. In this case, you can set the value of the document Status field in
Salesforce to a value that indicates that an email was sent from the document.

Select Event: Email Sent.

Select the appropriate Template.

For Object, choose tinderbox__Document__c.
For Field, choose Status.

For Value, enter Email Sent.

Click Add.
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Salesforce Data Types

Every field in Salesforce has an associated data type that defines the type of data that
must live in that field. In order for Outgoing Data to work correctly, the data you are
sending from Conga Collaborate must match the data type of the field in Salesforce. To
assist with this, Conga Collaborate displays the data type of the field you are choosing to
update when configuring Outgoing Data.



When you select a Salesforce field in Outgoing Data, Conga Collaborate displays all of
the available pieces of information of that data type that can be sent back into
Salesforce. Alternatively, you have the option to define a static value to be sent back to
Salesforce.

For example, if you choose a Salesforce field that holds a double (a type of number field),
Conga Collaborate does not have any pieces of dynamic document information stored as
data type double, so your only option would be to record a static value to send back. If,
however, you choose a Salesforce field that is of type string, then Conga Collaborate has
multiple document fields that can be pushed back to Salesforce. You can define a static
value in this scenario as well.

Below is a list of all dynamic Conga Collaborate document fields that can be sent back to
Salesforce, along with their compatible data types:

Strings (compatible with any Salesforce fields that use strings)

- Proposal: ID

- Proposal: Public URL

- Proposal: Build URL

- Proposal: Name

- Proposal: Status

- Proposal: Template Name

- Proposal: Owner

- Proposal: Access Code

- DocuSign: Envelope Data URLDates (compatible with any Salesforce date fields)

- Proposal: Closed At (DateTime)

- Proposal: Published At (DateTime)

- Proposal: Expires At (Date)

- Proposal: Created At (Date)

- Proposal: Updated At (Date)Attachments (compatible with the Attachments object in
Salesforce)

- Proposal: PDF

- Proposal: Word

Microsoft Dynamics

Integrate online Collaborate documents with Microsoft Dynamics.



Microsoft Dynamics: Assigning an Object from Build
View

You don’t have to leave Conga Collaborate to associate a document with a Microsoft
Dynamics object such as an Opportunity, Lead, or Account.

Follow these steps to associate an Opportunity with a document:

From the document, click the Properties tab

Scroll down to Microsoft Dynamics Opportunity and click Search

In the pop-up window, use the search bar to find your Opportunity

Click the appropriate Opportunity

Click Assign (you will receive a notification that the Opportunity is associated with
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your document)
6. Click the Refresh Variables button in the Variables tab to associate the information
from that Opportunity

Microsoft Dynamics: Associating a Record to a Conga
Collaborate Document

Once your integration is set up, you can associate your MSCRM record (Account,
Opportunity, Lead, Contact) to your Conga Collaborate documents without leaving Conga
Collaborate.

Instructions on how to associate your Dynamics record with a document:

1. From the document, click the Properties tab

2. Scroll down to Dynamics Opportunity and click Search

3. You can select your Account, Opportunity, Lead or Contact on the right drop-down
menu

Use the search bar to find your record

Click the record you want

Click Assign (you receive a notification the record is associated with your document)
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Click Refresh variables in the variables tab to associate the information from that

record

Microsoft Dynamics: Creating Auto-generated Tables

The most commonly used workflow involves launching documents from within a Dynamics
CRM Opportunity. For this reason we recommend building your table in a template and



then launching from an Opportunity in order to test. Alternatively, you can connect an
Opportunity to your document within Conga Collaborate and then build your table there.*

Most clients choose to launch their Conga Collaborate documents from Opportunities. By
default, Opportunities have an OpportunityProduct child object, which is what we use in our
example pricing table below.

Creating an Auto-generated Table

This basic pricing table will work if you are using the standard fields in Dynamics CRM.
Use the following steps to create an auto-generated table.

1. Create a table that has three rows and as many columns as you need.

2. Define the table as a Pricing Table by right clicking over the table and going to Table
Properties >> Class >> Pricing Table.

3. Define the table Header by right clicking On the first row and going to Row >> Row
properties >> Row type >> Header

4. Follow the same procedure as in step 3 to define the third row as the Footer. Choose
Row Type >> Footer

5. Choose the Data Source for your table

- Click on the gear icon in the upper right corner of the table to open the Pricing
Table Data Settings
- Select OpportunityProduct as the Data Source and click Save

6. Type your column headers into the first row (in the sample table below in black
highlighting with white text)

7. In the middle (body) row, place the fields you want in square brackets (below in light
blue); it is very important that these values match exactly with the APl names used
by Dynamics CRM. To find the correct field names, go to

- Account Settings >> Integrations >> Dynamics

- Scroll down to the Incoming Data section

- Copy the field names into the square brackets of your table exactly as they
show in the saved list

- If you don’t see the field you are looking for, it may require mapping to Conga
Collaborate.

8. If you want a totals row, use the table footer (below in green). Conga Collaborate
allows aggregator functions to be used in each column of the footer. Syntax is:
[FUNCTION_NAME(variable_name)]

- If you want to use SUM, as in the example below, simply change out the
variable being summed to match the variable you are using



- Cells can be set to show data in a certain format; right-click on the cell and go

to Cell >> Cell Properties >> Class and choose your desired format
9. Optional: Sort the order of the line items in the table.

- Click on the gear icon in the right-hand corner of the table to open the Pricing
Table Data Settings

- Choose the value you want to sort by from the Sort By drop-down menu

- Click Save

10. Optional: Filter the line items that will populate the table based on the value of a
field from Dynamics CRM.

- Click on the gear icon on the right-hand side of the table to open the Pricing
Table Data Settings

- Click Add Filter

- In the Variable drop-down menu, choose the variable you would like to filter by

- Choose your desired operator from the Operator drop-down menu

- Enter the value to which you would like to compare your variable

- Choose a data type that matches the type of the value to which you are
comparing

- You see the encoded expression in the Expression field

- Click Save

Microsoft Dynamics: Enabling Attachments

You can pull whatever files you’ve put into your Notes & Attachments section of an
Opportunity, or other MS Dynamics object, into your Conga Collaborate proposal. After you
move them, these files appear as Attachments to your document. They're updated when
you click Refresh Variables.

Only a system administrator can enable this function.
Follow these steps to add Microsoft Dynamics attachments to your account capabilities:

From your Account Settings view, click Integrations.

Choose Microsoft Dynamics.

Scroll down to Manage Features.

Click Attachments.

From the drop-down menu, click the checkbox next to Enable Attachments
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- You can specify which files you want to be pulled into your proposals by
specifying a pattern (for example, .pdf) in the File Name Pattern field - if you
don't set parameters, all files are pulled as attachments



Microsoft Dynamics: Integrating with Conga
Collaborate

Connecting your Conga Collaborate account with Microsoft Dynamics enables you to build
data-driven proposals using opportunities, leads, or contacts. With this integration, you can
drive data into a proposal using objects in Microsoft Dynamics, and you can associate
content with products in order to create a proposal quickly.

Essentials for Integration

To prepare to integrate your Conga Collaborate account with Microsoft Dynamics, have
the following ready:

- Your Microsoft Dynamics credentials
- The Conga Collaborate Managed Package ZIP file
- Read access of Conga Collaborate Org Settings

Connecting your integration

Use these steps to connect your Conga Collaborate account with Microsoft Dynamics:

Log into your MS Dynamics account

Click Microsoft Dynamics CRM at the top left of the screen, then click Settings
Click Solutions

Click Import

Choose the Conga Collaborate Managed Package ZIP file

Click Next > Import (this will take a few moments to set up)
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When setup completes, click Close
There is no need to download log files

After installation, we recommend you refresh the page so you receive all of the correct tabs
along the ribbon.

Configuring your integration

Use these steps to configure your two accounts:
From within MS Dynamics:

1. Return to your Dashboard
2. Click the Advanced Find Function



3. From the pop-up window, select Conga Collaborate Org Settings in the Look For
drop-down Llist

4. Click the red exclamation point

5. Click new Conga Collaborate Org Settings

6. In the pop-up window, enter your full Conga Collaborate account URL (i.e., https://
companyname.octiv.com)

7. Click Save

8. Open the Dynamics ribbon and go to Conga Collaborate. You now have a full Conga
Collaborate menu, including Settings, Library, and Tracking
From within Conga Collaborate standalone:

9. From your user dropdown, go to Administration > Integrations > Dynamics > Edit

10. In the Microsoft Dynamics Configuration section, enter your organization name, user
name, and password

1. Click Save

12. Click Integrations in the menu on the left, then click Dynamics

13. Click Activate to activate your Dynamics integration

Sandbox environments are currently supported for this integration. If you are interested in
setting up a Conga Collaborate sandbox to connect to a sandbox MS Dynamics org,
please contact Global Support for assistance.

Microsoft Dynamics: Managing Data

The Incoming Data tool makes it easy to select which fields from Microsoft Dynamics you
want to have available in your Conga Collaborate documents. Use the Outgoing Data tool
to push information from Conga Collaborate back into Microsoft Dynamics. You can set
this to trigger according to a number of different events and to push data into any editable
field within your Microsoft Dynamics account.

Incoming data

Use these steps to select all of the fields you wish to pull into Conga Collaborate
documents:

From your Account Settings view, click Integrations
Click Microsoft Dynamics
Scroll down to Manage Data
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Select the entity that you will use to launch Conga Collaborate documents from the
Select Launching Entity menu
5. Select an object, and all possible fields show up
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6. Check off the fields you would like to have available in your Conga Collaborate
documents and save them before you move on to another object

- A list of Referenced Fields also pops up to the right and enables you to select
fields from connected entities (for example, the user or account that owns the
Opportunity).

- Be sure to click Save on every entity that you are selecting fields from before
moving on to the next entity.

- After clicking Save you see a record of each field, organized by launching entity
in the drop-down List.

Any variables you need in your Conga Collaborate documents display when you click your
launching object in the variables list. If you have multiple objects in your list, only the
variables of the object from which you created your Conga Collaborate document will be
available.

If you have configured variables from multiple objects in your CRM settings, you may see
more variables available in your template than are available in your created document.

Remember: Use only variables that are listed directly under your launching object in your
Conga Collaborate CRM settings. For example, if you have configured variables to pull in
with the Account and Opportunity as launching objects, then only the variables listed
under your Opportunity object will be available in Documents created from your
Opportunities.

Outgoing Data

Any information you're sending needs a place to land in Microsoft Dynamics, so be sure the
field you are trying to push data into exists on the entity you've selected.

To configure this tool, follow these steps:

1. From your Account Settings view, click Integrations
2. Click Microsoft Dynamics
3. Select the Conga Collaborate event you want to trigger updates of MS Dynamics
entity records - you may select

- Publish

- Accept

- Decline

- New Version

- Ask a Question

- First View

- Formstack Form Submission



- Email Sent
4. Select Microsoft Dynamics and choose from the drop-down menu of every updatable
Microsoft Dynamics entity in your account
5. Select the field you would like to send the information to
6. Select the Conga Collaborate data you want to map to the assigned field or specify
the value to set in Microsoft Dynamics
7. Click Add to finish creating the event

Example Use Cases

Using the Outgoing Data Tool, you can push a PDF of a published proposal back as an
attachment to the Opportunity. Once triggered, the PDF will show up on the Attachments
related list on the Opportunity.

Follow these steps to push a proposal PDF to an Opportunity as an attachment:

1. Select the Event—most likely Proposal Publish, New Version of Proposal, or Accept
Proposal

2. Choose the Attachment object and then the Body field

3. You see a Proposal: PDF option. Click Add

Reporting

Use Conga Collaborate Reporting to discover, analyze, and take action on real-time sales
data.

Introduction to Conga Collaborate Reporting

Conga Collaborate Reporting is a way to discover, analyze, and take action on real-time
sales data. Conga Collaborate Reporting delivers the information you need to make data-
driven decisions faster. With this powerful platform functionality, you can spend less time
reporting and more time driving business forward.

Key Capabilities

- View Standard Reports: Choose from commonly used sales reports.

- Filter Reports: Analyze data by time frame, by document type, and more.

- Exporting Reports: Export and share reports in a CSV.

- Mobile: View reports on a mobile device for anytime, anywhere decision
making.Common Use Cases



Conga Collaborate Reporting can be used to analyze and report on real-time data. Here
are just some of the common use cases: Document Engagement Report: What deals are
more likely to close? Template Usage: Is the sales team using our templates? Page Usage:
What content is used most and least? User Report: How effective are my sales reps?

Navigate to Conga Collaborate Reporting

From your Conga Collaborate Dashboard, click on the “Reporting” tab. You'll see the
Conga Collaborate Reporting Dashboard, where you find standard reports.

Standard Reports

Out of the box, Conga Collaborate comes with access to reports that have already been
built out for you and your team. Conga Collaborate’s ability to track content usage,
customer engagement and effectiveness of sales content at the aggregate and user level
provides quick, easy access to essential information on your team’s success.

- Document Engagement: A Llist of all recently viewed sales documents.

- Template Activity: See which templates are being used and viewed the most.
- Page Activity: See which content has the most customer engagement.

- User Activity: See a list of recent user activities.

- Background Jobs: See a list of recent errors.

Each standard report includes pre-built filters to analyze data by time frame and
document type and downloaded offline. You'll find these options at the top of each page.

Standard Conga Collaborate Reports

Conga Collaborate Reports provide you with information on current Documents,
Templates, Content, and Users in your account.

Document Activity Report

You can track information from all documents created within a Conga Collaborate
environment. This report delivers a comprehensive view of document information including
timestamps for creation, publish and last view for all document types.



Document Engagement Report

You can track information from your documents that have been engaged by recipients. In
this report, all of your documents that have been viewed by at least one recipient will be
displayed with related analytics. You can see when documents were created, published,

and last viewed.

Template Activity Report

You can track information from Templates. Under the Templates reporting tab, you will
have a comprehensive view of all your Templates. Because this report displays Close Rates
for Templates, you will be able to identify which Templates are the most effective. Options
include:

- Number of CRM Ids: Shows the count of unique CRM IDs for the selected time period.

- Users Creating Documents: Shows how many users (count of the unique user ids)
created documents using this template during the selected time period.

- Value of Documents Created: Shows the sum of the value of documents created using
this period during the selected time period.

- Value of Documents Published: Shows the sum of the value of documents published by
template during the selected time period.

- Value of Documents Accepted: Shows the sum of the value of documents accepted by
template during the selected time period.

- A new row for documents created without a Template will be displayed at the
bottom of the report for the selected time period.Page Activity Report

The goal of the page activity report is to provide visibility into which content is being used
the most, and which content is viewed the most by document recipients. You can see the
page, the last view, the total number of views, how many individual viewers, and total time
spent viewing.

User Activity Report

You can track data about your account users. This report is based off all of your users, even
those that are deleted. This effectively allows you to view your most active and efficient
users. With the recent updates, we have added the following the following columns to be
selectable in this report:

- Average Time to publish (published_at - created_at)
- First Document Crection Date

- Email

- Mobile



- Company

- Title

- Address

- City

- State

- Zip
To view and select columns to be included in your report, click on the All Columns drop
down.

Background Jobs Report

The goal of this report is to provide increased visibility into the errors associated with the
documents in your account.

Report Export

You can quickly export a report to be viewed and shared offline. To export a report, simply
click the download button (download is a CSV file).

Report Filters

Filters can be helpful in improving the view's initial performance by reducing the amount of
data the report returns by default.

Each standard report includes pre-built filters to analyze data by time frame and
document type and downloaded offline. You'll find these options at the top of each page.
Below are some available filters:

Document Filter: This filter allows you to display All Documents in the account, OR select
Proposals, Presentations or Contracts. It will be set to All Document by default.

Date Filter: Select a specific date range if you want to refine the data shown. You can filter
the reported data by:

- Today

- Yesterday

- Last 30 Days

- Last 60 Days

- This Month

- Last Month

- Set a Custom Date Range



Tracking activity through the reporting feature

Click on the Reporting tab from your Conga Collaborate Dashboard to see activity reports
for the documents, templates, and users in your Conga Collaborate account.

Some options that may be helpful include:

Document filtering - a dropdown menu on the top right enables you to display all
documents or to sort by proposals, presentations, or contracts.

Proposal tracking - find all your proposals, their analytics, and details including: client,
status, value, views, owner, published date, and last viewed date.

Template tracking - find out which of your templates are working hardest for you with
data including close rate, number of documents created from each template, number of
times published, number of views, and number of documents accepted.

User activity - find out who's doing what—and with which documents. The User reporting

tab provides analytics for all users, including those who have been deleted. Within it you
find each user’s number of documents created and published, number of views, number of
documents accepted, and close rate.

Time breakdown - a dropdown menu on the top right enables you to look at data from the
past 7, 30, or 60 days.

Want to grab a report of this data? Download it as a CSV file by clicking the Download
button on the top right.

Advanced Usage

Advanced usage and functionality of Conga Collaborate.

Adding lightboxed images to documents

iLightBox lets you and your clients see full-size images without leaving your document. You
place an image thumbnail that the user clicks to bring up a full-size image, overlaid on the
current page. The lightbox also enables users to scroll through any other images that are
lightboxed on that page.

Use the steps below to lightbox an image in your document:

1. Within your document, place your cursor where you'd like the image thumbnail to
appear.
2. Click the Content tab.



3. Click Images.

4. From the image gallery that appears, drag and drop the image you want into the
content editor window.

5. Select the image and click the Image button in the editing toolbar.

6. Copy the URL from the Source field, and click Ok to close the window.

7. Right-click the image.

8. Click Insert Link in the editing toolbar.

9. Add your copied URL to the URL field, deleting the ? and everything that comes after

it. Your URL should now end with the image file type: .png, .jpg, and so on.
10. Click the dropdown arrow next to Class and select Enable Lightbox.
11. Click OK.

Advanced search in Conga Collaborate

A step beyond simple Title, Author, and Date filters, Advanced Search enables users to
combine multiple layers of search criteria relating to document type; date of expiration,
creation, or update; status; and content keywords.

The Advanced search tool gives you access to field by field specific searches and allows
you to combine multiple attributes into more complex statements.

Anytime you need to search on multiple document or content attributes, the Advanced
search tool makes it easy to add or remove criteria, gives you insight into all available
search criteria, and allows you to easily select and/or define the values you want to search
on.

To use the Advanced search tool:

Click Advanced to the bottom right of the search bar.
Select the attribute you want to search on (tag, name, client, etc.).
Select the operator. Available options vary depending on attribute type.

N~

Select the values you to want to search for or type in the text you want to find.
a. Optionally, add additional search criteria by clicking the + button. Criteria can
also be removed by using the - button.
b. Choose your Match criteria: All, Any, or None
5. Click Search.
6. Click on hyperlinks throughout the user interface, or type them into the advanced
search bar with a colon after the filter (for example, author: Jane Doe).



Assigning manager and report roles

System Administrators can set up the User Relationship Hierarchy for their users. Doing so
defines users as either Managers or Reports and sets the visibility of users’ private
documents in Conga Collaborate, giving them access only to documents that pertain to
them, their managers, or their direct reports and filtering out documents they don’t need to
see.

Here's the breakdown of who can do what after they're assigned a role:

- Managers can filter the Dashboard and Document List by their Reports by searching
for the document owner.

- Reports do not have visibility to managers’ private documents if they are in a
Standard User role.

- Everyone can see public documents in the documents List.

- A Manager can see a Report's documents, even those set to Private.

- A Report can have multiple Managers, and Managers can have multiple Reports.

These steps pertain to clients using Conga Collaborate’s default Roles and Permissions. If
you are using custom Roles and Permissions, things may be a little different.

Use these steps to configure the User Relationship Hierarchy:

From your user drop down menu, click Administration.

Click Users.

Choose the user you wish to set as a Manager or Report.

Click the Relationships tab.

Select users who will be Managers and Reports in the Manager and Report selection

o b~ w N~

boxes.
6. Click Save.

Auto-generated Content Data-Filter Attribute

Auto-generated Content Data-Filter Attribute
data-filter

If records in an array have fields that differentiate products with different criteria, data-
filter allows you to display only records that meet your criteria.

Example Use Cases:

- A table should only include one-time fee products (Product Family = Setup Fee)
- A table of food items should only include fruits (Product Family = Fruit)



- A table should only include items whose prices are greater than $1,000 (UnitPrice >
1000)Syntax: data-filter="field_name LIKE ‘value"value: a user-defined value that you
use to set up your filter criteria

data-filter is almost always used with a data-source. Here is example HTML in context
with data-source:

<table data-source="OpportunityLineltems" data-filter="field_name LIKE 'value™>

This will set up a table that only includes Opportunitylineltems records with a
field_namevalue of 'value'.

*Note: data-filter can be used on most HTML elements that include a data-source, but it is
important to note that within a standard auto-generated table, data-filter will not work
on the <thead>, <tbody>, or <tfoot> elements. It can be used on the <tr>element within
those parent elements, but not on those three elements themselves.

Consider this example, where we can see how the table output changes when data-filter is
used to only display products with the family of Fruit.

Output:

Without data-filter:

Product Name Product Family Total Price
Apple Fruit 1.0
Carrot Vegetable 2.0
Pear Fruit 3.0

With data-filter:

Product Name Product Family Total Price
Apple Fruit 1.0
Pear Fruit 3.0

HTML:



<table data-source="OpportunitylLineltems" data-filter="PricebookEntry.Product2.Family
LIKE "Fruit™> <thead> <tr> <th>Product Name</th> <th>Product Family</th> <th>Total
Price</th> </tr> </thead> <tbody> <tr> <td>[PricebookEntry.Product2.Name]</td>
<td>[PricebookEntry.Product2.Family]</td> <td>[TotalPrice]</td> </tr> </tbody></table>

Auto-generated Content Data-Format Attribute

Auto-generated Content Data-Format Attribute
data-format

The data-format attribute allows you to adjust the way dates are displayed in auto-
generated content. In order for data-format to work, the content must first be classed as
class="date" or class="datetime". In an auto-generated table this class can be added using
Cell Properties, otherwise it will have to be done in source code.

Syntax: data-format="%d/%m/%y"where the order of d, m, and y can be changed
according to your preferences.

In addition to changing the order of month, day, and year, using a capital Y will display the
full four digit year, whereas lower case y will only display the last two digits. The letter A
will display the day of the week written out (i.e. "Thursday"), while the letter B will display
the month in written out form (i.e. "July").

Examples:

<td class="date" data-format="%-m/%-d/%Y">[ExpirationDate]</td>Output:
7/7/2017<span class="date" data-format="%Y-%m-%d">[CreatedDate]</span>Output:
2017-07-07<p class="datetime" data-format="%A, %B %-d, %Y">[ModifiedDate]</
p>QOutput: Thursday, July 7, 2017

Auto-generated Content Data-Group-By Attribute

Auto-generated Content Data-Group-By Attribute
data-group-by
data-group-by allows you to show roll-up summary informaction of a group of records.

Syntax: data-group-by="field_name"Aggregator functions are used to access the summary
data of the records grouped by data-group-by[SUM(field_name)] - sums value of
field_name in each record in a group[COUNT(field_name)] - counts the number of
field_name entries in a group

Example Use Case: Sum total price of OpportunitylLineltems records by Product Family



In the example use case above, if we don't use data-group-by, the SUM function will display
the sum of all products together. Consider the table below, where the Total Price for Apple
is $1, the Total Price for Carrot is $2, and the Total Price for Pear is $3.

Output:

Without data-group-by:

Product Name Product Family Total Price
Apple Fruit $6
Carrot Vegetable $6
Pear Fruit $6

Because there is no data-group-by attribute, the SUM function displays the total sum of all
the products and does not split out based on Product Family. In addition, because the result
of the SUM function gets treated as a value associated with each product in the array, it
gets repeated for every product in the table. The HTML can be seen below.

HTML:

<table data-source="OpportunityLineltems"> <thead> <tr> <th>Product Name</th>
<th>Product Family</th> <th>Total Price</th> </tr> </thead> <tbody> <tr>
<td>[PricebookEntry.Product2.Name]</td> <td>[PricebookEntry.Product2.Family]</td
<td>[SUM(TotalPrice)]</td> </tr> </tbody></table>

Adding the data-group-by attribute solves this problem by telling Conga Collaborate to
only sum products that have the same Product Family. This also keeps the summed total
from being displayed more than once.

A quick note: We have removed the Product Name column from the table below because
data-group-by does what its name implies - it groups the entries and only makes one table
entry per group. The Product Family Fruit (which can be thought of as a group) has two
products associated with it, so normally there would be two entries in the table. However,
because we are using data-group-by and grouping by Product Family, there will be only
one entry in the table for the Product Family Fruit. Therefore there will only be one Product
Name entry (and missing the other), so we remove it from the table.

With data-group-by:

Product Family Total Price



Fruit $4

Vegetable $2

HTML:

<table data-source="OpportunityLineltems"> <thead> <tr> <th>Product Family</th>
<th>Total Price</th> </tr> </thead> <tbody> <tr data-group-
by="PricebookEntry.Product2.Family"> <td>[PricebookEntry.Product2.Family]</td>
<td>[SUM(TotalPrice)]</td> </tr> </tbody></table>

Auto-generated Content Data-Locale Attribute

Auto-generated Content Data-Locale Attribute
data-locale

This attribute has been deprecated by the Proposal Language feature. It is maintained here
for documentation purposes.

If you would like to format your data based on standard country formats, use the data-
localeattribute. This attribute is used in conjunction with auto-generated content classes.

Syntax: data-locale="value"value: the operator value that determines the country format.
Values supported: en-AU, en-EU, fr, ni, pt-BR

Example HTML:
<tr> <td class="datetime" data-locale="fr">[CreatedAt]</td></tr>

<tr> <td class="money" data-locale="fr">[TotalPrice]</td></tr>

Auto-generated Content Data-Repeat Attribute

Auto-generated Content Data-Repeat Attribute

The data-repeat attribute repeats the HTML element it is placed on for every child record
you are looping through. As it loops through the child records, you can access field values
specific to each of those individual records.

Syntax Overview

Place the syntax below into the HTML element you want to repeat.

data-repeat="variable_name in object_name"



variable_name: user-defined name for a record in the object array, or list of child records

object_name: an object array from a data source (such as OpportunitylLineltems in
Salesforce)

For example, to repeat a <div> element over OpportunitylLineltems, it would look Llike:
<div data-repeat="product in OpportunityLineltems">

To access and display the field values in your document, use the following syntax:
[variable_name.FieldName]

FieldName: the variable name of the field you want pulled into the document as defined in
the Incoming Data section of your Collaborate-Salesforce integration

For example, consider an array of five Widgets. Each of these Widgets has specific fields
such as Name, Description, and Price. To access these fields for each Widget in the array of
Widgets, set up the following HTML:

<div data-repeat="widget in Widgets__r"> <p>[widget.Name]</p>
<p>[widget.Description]></p> <p>[widget.Price]</p> </div>

"widget in Widgets__r" defines the generic record widget within the array Widgets__r.

Widgets__r (the Salesforce APl name for Widgets) tells Conga Collaborate which object
array to loop through, and the [square brackets] let Conga Collaborate know to evaluate
the text within the brackets as variables. The format [widget.FieldName] is the proper
notation for accessing fields that live on records in the array. Each time you use
[widget.FieldName], you are only looking at one specific record in the array.

In the example above, the data-repeat would repeat the Name, Description, and Price five
times, once for each Widget. As data-repeat implies, Conga Collaborate repeats through
the array looking for the next Widget each time through. The first repeat begins by looking
at the first widget in the array and accessing its Name, Description, and Price. Then the
second repeat looks at the second widget in the array and accesses its Name, Description,
and Price, and so on through the fifth widget in the array.

Consider another example where a Salesforce Opportunity has four products on it, named
Bronze, Silver, Gold, and Platinum, and we want to display the Product Name for each
product in an unordered list.

<p><strong>Product Name:</strong></p> <ul> <li data-repeat="item in
OpportunityLineltems">[item.PricebookEntry.Product2.Name]</li> </ul>

The output displays as:
Product Name:

- Bronze



- Silver
- Gold
- Platinum

- Data-Show-If/Data-Hide-If Attributes
Auto-generated Content Data-Show-If/Data-Hide-If Attributes

Data-Show-If/Data-Hide-If Attributes

Auto-generated Content Data-Show-If/Data-Hide-If Attributes
data-show-if/data-hide-if

These attributes allow a user to show or hide blocks of content in a document based on
meeting criteria defined in the attribute’s statement. The attribute is inserted within the
HTML element that you want to conditionally display.

Syntax: data-show-if="variable_name <operator> 'value“variable_name: the Collaborate
variable name of the field you want to evaluateoperator: the method by which you want
to compare your variable_name and valuevalue: a user-defined value that you compare
with the value of your variable_name

Valid operators in Conga Collaborate:

Operator Definition
= Equals

I= Does not equal

> Greater than

>= Greater than or equal
< Less than

<= Less than or equal
LIKE Contains

NLIKE Does not contain

IS BLANK Value is blank



Operator Definition

IS NOT BLANK, IS PRESENT Value is not blank

The following example shows the HTML necessary to make a paragraph visible when the
Proposal Location contains Los Angeles. In all other cases, the paragraph will hide.

<p data-show-if="proposal_location LIKE 'Los Angeles">Show this text if the Proposal
Location contains Los Angeles</p>

Remember that the value of the statement is case-sensitive. If the true value of the
proposal_location variable is 'Los Angeles' but instead we entered 'los angeles'in our
statement, the logic statement would return false and the content would hide.

These attributes can also be used within any HTML element, but is particularly useful
within <span> elements in order to conditionally display information within other elements.

Table cell example:

<td><span data-show-if="Opportunity_Contract_Term__c == 6">*</
span>[PricebookEntry.Product2.Name]</td>

This HTML allows us to show the asterisk only if the Contract Term = 6.

When rendered in the document, it will look like this:




Auto-generated Content Data-Source Attribute

Auto-generated Content Data-Source Attribute
data-source

Syntax: data-source="object_name"object_name: the name of the object from which you
want to pull data (such as OpportunityLineltems in Salesforce).

The typical use case for the data-source attribute is within an auto-generated table,
sometimes referred to as a pricing table. The HTML structure for a pricing table can be seen
below:

<table data-source="object_name"> <thead> <tr><th>Field</th></tr> </thead> <tbody>
<tr><td>[FieldName]</td></tr> </tbody></table>

Note: FieldName is a placeholder for the name of the variable from which you want to pull
data; replace FieldName with your desired variable.

For example, the table below lists the Product Name and Total Price for every Product on
an Opportunity in Salesforce.

Output:
Product Name Total Price
Apple 1.0
Carrot 2.0
Pear 3.0
HTML:

<table data-source="OpportunityLineltems"> <thead> <tr> <th>Product Name</th>
<th>Total Price</th> </tr> </thead> <tbody> <tr> <td>[PricebookEntry.Product2.Name]</
td> <td>[TotalPrice]</td> </tr> </tbody></table>

The data-source attribute tells Conga Collaborate where to pull data from. In this case, it
looks at OpportunityLineltems. The [square brackets] tell Conga Collaborate to evaluate
the text within the brackets as variables within the object array. This table pulls over both
Product Name [PricebookEntry.Product2.Name] and Total Price [TotalPrice]. Apples, Carrots,
and Pears are the products on the Opportunity.



Auto Generated Content Overview

This article summarizes different functions you can place in source code to generate

content from a data source and perform actions on that auto-generated content.

This article summarizes different functions you can place in source code to generate

content from a data source and perform actions on that auto-generated content. The

table below summarizes the auto-generated content attributes themselves, when you

might use them, and where you can use them. Click on an attribute to jump to the article

that details the attribute's syntax, possible use cases, and example code snippets

demonstrating its use.

Attribute

data-source

data-group-by

data-filter

data-show-if data-

hide-if

data-repeat

data-format

Use Case

Specify location from which to
pull data

roll-up summary data by
grouping specific records

filtering data by a user-defined
criteria

Showing/hiding data based on
some user-defined criteria

looping through a number of
records in an object array

formatting data

HTML elements you can use it on

<table> Elements with data-show-if
or data-hide-if to access field
values within an array

<table>; <tr> (within pricing table)
Elements with data-repeat
attribute

<table>, <tr>, <tfoot>; <div>; <p>
Elements with data-repeat
attribute

AWl HTML elements Elements with
data-source (including auto-gen
tables and data-repeat blocks)

Any HTML element that you want to
display array content

Anything within an auto generated
content block (data-repeat, tables
with data-source, etc.)



Attribute Use Case HTML elements you can use it on

data-locale deprecated - reference for
historical documentation
purposes

Math expressions can also be evaluated with auto-generated content. For more
information, reference this article.

Syntax for Using Attributes

The syntax for all auto-gen content attributes can be seen below, where the placeholders
are replaced with the actual names desired by the user.

<attribute>="<variable_name> <operator> '<value>"Example: data-show-
if="PricebookEntry.Product2.Name LIKE Test"

Details on each component:
- <attribute>: Auto-generated functionality as defined in the table above.

- <variable_name>: The name of the variable used in the comparison statement.

In the case of the data-repeat attribute, the <variable_name> is actually an
arbitrary loop iteration variable that you define.

- <operator>: The part of the statement that allows for a comparison to occur, such as
==, |=, or LIKE.

<operator> is not used in the data-sort, data-group-by, or data-source
attributes.

- <value>: The value to which the <variable_name> is compared using the <operator> .

<value> is not used in the data-sort, data-group-by, or data-source attributes
<value> is an array name in the data-repeat and data-source attributes.

Variable Syntax for Auto-Generated Content

Conga Collaborate searches for [square brackets] in order to identify a variable that will
pull auto-gen content into the document. Because of this, every variable you want to
access must be surrounded by a set of single open and closed brackets.

Example using an auto-generated table:



<table data-source="object_name"><thead> <tr><th>Field</th></tr></thead>
<tbody><tr><td>[FieldName]</td></tr></tbody></table>

Advanced Conditional Logic Statements

Configure conditional logic statements from scratch, directly within a page’s HTML source
code.

Conditional logic statements can be applied to any HTML element in your document, but
the point and click Collaborate user interface only supports inserting a conditional <div>
block. To create statements on other HTML elements, you will need to insert them directly
into source code.

HTML Overview

<div>Some content to display here</div>

HTML is the standard structure that makes up the skeleton of all content on the web. All
HTML elements are contained within a set of < > carats. Any text inside the carats is not
visible to the user when the HTML is rendered. The text outside of those carats will be
displayed. In addition, each HTML element has an opening and closing tag. Opening tags
use only < > carats, while closing tags use </ >. AlL HTML is simply made up of elements
that are called out using pairs of tags. Each element has rules that govern how it displays
on the page and how it interacts with other HTML elements.If you want to learn more
about HTML, here are some good references:

- HTML Overview
- A Detailed HTML Overview
- HTML Introduction

HTML as used with conditional logic statements in
Collaborate

In the context of Collaborate and writing conditional logic statements, you can write
statements manually in the Source Code of your document. Access Source Code by going to
Edit > Source Code in the editor toolbar.

You'll Likely see something Llike this in your document HTML:

<div data-show-if="proposal_client = '"ABC Company™>


https://www.tutorialspoint.com/html/html_overview.htm
http://ithare.com/a-detailed-html-overview/
https://www.w3schools.com/html/html_intro.asp

This is a <div> element that has a conditional show statement inserted on it. To compare to
the Ul editing experience, this is what would be entered into source code automatically
when you insert a conditional content block using the Conditional Content option on the
editing toolbar. The dashed blue box surrounding your content represents the data-show-
if="" or the data-hide-if=""in the source code.

Using the Collaborate Conditional Content tool will only insert <div> elements with
conditional statements; however, conditional statements can be applied to any HTML
element. Other useful examples include (but are not limited to):

- Paragraph <p>

- Table <table>

- Table Row <tr>

- Table Cell <td>

- Ordered List <ol>

- Unordered List <ul>
- List Item <li>

- Span <span>

<span> is especially useful for inserting conditional logic on content that is within any
other HTML element. Whereas <div> and <p> (among others) are block elements that take
up the entire line inside the container, <span> is an inline element and therefore is allowed
to be on a line with other HTML elements.

<span> example:

<p>Direct any inquires to the <span data-show-if="Opportunity_Region == 'North">North</
span><span data-show-if="Opportunity_Region = 'South™>South</span> region manager.</
p>

When rendered in the document, it will look like this: [

Then when the document is previewed or published, the proper word will display based
upon the value of the Opportunity_Region variable.

Writing Conditional Logic Statements in Source Code

Once you identify the element(s) you want to put conditional logic statements on, refer to
Data-Show-If/Data-Hide-If Attributes for a detailed breakdown on how to write these
statements in source code.

It is also possible to string multiple Llogic statements together to create a complex logic
statement. To do this, you can insert multiple ANDs or ORs between each collection of a
variable, operator and value. However, you cannot use ANDs and ORs together in the same
complex statement. For example, these statements are valid:



<div data-show-if="proposal_client = '"ABC Company' OR proposal_client = 'XYZ
Company™><div data-show-if="proposal_client = 'ABC Company' OR Opportunity_Industry
='Tech' OR Opportunity_Industry == 'Aviaton™><div data-show-if="proposal_client = 'ABC

Company' AND proposal_owner = 'John™>
But these statements are not:

<div data-show-if="proposal_client = '"ABC Company' OR proposal_client = 'XYZ Company'

AND proposal_owner = 'John"><div data-show-if="proposal_client = 'ABC Company' AND

Opportunity_Industry = Tech' OR Opportunity_Industry == 'Aviaton™>

ANDs and ORs are case sensitive and must be capitalized. This differs from writing
conditional logic statements for including sections and pages, where these must be lower-
case.

If your use case requires a combination of ANDs and ORs, consider enabling and using Logic
Groups. If not enabled in your account, you will need to contact support.

Document scripting overview

Conga Collaborate’s Document Scripting is the language you use to write conditional
statements, substitute strings, and perform calculations with variables.

This article is maintained for legacy purposes only. All clients should be utilizing the
Modern Variables feature, which provides a modern, point-and-click interface for
formatting variables. If this feature is not enabled in your account, please contact Conga
Global Support.

Conga Collaborate’s legacy document scripting language allows you to write conditional
statements, substitute text strings, and perform calculations with variables.

Being able to format your variables is important for the look, feel, and design of your
document. Document scripting allows you to, among other things, remove unnecessary
decimal places, display links as images, and format currency variables with the proper
currency symbols. In addition, math operators allow you to perform basic operations on
your variable data and display the results, all within Conga Collaborate.

- Format variables using method statements.
- Perform basic math functions.

Document scripting requires entirely lower case variables, even if the variable would
normally have capitalized letters. Ex: { { Opportunity_Name } } would
be { { opportunity_name } } when used with document scripting.



Conditionally Display Sections and Pages

Conga Collaborate administrators can create pages and sections in templates and
documents that conditionally display based on specific criteria. The conditional logic
builder provides a simple point-and-click interface that enables you to build your logic
statements without code. Conditional sections or pages can leverage document variables,
CRM variables, or survey form variables in their logic statements.

If you are using the newest logic feature, Logic Groups, see Logic Groups Basics.

Conditional sections and pages provide Conga Collaborate admins with a way to ensure
that content is present in a document only if it is needed, thus eliminating user error and
speeding up document creation time.

For example, many Conga Collaborate administrators want pages in a template that will
show only if a prospect is purchasing a specific product or if a proposal is for a specific
scenaurio, like a client renewal. In that case, they may create a page that uses conditional
display logic based on Opportunity Line Item data or an Opportunity variable coming from
a Salesforce Opportunity record.

In your template or document, hover over the section or page in the Table of Contents.

1.

2. A gear icon will appear. Click the gear icon and select Edit Properties.

3. Click Include Logic > on the Section or Page properties.

4. Use the first drop-down to select the variable that will be evaluated.

5. Use the second drop-down to select an operator. A large humber of operators are
supported, and they vary based on your variable’s data type.

6. Use the third drop-down to define a value as the operand.

7. Click Save.

Example Statements:

Variable Operator Value
proposal_name (Document Variable) contains Renewal
Opportunity_Type (Salesforce Variable) equals New Customer
Opportunity_Account_Industry (Salesforce | not equal Finance

Variable)



Page Properties
Options
Include Logic

Include Logic Opportunity_Type X equals New Customer
Repeatable

PDF Settings

» Show Advanced

When building show/hide logic statements using CRM variables, you must use variables

that are related to your launching object. For example, when launching from an
Opportunity but using the Industry field on the Account object, you need to use the variable
that gets mapped from the Opportunity up to the Account, Opportunity_Account_Industry.

Logic-Based on Child Object Data

Some Conga Collaborate administrators may want to write logic statements that are not
based on fields on the launching object, but instead use fields from a child object of the
launching object, such as Opportunity Line ltems present on an Opportunity in their CRM. In
this case, the fields are treated as a data array filled with key value pairs. If a child object
is selected in the variable drop-down, additional logic builder fields become available

Child object logic example:

Variable Operator A Record Where Equals
OpportunitylLineltems | contains PricebookEntry.Product2. | Services
Family

In this example, this page or section would show if any of the products in the Opportunity
Line Items on the Salesforce Opportunity record have a product family equal to “Services.”



Page Properties
Options
Include Logic
Include Logic OpportunityLineltems X contains

Repeatable PricebookEntry.Product2.Family

PDF Settings Services

» Show Advanced

Advanced Conditional Section and Page Logic

Admins can use the Show Advanced option in the logic builder to write more advanced logic
statements with other operators or AND/OR statements. Statements written in the
advanced builder must be all lowercase, with the exception of variable values, which are
case sensitive.

Examples:
opportunity_region__c == 'Northeast' or opportunity_region__c == 'Midwest'
proposal_name.include?("Octiv Document”) or proposal_client.include?("Octiv Client")

opportunity_amount >= 1000 and opportunity_type == 'New Customer' or opportunity_type
=='Renewal

If you added or changed logic to conditionally display a section or page in a generated
document (not a template), you will need to refresh your browser or go to the Integrations
panel and click Refresh Variables and CRM pages in order to see your changes take effect
in draft mode. Otherwise, your new logic statements won't be applied until you publish your
document.

Including Call to Action buttons

Call to Action buttons allow your document recipients to interact with your documents
online.

Call to Action buttons speed execution time of your documents by giving your recipients
easy ways to interact with the document while viewing it. There are several types of Call to
Action buttons that can be added to individual documents or templates in order to allow
different types of recipient interaction:



Accept: prompts the recipient to sign a document by using the configured eSignature tool -
Conga Sign, DocuSign, or the Conga Collaborate eSignature tool. When you add a recipient
to a document, you must also ensure they are marked as a "Signer” in order to allow them
to use this button. If configured with your eSignature tool, you will also be prompted to
enter a signing order.

Decline: enables the recipient to decline a document and include a comment as to why.

Ask a Question: gives the recipient a chance to submit a question or comment to the
document owner, who then receives the question via an email notification outside of Conga
Collaborate.

Add People: allows the recipient to forward a document to colleagues for viewing,
redlining, or signature. When you add a recipient to a document, you must also given them
permission to "Add People" for this button to work.

Change Request (contracts only): lets the recipient create a change request on the
contract and return it to the document owner or change request approver for review.

1. In the document or template you want to add buttons to, click the plus sign with a
dotted outline in the header of the document.

2. After clicking the button, you'll see a dropdown menu of button types. Use the Button
Label field to enter a button label, and then select the type of action you want your
button to perform.

3. Click Save.

To edit or delete a button you've created, hover over the button, and click the pencil icon in
the upper right corner. You will see a dropdown menu that enables you to edit or delete. A
document owner can also add or remove a Call to Action button after a document has
been published and sent and even viewed. However, a Call to Action button cannot be
added after document acceptance.

When sending a document to a recipient, you must also ensure that each recipient has the
correct permissions to use the buttons on the document.

A recipient must be marked as a Signer in order to allow them to use the Accept button on
a document. If your eSignature tool configuration allows it, you will be prompted to enter a
Signer Order as well.

A recipient must have the "Can add signers" or "Can add collaborators” permission in order
to use the Add People button and add additional viewers, redliners, or signers to a
document.

A recipient must have the "Can Redline" permission in order to use the "Change Request”
button (Contracts only).



Including post-acceptance content

You can choose to show sections of a proposal only after it has been accepted. You might
include a post-acceptance section in order to solicit information after signature—for
example, to collect payment information directly from the client.

Add post-acceptance content by following these steps:

1. From the Document or Template you wish to add this feature to, click the New Section
button in the Table of Contents panel to add a new section. You can also add the
post-acceptance feature to an existing section (just jump to Step 3).

Name your Section.

Hover over the Section you want.

Click the gear that appears right of your Section name.

Choose Edit Properties.

In the Section Properties pop-up window, click the checkbox next to Display section
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once document is accepted.
7. Click Submit.

Logic Groups Basics

Conga Collaborate Logic Groups allows Administrators to build complex Logic statements
throughout the application to show or hide content. You can build rules that apply to an
entire page, or a specific section of a page.

If you are using the previous version of Logic Groups, see Hiding or showing content in
Sections and Pages: Logic Builder.

To setup a logic condition

From your user dropdown, go to Administration and select Logic Groups.

1.

2. Click +Create.

3. Select a display name. For example, value is greater than 5000.

4. Select an attribute name. This value is used by the API to store the rule in the page.
For example, value_gt_5000.

5. Click Add Rule.

6. Under Logic Rules, Click +Click here to select a field and select the variable you want

to base the rule on in the Field Selector. For example, click on Document and under
Field, select proposal_value.Only mapped CRM fields will be displayed in the tool. For
instructions on mapping CRM fields, reference Using the Incoming Data Tool.



26.
27.
28.

Back under Logic Rules, select the operator values from the dropdown menus beneath
the field you've chosen. For example, select Greater than and choose a value of 5000.
You can click the evaluate variable value checkbox if you want the logic rules to
compare a variable to another variable.

Click Create. To enable a logic condition on a page in the Table of Contents:

Open your document.

. In the Table of Contents, select the gear icon next to the page you want to edit.
. Select Edit Properties.

. Select Include Logic.

. Under Include Logic, select Show if or Hide If.

Under Logic Group, select the name of the Logic Group you created.

. Click Save. To enable a logic condition on a page section in the Table of Contents:
. Open your document.

Select the gear icon next to the section where you want to apply the condition.

. Select Edit Properties.

. Select Include Logic.

. Under Include Logic, select Show if or Hide If.

. Under Logic Group, select the name of the Logic Group you created.

. Click Save. To Insert a logic condition on a specific content within a page:

. Open your document.

. In the Insert dropdown menu, select Conditional Content.

. Select the gear icon that appears on the top right side of your conditional content

block.

Under Showing, select Show if or Hide if.

Under Logic Group, select the name of the Logic Group you created.
Click Save.

Conga Collaborate API

Conga Collaborate is proud to offer a RESTful APl which gives anyone the ability to

automate and embed functionality into their own application, manage users, and trigger

additional workflows. You can use the interactive APl documentation to test out API

requests without writing any code. To access the APl documentation and interface,

append /api to the end of your Conga Collaborate URL.Example: mycompany.octiv.com/api


http://mycompany.octiv.com/api

Offline Change Requests

In Conga Collaborate, you have the ability to take your online change requests offline into
Microsoft Word.

This is a BETA FEATURE and not generally available at this time

In Conga Collaborate, you have the ability to take your online change requests offline into
Microsoft Word. If you don’t see the feature in your account and are interested in finding out
if your team would be a good fit for this Beta program, reach out to your relationship
manager for more informaction.

How do | complete an offline change request?

In Conga Collaborate

- From a published contract (internally or externally published), navigate to the
Versions Tab and select “New Change Request”

- In the drop-down that appears, choose “Make Offline Changes”

- A download of the current version of your document will automatically begin

In Microsoft Word

- Open up the downloaded file

- Make any desired changes to the file

- You'll notice any changes reflected in the right-hand margin of the document and
underlined

- Save the file

In Conga Collaborate

- Return to the online document

- Click “Choose Files” located under the cancel change request button

- Select the updated Word file

- From here, the change request approver will be able to accept and reject changes
just like an online Conga Collaborate document, then submit it as a new version

Performing basic math functions

The following table shows you the right operand for various functions you're likely to use in
Document Scripting.



Operand Name

+ Addition

- Subtraction
* Multiplication
/ Division

e Power

% Mod

&& Boolean and
and Boolean and
or Boolean or

< Less than

! Not

Example

2+2

2-2

2*3

1274

2**10

12% 9

true && false

true and false

true or false

ltrue

Result

1024

false

Boolean or | true || false | true

false

true

Greater than |2 > 3 | false

false

Using Document Scripting to perform basic mathematical calculations is fairly

straightforward. Here are a couple of examples.

Input

{2+2}

{{ proposal_value.to_i * 10 }}

{{ proposal_valuel.to_i +
proposal_value2.to_i}}

Output

value*10

valuel + value?2

Notes

All of the operands are valid here.

Check out the methods article to

find out more about using .to_i.

Check out the methods article to
find out more about using .to_i.

Convert any proposal_value to an integer prior to performing any math functions with the

value.



Document scripting method statements

Conga Collaborate Document Scripting allows you to manipulate the formatting of

variable data within a document.

This article is maintained for legacy purposes only. All clients should be utilizing the

Modern Variables feature, which provides a modern, point-and-click interface for

formatting variables. If this feature is not enabled in your account, please contact Conga

Global Support.

Conga Collaborate document scripting method statements allow you to format variables

in a document.

For an overview of document scripting, reference the Document scripting overview article.

Being able to format your variables is important for the look, feel, and design of your

document. Document scripting allows you to, among other things, remove unnecessary

decimal places, display links as images, and format currency variables with the proper

currency symbols.

The following table summarizes supported method statements, their descriptions, and

examples of how to use them. To see more detailed explanations and examples for each,

scroll down to it's corresponding detail section.

Document scripting requires entirely lower case variables, even if the variable would

normally have capitalized letters. Ex: { { Opportunity_Name } } would be

{{ opportunity_name } } when used with document scripting.

Method

as_img

as_iframe

to_i

Description

Takes a URL and displays
the image found at that
URL

Takes a URL and displays
the content found at that
URL in an iframe

Forces a number to
display as an integer.
Always rounds down

Example

{{image_variable.as_img}}
where image_variable
contains a URL for the
image

{{url_variable.as_iframe }
MWhere url_variable
contains a URL for the
content to display within
the iframe

{{number_variable.to_i}}
where number_variable =
1000.0

Result

Image displayed

Content displayed
within the document

page

1000



Method Description Example Result

to_f Forces a number to {{number_variable.to_f}} 1000.0
display as a float. A where number_variable =
single decimal place is 1000

added to the number.

to_url Takes a string and turns {{url_variable.to_url } } https://getconga.com
it into a hyperlink where url_variable =
https://getconga.com

number_to_curr | Displays numbers with {{number_to_currencg(num $1,000.32
ency currency formatting ber_variable)}}where
number_variable = 1000.32

to_formatted_d | Displays a date variable | {{date_variable.to_formatt | 5/5/2018

ate with the selected ed_date("%-m/%-d/%Y")}}
formatting applied where the date is May 5,
2018
as_img

Using as_img tells Conga Collaborate to interpret and display the variable value (which
must be a publically accessible image URL) as the image itself instead of the URL text. CSS
inline style modifiers can also be added to adjust height, width, etc.

Example Result

{{image_variable.as_img } }where image_variable | Image displayed
contains a URL for the image

{{ image_variable.as_img('style" => 'height: 30px; Image displayed with height and width of
width: 30px;) } } 30px

{{image_variable.as_img("style" => 'width: Image displayed with width of 15%
15%; } }


https://getconga.com
https://getconga.com

as_iframe

Using as_iframe tells Conga Collaborate to pull the content located at the URL into an
iframe within the document. For example, you want to display a form within a Conga
Collaborate page, so you pull it into the page using as_iframe. CSS inline style modifiers
can also be added to adjust height, width, etc.

Example Result
{{ url_variable.as_iframe } }Where url_variable Content displayed within the document
contains a URL for the content to display within the | page
iframe
{ { url_variable.as_iframe('style" => 'height: iframe height set at 300px
300px;) }}
to_i

When using to_i, a number variable is displayed as an integer instead of a float. All
decimal points are removed and the number always rounds down.

EXAMPLE Result
{{ number_variable.to_i } }where number_variable = 1000.0 1000
{{number_variable.to_i}}where number variable = 100.67 100
{{"23"to_i}}this statement makes Conga Collaborate interpret the 23

string “23” as a number

number_to_currency

By default, Conga Collaborate displays CRM currency values as floats. Using
number_to_currency allows you to format these values using currency symbols. In addition
to simply converting a number to a currency format, number_to_currency has several
additional attributes. These are described below:

EXAMPLE RESULT

format as currency{{number_to_currency(number_variable)}} $1,000.32
where number_variable = 1000.32



EXAMPLE RESULT

change the currency £1,000.32
unit{{number_to_currency(number_variable, :unit=>"&pound")}}

change the $1.000.32
delimiter{{number_to_currency(number_variable, :delimiter=>"")}}

change the currency unit and ¢1.000.32
delimiter{{number_to_currency(number_variable, :delimiter=>"/, :u

nit=>'¢)}}

change the number of decimal $1,000.3

places{{number_to_currency(number_variable, :precision=>1)}}

Using an apostrophe as the delimiter

This is a special case because Ruby (the language that document scripting methods are
based on) uses apostrophes as part of its own parsing process such that an apostrophe
cannot be used without using an escape character. In Ruby, the escape character is a
backslash \. The syntax looks like this:

EXAMPLE RESULT

{ { number_to_currency(number_variable, :delimiter=>"\") } } $1'000.30

ALl number_to_currency attributes can be combined into one statement if desired

to_formatted_date

This method provides several options for formatting date variables. Using a combination of
m, d, y, A, and B, you can display the date in numbers or in words.

Using %-m or %-d will only display one digit as appropriate, while using Yom or %d will
always display two digits

EXAMPLE RESULT
{{date_variable.to_formatted_date("%-m/%-d/%Y") 7/7/2017

{{date_variable.to_formatted_date("%Y-%m-%d") 2017-07-07



EXAMPLE RESULT

{{date_variable.to_formatted_date("%A, %B %-d, Thursday, July 7, 2017
%Y")

Setting up page-by-page acceptance

Rather than requiring an entire document to be accepted, you can select pages or sections
of your document to be accepted with the recipient’s signature. Only pages that are
accepted will appear in the Signed PDF.

You will want to first set up this feature in your document'’s sections. If your section
properties don't match those of the content pages, you'll get an error message. So if a
section is set up as All Content Must Be Accepted, you need to set up each page within it to
Require Acceptance or Allow Acceptance.

Follow these steps to set up acceptance for your document sections:

From the Build view of your document, hover over a section in your Table of Contents.
Click the gear icon that appears.
From the dropdown menu, choose Edit Properties.
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In the pop-up window, choose the Acceptance properties you want. Those options are:
- Disable Content Acceptance for This Section
- Any Acceptable Content In This Section Is Optional
- Require Only One Content To Be Accepted
- Require At Least One Content To Be Accepted
- Require All Content In This Section To Be Accepted
5. Click Submit.

Follow these steps to set up acceptance for individual pages of content:

1. In the Table of Contents panel for your document, hover over the page of content you
want.
2. Click the gear icon.

w

From the dropdown menu, choose Edit Properties.

4. In the pop-up window, choose the Acceptance properties you want. Those options are:
- Content can't be accepted
- Require Acceptance for Overall Proposal Agreement
- Allow Acceptance with Overall Proposal Agreement

5. Click Save.

After you select your acceptance options, your client will have the option to select a box
next to the pieces of content that are open for acceptance in your published proposal.



Updating variables in documents

You can easily make sure your document is up-to-date by refreshing the CRM variables you
pulled from a third-party source such as Salesforce.com or Microsoft Dynamics. After a

refresh, you can see which variables have been added or deleted from version to version.

Use these steps to refresh your CRM variables and pages:

1.

If the document is already published Create a new Version, if the Document is in a
Draft state continue to step 2

Click the Variables Tab

Click the Refresh Variables button. All of the variables within your document will
update

Using iFrames to Embed Content

You may need to use iFrames to embed some forms of content into your Conga Collaborate

documents. You can use iFrames with any secure link—and only a secure (HTTPS) link—so

that we can keep all of your content secure.

Here’s how you do it:

1. Copy the HTTPS URL of the content you want to embed.

Place your cursor at the spot in your document where you want your embedded
content to appear.

Click Edit in your document’s editing toolbox.

From the dropdown menu, choose Source Code.

A pop-up Source Code window appears. Place your cursor before the first character in
the HTML code, and hit Enter twice.

Move back to the top line of the window and type: <iframe width="100%"
height="500px" src="

Copy/Paste HTTPS URL.

After the HTTPS URL, type: ” /

Click Ok.

. From your document’s Table of Contents, toggle the Preview switch to On. Your

embedded content appears. If you decide to move the content, turn Preview to Off,
and drag the iFrame to its new position.


http://Salesforce.com

Using Math Expressions in Auto Generated Content

You can perform mathematical operations on fields in any single table cell within an auto-
generated table or on fields in a data-repeat block. Conga Collaborate only understands
math operators within the context of auto-generated content, and as such all math
expressions must be within [square brackets]. Operators that are supported are: + - */

Examples:

- To calculate Total Price: [ListPrice * Quantity]
. To calculate sales tax: [SUM(TotalPrice) * .07]

As a best practice, Conga Collaborate does not recommend performing
mathematical operations within Conga Collaborate itself if you are using a CRM.
These calculations should be performed within the CRM and the results simply
displayed in Conga Collaborate. This allows your CRM to be the source of truth for
your data.

Here is an example pricing table that uses math expressions:

Product Name Product Family Price Quantity Total Price
[PricebookEntry.Prod | [PricebookEntry.Produ | [UnitPrice] [Quantity] [UnitPrice *
uct2.Name] ct2.Family] Quantity]

With preview turned on:

Product Name Product Family Price Quantity Total Price
Apple Fruit $500 2 $1,000
Carrot Vegetable $2,000 7 $14,000
Pear Fruit $2,500 4 $10,000

Using variables in Conga Collaborate

Variables can be used within a document to display dynamic content. Conga Collaborate
allows you to use out-of-the-box document variables, CRM variables, and form variables.
(CRM and form variables require integrations with a CRM and Formstack, respectively.)



Using Standard Document Variables

Conga Collaborate provides standard variables that are populated by filling out fields in
the Properties panel of your document, under Details. Available variables include such
information as document title and document value as well as document owner information
like name and phone number.

Follow these steps to insert standard variables into your content:

1. In your document’s Build view, click the Properties panel.

2. Fillin the fields you want to include (i.e., Client, Value, Description, etc.) under
the Details section.

3. Add variables to your document.Click the Content panel, then click Variables. You will
see a dropdown list called Document which contains all the standard variables
available in your document, as well as the current value of those variables.Drag and
drop the variables into your content.You can also type the “%"” sign in your document
to pull up a list of variables while creating content. As you type the variable name
after the “%" sign the list of variables will be filtered to match your desired
variable Variables inserted into a document while in draft mode appear as the
related field name surrounded by a set of {{double brackets}}.This behavior is
different if you have Modern Variables enabled. See the Modern Variables section at

the end of this article for more information.

Preview or publish to see the actual data

Creating Custom VariablesYou might want to use custom variables in a Template,
meaning any documents created from that Template will also have those custom
variables. Using this feature enables your users to fill out information to customize their
documents. Custom variables can also be added to generated documents.

Follow these steps to create custom variables:

1. In your template or document'’s Build view, click the Content panel.
2. Click Add New, and then select Add New Variable.
3. From the pop-up window that appears, fill in these variables:
- Name is actual name of your variable and appears in {{curly brackets}} when
inserted into a document in Build view.
- Value shows in place of the variable name when the document is previewed or
published.
4. Click Submit. A new Custom dropdown in the Variables panel houses your custom
variables, which you can drag and drop into your content as with any other



variable. To edit a custom variable, hover over its title, click the gear that appears,
and click Edit. You can then change the variable’s value.

Previewing Variables in a Document or Template

Before you turn on Preview within your document, your variables appear in {{double curly
brackets}} or [single square brackets] that look like

this: {{variable_name}} or [variable_name]. Using Preview mode, you can preview them to
see what they'll actually look like when you Publish your document.

Toggle the Preview switch in the Table of Contents panel to On, and your variables will be
replaced by the values they hold. If you want to preview CRM variables, make sure that
you are connected to an Opportunity or other CRM object.

If you want to edit your document, turn Preview to Off.

Refreshing Variables

If you're using any of Conga Collaborate’s CRM integrations, you need to refresh the
variables in your document after any updates to information in your CRM.

Follow these steps to refresh your variables:

1. After you edit data in your CRM, open the connected document in Conga Collaborate.

2. Make sure Preview is switched to Off. Otherwise the Refresh Variables button won't
appear.

3. Open the Integrations panel.

4. Click Refresh Variables. The data from your CRM updates all of the dynamic sections
and content in your document.

To refresh some content pages, such as those added from the Conga Collaborate Content
related list in Salesforce or the automatically generated Quote and Product Pages, you
need to click the arrow to the right of the Refresh Variables button and click “Refresh
Variables and CRM Pages.” This will actually delete and re-generate those pages in order
to display the new values.

When working on a template, you must disconnect it from your CRM object record by
deleting the ID and refreshing the page. Then re-connect the template by adding the ID
back in. This allows variables to be refreshed.

Modern Variables

This feature allows users to see the value of variables instead of seeing the variable name
appear inside of {{curly brackets}}. The value of the variable will appear with a yellow



background to differentiate it from standard text in a document. If a variable doesn't have
a value, it will be populated with No Value:

With Modern Variables, you are able to change the format in which a variable will display.
When you click on a variable (highlighted in yellow), a menu appears that shows the value
of the variable. Clicking the carat (>) opens a second menu that lets you select the data
type of the variable.

Each data type has different formatting options available, summarized below:

Data Type Formatting Options

String Text Case - Normal, Uppercase, Lowercase
Image Width, Height

Link Text to display

Iframe Width, Height

Date Display format (1/1/11; 01/01/11; Jan. 1, 2011, etc.)
Number Unit, Delimiter, # of decimal places

For example, if you have a variable that should be formatted as US currency, you can
select “Number” as your data type and then enter a dollar sign ($) for the unit, a comma (,)
for the delimiter, and a two (2) for the number of decimals you would like displayed.

Webhooks

A webhook is a user-defined callback over HTTP. You can use Conga Collaborate webhooks
to notify your add-on or web application when certain events occur in Conga Collaborate.
For example, you might want to alert your remote application when a document has been
published or when a document has been accepted. Using a webhook to do this means that
your remote application doesn’t have to periodically poll Conga Collaborate (via the REST
APIs) to determine whether changes have occurred.

A webhook in Conga Collaborate is defined by the following informaction, which you need to
provide when registering (i.e. creating) a new webhook:

- the URL where the callback should be sent
- the Content type, Conga Collaborate supports JSON, XML, and Form Encoded



- the Trigger to post to the URL, for example, document.create would post to the URL
whenever a new document is created

Keeping your systems in sync

Webhooks keep your application up to date as events are happening in Conga Collaborate
so all of your systems can stay in sync; they:

- Allow you to utilize the power of Conga Collaborate Document Generation while
allowing your users to stay within your own system

- Can trigger additional workflows or notifications to your internal team based on
events happening within Conga Collaborate

- Allow you to build a bi-directional application which was only previously possible
with Conga Collaborate Owned st party integrations (Salesforce, MS Dynamics)

Registering a webhook

1. Navigate to the Conga Collaborate administration console > User Dropdown >
Administration > Webhook

2. Click Add Webhook

3. Enter the details for your new webhook in the form that is shown

4. Click Save to register your webhook

PDFs

Use PDF files with Conga Collaborate.

Adding Page Numbers to Your PDFs

System administrators can add page numbers to PDFs through Theme Builder.

To add page numbers to a PDF

From your Drop Down User Menu (your avatar), click Account Settings.
From the menu on the left, click Themes.

Choose the theme you have established.

Click the PDF tab from the menu on the right side of the screen.
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Scroll down to Header or Footer, depending on where you want your page number to
appear.



6. Select the arrow above the Left, Center, or Right placement option, depending on your
choice.
7. From the pop-up that appears, click the Print tab and select Page Number.
8. Click Save.
Annotations

Annotations are markups made on a PDF such as text, drawings, shapes, images, or

comments. Annotations must be turned on by Conga Collaborate

To annotate a PDF
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Upload the file to the Content Library
Drag the file to the table of contents
Select the gear icon next to the page name
Select Annotate - this will reload the page and you will see a new editor appear atop
the document
Click on the pencil icon to activate the annotations mode
- Your document will open in full-screen view to give you more space to annotate
- Use the annotate options on the left to markup your drawing
- Once you are done click on the x icon to exit out (the annotations will save on
their own)
After exiting you will see a banner saying that the page is reloading
You will see the annotations you made on the embedded pdf
Download your document (select PDF download) and your annotations will be
included in the full document download

If you annotate a PDF file online the annotations will be included in your pdf.

Automatically populate a PDF with Web Merge

You can use Web Merge to automatically populate fields of fillable PDFs through Conga

Collaborate. Web Merge enables you to reference variable data from a document, CRM

platforms, and Formstack entries.

To upload and auto-populate a PDF

1.
2.

From your Account Settings view, click Web Merge from the left-side menu.
Click the Add Merge Document button.



3. Choose your PDF by using the search field or the Choose File button (the PDF must be
a fillable PDF).

4. (Optional) Check the box next to Flatten to prevent the PDF from being edited after
it's auto-populated.

5. (For Formstack-integrated accounts only) Choose the form that document owners
complete to populate information that isn’t available in the document or CRM
variables.

6. Click Save. You see a list of fillable fields from your PDF.

7. Select one of three Default Value Types next to each field.

- Use String to insert a single static value.

- Use Variable to reference a document, CRM, or form variable value.

- Use Condition to insert one of two static values based on an evaluation of one
or more variable values.

8. Click Save.

Use the Properties tab to add saved Merge documents to a Proposal template.

Document owners and recipients can find completed merge documents from the Download
Documents button in the Table of Contents.

Disable link display in PDF downloads

Conga Collaborate allows, at the Theme level, for URL Llinks to be hidden in PDF downloads.
This way you can create the same clean look in your downloadable documents that you
expect from Conga Collaborate’s online documents.

It’s increasingly common to include links to other material within documents, but URLs can
be clunky and lengthy when fully displayed. Our document users simply want to click once
and be taken where they need to go. To solve this problem we often create hyperlinks
within Conga Collaborate documents (i.e. “click here”), but this didn’t account for situations
where the PDF was being downloaded.

Conga Collaborate allows, at the Theme level, for URL links to be hidden in PDF downloads.
This way you can create the same clean look in your downloadable documents that you
expect from Conga Collaborate’s online documents.

To disable link display in PDF downloads:

1. From your user profile, select Administration, then the Themes icon
2. Select a theme to edit
3. Select the PDF section of the Theme editor and then check the “Hide link URLs” option



You must have permission to edit Themes for this feature, this permission is usually reserved
for Conga Collaborate Administrators.

Displaying content in web-only or print-only

You can customize PDF output in Conga Collaborate so that you hide content in the web
view and display it in the print view—or vice versa.

Customize Conga Collaborate pages or page content to display only in web view or only in
PDF download. Any page or content on a page can be configured for web-only or print-
only.

There are several use cases where you would only want the content to display in one of the
two scenarios. A couple of examples:

- Create a signature block that does not display until your document is downloaded to
PDF.

- Add an embedded video to a document that is hidden in PDF download in order to
remove the white space caused by the video container.

To Set Pages as web-only or print-only

1. In the document editor, click on the gear icon to the right of the page you want to edit.
2. Select Edit Properties.

3. In Display Options, select your desired setting.

4. Click Save.

To Set Page Content as Web-Only

The steps laid out in the next two sections work for Proposal-type documents. If you are
working in contracts, you will need to edit the source code in a content page and then add
that content page to your Contract-type document.

1. In the document editor, open the Edit dropdown and select Source Code.

2. Locate the HTML for the content that you only want to be displayed on the web.

3. Add a <div> element with a class of no-print around your content: <div class="no-
print">[web-only content]</div>

4. Click Save.
Set page Content as print-only

5. In the document editor, open the Edit dropdown and select Source Code.

6. Locate the HTML for the content that you only want to be displayed on the web.



7. Add a <div> element with a class of print-only around your content: <div class="print-
only">[web-only content]</div>
8. Click Save.

Mark a document as Accepted by uploading a signed
PDF

If your recipient opts to return a wet-signed PDF version of your document via email rather
than applying an e-signature to the on-line version, the PDF file can be used to move a
document from an Open state to Accepted.

Upload a signed PDF in order to mark a Collaborate document as Accepted.

If a client wants to sign through wet signature or your process is such that it requires
signing outside of Collaborate in any way, you will want to be able to mark the original
Collaborate document as Accepted in order to keep your records up to date.

Follow these steps:

Open the build view of a published document

Open the Properties panel

Click the Status dropdown at the top of the Properties panel

Select the option Mark as Accepted and Upload Wet Signature

In the Upload Signed Document modal, click Choose file

Select your signed PDF file that corresponds with the Collaborate document
Click Submit
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Your Collaborate document will now show a status of Accepted. In addition, the uploaded
PDF will be viewable within the Properties panel underneath the document status bar.
Finally, downloading the Collaborate document to PDF will now produce the signed PDF
that you uploaded in step six instead of the web version of the document.

Optimizing a PDF
We recommend the following practices to ensure the best-possible PDF output quality.

If you want your Conga Collaborate documents to be downloaded as PDFs, you can click
the Properties panel on the right-hand side of the page, click Options, and then click enable
PDF download. Once you have this option turned on, make sure they're looking as good as
they can. We recommend the following practices to ensure the best-possible PDF output
quality.



Page Breaks

Use the Content Editor to insert page breaks exactly where you want them to fall. (Just put
your cursor where you want the break and click Insert and then Page Break.) Doing so keeps
your content from running together in the PDF output and hard copy.

Web-Only or Print-Only Content

You can hide pieces of content from web or print versions. This comes in handy for hiding in
web view anything that requires a recipient to write in content—or for keeping video or other
content that you want only online from showing up in print versions.

PDF Background

Add design and branding elements to the PDF output of your documents by including a. PDF
background image. In the Theme Builder, upload an 8.5" x 11" png or jpg file at 150 DPI for
best results. Different images can be assigned to a document'’s cover page and standard
pages.

Photo Files

Upload a 3 MB photo into a proposal, and all 3 MB are downloaded within the PDF. Too
many big files can keep your proposals from downloading. We recommend keeping your
photo files under 500 KB so that your PDF sizes stay manageable.

Designate a page to be landscape or portrait

You can designate a content page to appear as landscape by hovering over the desired
page in the Table of Contents, and clicking the gear icon that appears. Once the page
properties modal appears, check the box that says Landscape Mode.

To use this functionality, Modern Document Size must be enabled for the account
(An administrator can enable this by going to Administration > Account Settings >
Checking the box next to Modern Document Size under Document Settings).

Advanced Table of Contents You can easily insert a table of contents into your Conga
Collaborate Proposals. This option enables your recipients to more easily navigate your
Proposal in a PDF format. To enable this feature, navigate to a template, select Properties,



select options, then click Enable Print Table of Contents. You have two options for Table of
Content type:

Sidebar generates a table of contents from the Sections and Pages in the sidebar.

Content generates a table of contents from the headings in the document content.

Sidebar Advanced Options

With the Sidebar PDF Table of Contents, you can include section titles, page titles, or both
in your PDF Table of Contents.

- If you do not want to include section titles and page titles in the PDF Table of
Contents, you can turn off those options within your document by navigating to that
particular section’s properties: Hover over the section, click the gear icon, and click
Edit Properties. Open the Table of Contents tab.

- If you un-check “include this section,” the section title no longer appears in the PDF
Table of Contents. Page titles from that section also no longer appear in the PDF
Table of Contents.

- If you check “include this section” and un-check “include all pages,” the section title
appears but page titles are excluded from the PDF Table of Contents.

PDF Table of Contents Properties do not affect which content is presented in the PDF
export-only whether or not the page title or section title is represented in the PDF Table of
Contents.

Selecting pages from a PDF

If you'd like to insert only certain pages from a PDF into a Conga Collaborate document,
you can do so by using our Page Select feature. The first step is to ask your account
manager to enable this feature.

To use Page Select

Ensure the PDF you want to insert pages from is in your Content Library.
From the Build view of the document you want, click the Content tab.
Click the down arrow on the top right to select Files.
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Drag and drop the PDF you want into your content, or the Table of Contents panel to
create a new page.

o

From the pop-up window, Click Select Pages.

o

In the new pop-up window, scroll through your PDF’s pages, clicking the check mark
for those you want.



7. Click Embed Pages. Your selected pages appear in your content. If you dropped your
PDF into the Table of Contents, you'll see them right away. If you dropped it into your
content, toggle the Preview switch On.

Setting up PDF page sizes and layouts

Size is no small matter when you're building just-right documents. You can shrink or expand
your PDFs to the size you want, or change the layout.

To change your PDF output

1. From your user icon click into Administration and then from the Administration page
click into Themes.

2. Select the Theme(s) you would like to update the PDF output for, if there are multiple
Themes you will need to repeat the steps for each theme.

3. Click the PDF tab from the right-side menu, it is the icon with the down-pointing arrow.

4. Under Page Sizes in the PDF window, click US-Letter (the default setting), and choose
the size you want from the pop-up window.

5. To change the layout of your PDFs, click Portrait (the default), and choose Landscape
from the pop-up window.

6. Click Save.

Using a PDF to create a presentation

You can use existing content from a PDF to build a presentation in Conga Collaborate. Use
these steps to start your presentation from any PDF.

From the Dashboard or your Documents view, click the Create button.

Select Presentation from the dropdown menu.

Within the Create a Presentation window, click the Choose Files button.

Select the PDF you want. The system gets to work, and a notification appears after
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your presentation has been built.
5. Find your new presentation in your Document List.

Presentations

Create Presentations in Conga Collaborate.



Adding and Editing Presentation Slide Content

You have a lot of options for bringing engaging content into your presentations.

You can add text, images, videos, and shapes.

To add text to a slide
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Click the Text icon at the top of the slide editor.
Click Add. An adjustable text box appears in your slide.
Click within the text box to insert a cursor and add your text.
Use the Properties tab on the editing toolbar to:
- Adjust the position of the item on the slide.
- Adjust the scale (size) of the item.
- Adjust the Z-Index (Layering order of each item displayed.
- Adjust the opactity (transparency) of each item.
- Adjust the alighnment of each item.
- Lock the ability of other users to edit an item.
Standard formatting options including font sizes and font family are also available
on the editing toolbar. Right-click the text box to quickly adjust its layering order on
the slide, expand it to the size of the canvas, or remove it. You can add an image that
appears in your Content Library.
To add an image, click the Image icon at the top of the slide editor.
Click Add.
From the pop-up window, search by name of the image you want or select it from the
preview panel.
Click to select the image you’d like to add.
Click Add. The selected image appears on the slide.
a. Click and drag any of the circular points along the border to expand the image
in that direction.
b. Hold the Shift key while dragging to maintain the dimensions of the image.
c. Click and drag the blue point just above the border to adjust the tilt.
You can also click the Properties tab on the editing toolbar to make the adjustments
to your image that we note in the Adding Text section. Right-click the image to quickly
adjust its layering order on the slide, expand it to the size of the canvas, or remove it.

. To add a video to your presentation, click the Video icon at the top of the slide editor.
. Click Add. A new video placeholder appears on the slide.
. Click to select the video placeholder. A Video URL entry field appears on the editing

toolbar.



13. Copy and paste your video’s URL from the source to the Video URL field. A preview
image appears in the placeholder.
a. Click and drag any of the circular points along the border to expand the
placeholder in that direction.
b. Hold the Shift key while dragging to maintain the dimensions of the placeholder
c. Click and drag the blue point just above the border to adjust the tilt.
You can also click the Properties tab on the editing toolbar to make the adjustments
to your video that we note in the Adding Text section. Right-click the placeholder to
quickly adjust its layering order on the slide, expand it to the size of the canvas, or
remove it.
Note: Video sources supported are YouTube, Vimeo and Wistia.
14. To add shapes, click the Shape icon at the top of the slide editor.
15. Click Add. A gray square appears by default.
16. Click on your shape to see an Editing Toolbar and change the shape or color.
a. Click and drag any of the circular points along the border to expand the shape
in that direction.
b. Hold the Shift key while dragging to maintain the dimensions of the shape.
c. Click and drag the blue point just above the border to adjust the tilt.
You can also click the Properties tab on the editing toolbar to make the adjustments
to your shape that we note in the Adding Text section. Right-click the shape to quickly
adjust its layering order on the slide, expand it to the size of the canvas, or remove it.

Adding Presentation Variables

Users can access their Document and CRM variables from the side variable panel. Simply
drag and drop or add desired variables within the slides.

Users no longer have to manually type in their variables in order to include dynamic
content within their presentations. They can now access their Document and CRM variables
from the side variable panel. Simply drag and drop or add desired variables within the
slides.

To Add Variables

1. Create a Presentation.

2. Click into a slide.

3. Open up your Variables tab.

4. Select the desired variable that you would like to add to your slide.



5. You can click on the “+"” button and add your variable. OR, you can drag and drop
your variables into your slides.

Adding slide transition effects in a presentation

Choose from six available slide transitions.

There’s more than one route from slide to slide in your presentations—in fact, you can
choose from six.

Use these effects to your advantage by following these steps:

1. Within the presentation, you'd like to edit, scroll through the Table of Contents panel
to find the slide you want to add a transition effect to.

Click on the gear icon that appears when you hover over the slide.

Click Edit Properties from the dropdown menu.

In the Slide Properties window that appears, choose Transition.

Hover over an effect to preview it; click to select.

Click Save.
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Adding Variables to Presentation Slides

You can easily add variables to your presentation slides.
Follow these steps to enter variables manually:

1. From the Build View, click the Text icon.
2. Click Add.

3. In the text box that appears, manually enter your variables.
Follow these steps add variables by using the Variables tab:

1. From the Build View, click the Variables tab.
2. In the Variables panel, you see categories of variables. Choose the category you
want to see the individual variables.
3. From the Variables panel, you can:
- Drag and drop the variable you want into your slide. The related formatting
stays intact.
- Click the plus icon to choose your variable. The variable lands where your cursor
appears in your slide.

Adjusting slide size in a presentation

You're not limited to one slide size within a presentation.



Here’s how to adjust the dimensions of an individual slide:

1. Within the presentation you’d like to edit, find the slide you want to resize in the Table
of Contents panel.

Click on the gear that appears when you hover over the slide.

Click Edit Properties from the dropdown menu.

In the Slide Properties window that appears, scroll down to Slide Size.

Choose a size, or create your own custom size.

Click Save.
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Download a Presentation to PowerPoint

Conga Collaborate allows the option to download your presentation documents to
PowerPoint.

Contact Conga Collaborate to enable this feature for your account.

Conga Collaborate allows the option to download your presentation documents to
PowerPoint. Once enabled, your Conga Collaborate Administrator can complete the initial
setup. Then, this functionality will be available for all users.

Conga Collaborate Administrator Initial Setup

Follow the steps below after this feature has been enabled
for your account

Open the Administration menu

Click Account Settings

Click the General tab

Under Download Formats, click to enable the Microsoft PowerPoint option
Click Save
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To download your presentation to PowerPoint

1. Open a Presentation template or document

2. Click the Properties tab

3. Scroll the Properties tab to the Document Options section
4. Click to enable the Allow PPTX Downloads option

Once these steps are taken, document owners and recipients will have the option to
download to PowerPoint by simply clicking the Download Document button in the Table of
Contents column.



Import Editable Presentations

You can import presentation decks and make each slide editable within Conga
Collaborate.

In order to do this, follow these steps:

1. Go to the Documents list and click Create > Presentation

2. Click Choose File (or Browse, if you are using Firefox) and select the presentation file
you want to import

3. Check the box next to Editable

4. Click Create

Conga Collaborate will then process your deck and prepare it for editing. Depending on the
size of your presentation, this can take several minutes. Once processing is complete, you
will be given a link to your editable presentation in the modal, an email will be sent to the
address associated with your user, and it will also be available in the Documents List.

Moving slides into a presentation

Pick and choose from a full PowerPoint deck to build your presentation by following these
steps:

1. Within the presentation you want to work from, click the Content tab from the menu
on the right.

Choose Decks from the dropdown menu.

Drag and drop the file you want into the Table of Contents panel on the left.

In the pop-up window that appears, click the Select Pages button.

Click to select each slide you want.
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Click the Embed Pages button. The slides appear in your Table of Contents.

Presentations overview

Use Conga Collaborate to share and track Presentations online. Create your presentations
from scratch in Conga Collaborate or upload an existing presentation.

You can use Presentations to:

- Upload a PowerPoint presentation to Conga Collaborate.

- Assemble an online presentation from uploaded slides.

- Deliver an online presentation via URL.

- Email a URL link to meeting participants and track attendees’ viewing patterns in
real time.



- Use presentation timers, speaker notes, and next-slide preview to stay on task during
live presentations.

- Receive real-time notifications when a prospect views a presentation or opens an
ematil.

- Track the time a recipient spends viewing each slide.

Follow these steps to create a Presentation:

1. From your Dashboard or Document List, click the Create button.

2. Click Presentations in the dropdown menu.

3. From the pop-up window, you can choose to start with a blank document, upload a
presentation file (ppt or .pptx) from your computer, or work from a template.

4. Click Create. Doing so takes you to the presentation Build View.

5. Add additional Slides to your Presentation by clicking Content in the top right menu
bar and dragging the desired slides to the Table of Contents panel on the left. You
can organize your slides by dragging them into the order you want in this panel.

6. Click the Properties tab to set your title, description, tags, and other properties of your
Presentation.

7. When it’s just as you want it, Publish your Presentation. (Edits are closed after you
Publish.)

8. Click the People tab to share this Presentation. You can use the Tracking feature to
find out who's looking—and for how long.

Presenter and viewer modes for presentations

Your options for Presentations are different depending on whether you're in Presenter or
Viewer Mode. The following sections outline what you can do when.

Presenter Mode

When you're the Presenter, you can share, track, and present a Presentation.
To share a published Presentation, you can:

- Copy, paste, and share the URL and Access Code.
- Click the People tab and then the Add People button.

Follow these steps to track a published Presentation:

1. Click the Track tab. A tracking data panel opens, and it includes:
- Number of views
- Last viewed by
- Time viewed



- Age
- An activity feed of updates, presentation dates, and so on
2. Click the View Full Report button to drill deeper into tracking informaction.

Follow these steps to present a Presentation:

1. Click the Next Steps tab.
2. Click the Start Presenting button. You see your current slide in the center panel. The
panels on the right and left give further detail about your presentation.

The right panel shows you

- A preview of the next slide in the deck.
- A timer, to help you keep on track as you present.
- Any slide-specific meeting notes you add.

The left panel enables you to jump to a specific slide. You can close this panel by clicking
the bookmark icon.

There’s also a bottom menu, from which you can see who is viewing your Presentation. You
also find the Stop Presenting button on the bottom Lleft of this menu.

Viewer Mode

When you're in Viewer Mode for a Conga Collaborate Presentation, you can use the bottom
menu to:

- Navigate through the slides.

- View thumbnails of all slides.

- Enter full-screen mode.

- Download a PDF of the Presentation.
- See who is viewing the Presentation.

Once the presenter kicks off the presentation, you lose the option to move through or
otherwise manipulate the presentation and can use the bottom menu only to see who is
viewing the presentation. When the presentation is over, you get your options back.

Presenting Decks in Draft State

Within the build view of your presentation, users now have the ability to present their decks
before the presentation is published. Being able to present pre-publish allows users more
flexibility for when they need to start presenting, and it allows users to make more
informed changes before they publish their decks.

How to Present in Draft State:

1. Create your Presentation.
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Add and edit your slides.

Click on the Next Steps tab.

Click on the Start Presenting button.

You will then be taken to your normal presenting modal.

Click on the Stop Presenting button to go back to the draft version of your
presentation.

Selecting slides for your presentation

You can add an entire deck—or just select slides—to your Presentation by following these

steps:
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In Build View for the Presentation you want, click the Content tab.

From the dropdown menu in the Content panel, choose Decks.

Drag and drop the Deck you want into the Table of Contents panel on the left.

In the pop-up Embed File window, click the Select Pages button. Your presentation
deck loads in the window.

Check the checkmark icon for the slides you'd like to include.

. Click Embed Pages. Your slides appear in your Table of Contents panel. Drag and

drop them to change the order.

Cloud Storage

Store online Collaborate documents in third-party Cloud Storage applications. Expand the

menu to the left and select a topic for more informaction.

Cloud Storage: Adding Cloud Attachments

The attachment link is always up to date with the most current version of the file on your

cloud platform. Deleting or moving a file from your cloud platform won't delete it from your

documents, however, so remember to remove deleted attachments from your saved

templates. You can add attachments to any document you have yet to publish (draft only).

Adding an attachment includes an option for using cloud files from any of these platforms:

- Amazon s3

- Box

- Dropbox

- Google Drive
- OneDrive



- SharePoint
- Salesforce Files

How to attach a document from a cloud platform:

1. From the document (draft only) you'd like to attach files to, click Attachments in the
Table of Contents panel
2. In the popup window that appears, click Cloud File
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From our available cloud platform connections, click the one you want

4. Follow the prompts to sign in to your platform (your credentials aren’t stored; you
can see and revoke access from your cloud platform)

5. Click the file you want

6. Click the Select button (your document attaches to your draft)

Cloud Storage: Box: Integrating with Conga
Collaborate

If you're not already using Box, check out Box.com/business for additional information.
Before you get started with your Box integration:

- Gather your Box credentials
- Ensure the Box Integration is enabled for your Conga Collaborate account
- Edit Integrations Permissions (determined by Group Permissions)

To connect this integration

From your Administration page, click Integrations
Choose Cloud Storage from the Integrations menu
Click Choose on the right-hand side of the screen
In the pop-up window, select Box

Enter your email address and password

Click Authorized

Click Grant Access to Box
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Organizing your documents using Box integration

The beauty of Box is how it enables you to organize your files. Find out how to get your
documents and templates to Box and into your system in the following sections.


http://box.com/business

Designating a default Box folder

Accepted and signed Conga. Collaborate documents are legally binding. Using this feature
lets you upload them directly to a folder in your Box account so that nothing slips through
the cracks.

From your Administration page, click Integrations
Choose Cloud Storage from the Integrations menu
Click Choose on the right-hand side of the screen
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Select the folder you want (you can navigate to subfolders by clicking the name of a

parent folder)

5. Click Select (the filepath to the folder will now show up under Default Destination for
Signed Documents)

6. Click Save

Designating a Box folder for a template
Follow these steps to guide a template to its Box destination:

1. With the template open, click the Properties tab

2. Click Choose to the right of the Cloud Folder for Signed Document field

3. Select folder destination you want (you may navigate to sub-folders by clicking the
name of a parent folder)

4. Click Select

Setting a default file name pattern

A PDF downloaded from a proposal often ends up with w default file name that’s hard to
understand. This feature lets you assign variables to keep file names clean and clear.

1. From the Administration page, click Integrations

2. Click Cloud Storage

3. Under Filename Pattern, click Insert Variable (include at least one variable; you can
include additional text in the Filename Pattern as well)

4. Click Save

Setting filename patterns for templates

Using different filename patterns and variables for templates can make your searches

easier.



1. From the Template you want to set a Box filename pattern for, click the Properties
tab.

2. Enter your variable name in the Cloud Filename Pattern field (include at least one
variable; you can include additional text in the Filename Pattern as well; ensure to
include the {{ double curly brackets }} around your variable name. (e.g.,
{{proposal_client}} PDF))

Attaching Box files to a Conga. Collaborate document

To attach a Box file to your document, see this article on attaching cloud files to a Conga
Collaborate document.

Adding Box files as a page in a Conga Collaborate document
A Box file can be added as a new page in your Conga Collaborate document.

1. From a Conga Collaborate document, click New Page at the top of the table of
contents bar on the left-hand side of the screen

2. Click Cloud Asset

3. Choose your file (you can navigate to sub-folders by clicking on the folder)

4. Click Select

Cloud Storage: Connecting your Conga Collaborate
Account

You can automatically store signed documents in Amazon S3, Box, Dropbox, Google Drive,
OneDrive, SharePoint, or Salesforce Files.Follow these steps to connect a cloud storage
account:

1. From the Account Settings view, click Integrations in the Table of Contents panel

2. Click Cloud Storage from the menu

3. Use the Choose button to select from available cloud storage platforms (follow the
prompts to log in to your platform)

4. Click the folder where you'd like documents to be saved, and click Select

5. Under the Filename Pattern field, use Insert Variable to choose how your uploaded
documents are named and organized

6. If you want to limit cloud storage to one destination, click Use Single Account
Authentication

7. Click Save



Cloud Storage: Egnyte: Integrating with Conga
Collaborate

The Conga Collaborate integration gives Egnyte users the power to create, share,
collaborate and sign documents online - on any device, anywhere. Once a document is
signed, Conga Collaborate automatically saves a completed document to the correct
Egnyte folder for secure storage and sharing.

With the Conga Collaborate integration Egnyte users can:

- Use Egnyte’s search to find files, right from within a Conga Collaborate account

- Build Conga Collaborate documents with files stored in the Egnyte repository

- Automatically sync the latest version of Egnyte files to have access to the most up-
to-date version within Conga Collaborate

- Collaboration with any internal or external party on any type of document that
requires eSignature

- Send a copy of the completed document to the correct Egnyte folder for secure
storage

- Track interaction with shared files for more timely and informed follow-up

To use your Egnyte or other cloud storage account, simply select the New Page button from
a document. Then select the option to add from cloud content.

Choose Egnyte from the list of Conga Collaborate’s cloud storage partners and log into
your Egnyte account. This will give you access to all of your folders and files that are
stored through Egnyte and can bring them into your Conga Collaborate document.

To learn more about our Egnyte integration, head to our website and have one of our
experts get in touch with you!

Cloud Storage: Embedding Cloud Content

Your content is always up to date with the most current version of the file on your cloud
platform. These updates occur only in Templates and documents still in Draft mode.
Published Documents are not updated. If you delete a file from your cloud platform or move
it to another folder, your Conga Collaborate documents are not affected. If you want your
file deleted from Conga Collaborate, ensure it is manually deleted within whatever
templates and document drafts it appears. Using the Conga Collaborate Cloud Content
feature, you can embed documents, from the following sources, directly into your Conga
Collaborate document:



- Amazon s3

- Box

- Dropbox

- Google Drive
- OneDrive

- SharePoint

- Salesforce
For any unpublished document (draft only), follow these steps to access cloud files:

1. From Build view of your Conga Collaborate document, click New Page in the Table of
Contents panel

2. Click Cloud Content

3. Choose the platform you use (you'll be prompted to sign into that
platform)Credentials aren’t stored, you can see and revoke access from your cloud
platform at any time

4. Choose your files and click Select (your file now appears as a new page in your
document; Hover over the page title, and you'll see a cloud icon)

5. Click the back arrow if you'd like to switch to another platform and grab more files

Netsuite

Integrate Conga Collaborate with Netsuite.

Netsuite: Adding an opportunity to a document

You can connect a Netsuite opportunity to a Conga Collaborate document by following
these steps:

1. From your Conga Collaborate document, click the Properties tab in the Document
Informaction panel.

2. Scroll down to Netsuite Opportunity and click Search.

3. Find the name of your Opportunity and select it.

4. Click Assign.

If you update a Netsuite Opportunity and want your Conga Collaborate documents to
reflect the changes, select Variables from your Document Information panel and click
Refresh Variables.



Netsuite: Creating auto-generated tables

You can pull data from Netsuite into your Conga Collaborate documents to create an

auto-generated table.

This is an example of a basic pricing table that will work if you're using the standard fields

in Netsuite. You can customize some parts of the code (shown below) to your own Netsuite

instance in order to populate the table with the correct information.

BUILDING YOUR TABLE

To create an auto-generated table

1.

In a Conga Collaborate document, create a table in the Conga Collaborate editor
that has three rows and as many columns as you need.
Add the class custom_pricing (below in red).

. Add the data-source attribute (below in yellow).

- Quotelineltems for quotes

- OpportunitylLineltems for opportunities
Define the table structure by declaring the first row a header row, the middle row the
body, and the bottom row the footer (below in green)
Fillin the table

- Type your column headers into the first row (below in light blue).

- In the middle (body) row, place the fields you want in square brackets (below in
yellow). To find the correct way to reference the fields, go back to the Incoming
Data configuration, copy the field names exactly as they show in the saved list.
Only the fields in square brackets will be replaced.

- If you want a totals row, use the footer section (below in hot pink).

- Styling is markup based; inside the cell tag use class="money”,”"html”, “integer”
or “float” (below in orange).

Optional: Sort the order of the line items in the table (below in pink).

- data-sort="field_name desc” (sorting is ascending by default)

Filter the line items that will populate the table based on the value of one field from
Netsuite. Filters are entirely case sensitive and have a variety of operators (=, !=, >,
>=, <, <=, LIKE, NLIKE, IS BLANK, IS NOT BLANK). (below in darker blue).

- data-filter="Name LIKE 'hello world" like must be uppercase and comparison is
also case sensitive

- data-filter="Pricebook.product2.family = 'bronze"



- If you would like separate tables for each value of the filtering field, you can
copy the table multiple times and simply set each filter to a unique

value.RENDERED TABLE
Name Item Price Quantity Total Price
[name] [item_price] [quantity] [sum]
Total Price: [SUM(sum)]
HTML

<table style="width: 100%;"” data-source="OpportunitylLineltems”data-
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filter="PricebookEntry.Product2.Family = ‘Subscription” data-
sort="PricebookEntry.Product2.Name”> <thead> <tr> <th>Name</th> <th>Item Price</th>
<th>Quantity</th> <th>Total Price</th> </tr> </thead> <tbody> <tr> <td>[name]</td> <td
class="money” style="text-align: center;”>[itemprice]</td> <td class="integer” style="text-
align: center;”>[quantity]</td> <td class="money” style="text-align: center;”>[totalprice]</
td> </tr> </tbody> <tfoot> <tr> <td colspan="3" rowspan="1" style="text-align:
right;”>Total Price:</td> <td class="money” style="text-align: right;”>[SUM(priceperunit)]</
td> </tr> </tfoot> </table>

Finally, test your auto-generated table using your data from Netsuite. When you create a
new document, choose the template where you added the pricing table. You should be able
to click Preview and see your populated table

Netsuite: Integration overview

Leverage the power of a CRM with the simplicity and efficiency of our proposal-building
process by integrating your Conga Collaborate account with Netsuite. If needed, Contact
Support for information on this integration.

Follow these steps to connect your Netsuite and Conga Collaborate accounts:

Log into your Netsuite account

Click on your name in the upper right-hand corner

Copy your account ID (the long string of letters and numbers)

From your Conga Collaborate Account Settings page, select Integrations
Click on Netsuite from the Integrations menu

Enter your Netsuite login credentials

Paste your Netsuite account ID into the Account field

Click Save
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Sandbox environments are currently supported for this integration. If you are interested in
setting up a Conga Collaborate sandbox to connect to a sandbox Netsuite org, please
contact Global Support.

Netsuite: Managing data

After you've integrated your Netsuite account with your Conga Collaborate account, you
can easily move data back and forth.

INCOMING DATA (NETSUITE TO Conga Collaborate)

The data set within Netsuite is small enough that Conga Collaborate will automatically
pull every field available.

When you add a Netsuite Opportunity to your Conga Collaborate document, all standard
and custom fields will be available in the document.

Custom fields that do not hold any value will not be pulled over. They must
contain a value of some kind in order for Conga Collaborate to see them.

OUTGOING DATA (Conga Collaborate TO NETSUITE)

Use the outgoing data tool to push information from your Conga Collaborate account
back into Netsuite. You can use various events to trigger outgoing data, and you can push
data into any standard field within your Netsuite account. Custom fields are not available
to use with this feature.

Follow these steps to configure this tool:

1. From your user dropdown in the top right corner, go to Administration => Integrations
=> NetSuite CRM => Edit
2. Scroll down to the Outgoing Data section
3. Select the Conga Collaborate event that you want to trigger updates of Netsuite
records. You may select
- Created
- Publish
- Accept
- Decline
- Create New Version
- Finalize Version
- Ask a Question
- First View
- Formstack Form Submission


https://octiv.com/support/
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- Email Sent

- Request Approval

- Void
Select a specific Template or All Templates to designate how this rule will apply
Select the NetSuite Opportunity object and the field you'd like to send the information
to
Select the Conga Collaborate data to map to the assigned field or specify the value
to set in NetSuite
Click Add

Example Use Cases

Send the URL of a published proposal back to your Opportunity when that proposal is
published.

> w N~

Select event Publish

Choose your template

Select the Opportunity object and the Memo field
Define value: Proposal Field = Proposal: Public URL
Click Add

Update the closed date of an Opportunity when a proposal or contract is accepted.

o b~ w N~

Select event Accept

Choose your template

Select the Opportunity object and the Close Date field

Define value: Proposal Field = Proposal: Closed At (DateTime)
Click Add

Pipedrive

Integrate Conga Collaborate with Pipedrive

Pipedrive: Adding a deal to a document

Integrating your Pipedrive account enables you to add your deals to your Conga

Collaborate documents.

To connect a deal

1.
2.
3.

In the document, you want to add a Deal to, click the Properties tab.
Scroll down to Pipedrive Deal and search for the name of your Deal.
Select the Deal you want.



4. Click Assign. Your document refreshes and your Deal is connected.
- If you update a Pipedrive Deal and want your Conga Collaborate document to
reflect those changes, click the Variables tab and choose Refresh Variables.

Pipedrive: Creating auto-generated tables

Conga Collaborate’s Pipedrive integration allows data to be referenced from a Pipedrive
deal to automatically generate and populate rows of a pricing table.

This is an example of a basic pricing table using standard fields in Pipedrive. You can
customize small parts of the code (shown below) to your own Pipedrive instance in order to
populate the table with the correct information.

BUILDING AN AUTO-GENERATED TABLE

To create an auto-generated table within a template

1. Click Insert > Insert Table on the editing toolbar. The table should have one column
for each Pipedrive field you wish to include and a total of three rows.

2. Once the table is inserted on the page, assign the Pricing Table class by right-clicking
the table and selecting Table Properties > Class > Pricing Table.

3. Hover over the table and click the gear icon that appears in a blue frame. This opens
the Pricing Table menu. Here, you can assign the table’s desired Data Source. Only
fields from the selected data source should be included in the table.

4. Complete the table layout.

- Enter static column header text into the first row of cells.

- In the middle row, enter “%" to prompt a dropdown Llist of variables available
from the table data source and select the desired variable. If you don’t see the
variable you are looking for, it may not yet be mapped to Conga Collaborate.
Reference this article for information on variable mapping. This row will repeat
when the document is previewed/published to match the number of line items
present.

- The third row can be used for aggregate functions, most commonly, to display a
sum total price. Syntax is as follows: [SUM(variable_name)]

- Cells can be set to display data in a certain format. Right click a cell and select
Cell > Cell Properties > Class and choose your desired format.

Optional: You can add a filter to a table by clicking the gear icon to open the Pricing Table
modal and selecting the Add Filter option. Make selections in the Variable and Operator
fields, then enter a value in the Value field. Click Save to apply the filter.



Optional: You can sort the table by fields available in the table’s selected data source.
Sorting is ascending by default.

Rendered Table:

HTML
Name [tem Price Quantity Total Price
[Name] [item_price] [quantity] [sum]
Total Cost: [SUM(sum)]

Test your Auto-Generated Pricing Table by connecting a Pipedrive deal to the template or
related document. If everything is done correctly, clicking the Preview button will allow you
to view the populated pricing table.

Pipedrive: Integration overview

Merge Pipedrive’s power with our efficient proposal-building process for the best of both
worlds. The first step is contacting your account manager to enable the integration.

To integrate Pipedrive into your Conga Collaborate account

From your Pipedrive account, click your name in the upper right corner.

1.

2. Select Personal.

3. Select API.

4. Copy your APl token (the long string of letters and numbers).

5. Hop over to the Account Settings view of your Conga Collaborate account.
6. Click Integrations.

7. From the Integrations menu, click Pipedrive.

8. Paste your APl token into the API Key field.

9. Click Save

Pipedrive: Managing data

After you've integrated your Pipedrive account with your Conga Collaborate account, you
can easily move data back and forth.



INCOMING DATA

The data set within Pipedrive is small enough that Conga Collaborate automatically pulls
every field available.

When you add a Pipedrive Deal to your Conga Collaborate document, all standard fields
will be available in the document.

OUTGOING DATA

Use the outgoing data tool to push information from your Conga Collaborate account
back into Pipedrive. You can use various events to trigger outgoing data, and you can push
data into any editable field within your Pipedrive account.

To configure this tool

1. From your Account Settings view, click Integrations.
2. Click Pipedrive. Any information you send needs a place to land in Pipedrive, so be
sure that the field you want to push data into exists on the object you select.
3. Select the Conga Collaborate event you want to trigger updates of Pipedrive object
records. You may select
- Created
- Publish
- Accept
- Decline
- Create New Version
- Finalize Version
- Ask a Question
- First View
- Formstack Form Submission
- Email Sent
- Request Approval
4. Select a specific Template or All Templates to designate how this rule will apply.

o

Select the Pipedrive Deal object and field you’'d like to send the information to.

6. Select the Conga Collaborate data to map to the assigned field or specify the value
to set in Pipedrive.

7. Click Add.

Examples



Send the access code of a published proposal back to Pipedrive when that proposal is
published.

6.

o b~ w N~

Create a Text field called Proposal Access Code in the Deal object.

Select event Publish.

Click Add.

Assign field: Pipedrive objects = Deal, Pipedrive fields = Proposal Access Code
Define value: Proposal Field = Proposal: Access Code

Click Add.

Update the closed date of a Deal when a proposal or contract is accepted.

1.
2.
3.
4.

Select event: Accept Proposal

Assign field: SFDC Objects = Deal, SFDC Fields = Close Date
Define value: Proposal Field = Proposal: Closed At (DateTime)
Click Add.

Overview of Filters

An overview of the new Faceted Search for Conga Collaborate.

Conga Collaborate is releasing a new filter feature to improve your user experience.

You are now able to filter and refine documents shown in the center panel by

predetermined filters in the right panel in addition to the following changes:

- The center and left panels are rebuilt to enhance your experience
- Templates are moved from the documents list to their own navigation tab
- You are able to save sets of filters to easily pull up relevant documents for use at a

later time

- The Advanced Search feature is removed
- Current saved searches are not available in the new interface. You must create a new

saved search based on the filtering options available on the left panel.

Guided Tour of Conga Collaborate

Watch Conga Collaborate videos for a detailed overview of Conga Collaborate.


http://videos.conga.com/category/videos/conga-collaborate

Troubleshooting Conga Collaborate

You can review issues and known problems by searching the troubleshooting section. For
more information, see the issues listed.

Conga Collaborate Missing Call to Action
Buttons

Conga Collaborate previously released enhancements to its security model which had an
unanticipated adverse and undesired effect on a subset of previous functionality.

Summaury

Conga Collaborate previously released enhancements to its security model which had an
unanticipated adverse and undesired effect on a subset of previous functionality.

Impact

The first impact was to Collaborate End Users, and related to the View functionality in the
build part of the document during the sending experience. Previously the Collaborate End
User was able to use the View functionality to copy and paste the Recipient document Llink
in a new browser tab and view the document as the Recipient. With the enhanced security
model, this is no longer allowed in the same browser because of a shared session (for
example, the End User is currently logged into Collaborate and cannot simultaneously
share a session to view a Recipient document). This would result in an End User being able
to view a document, but “call to action” buttons like the Acceptance Button would be
missing on the document. The proposed workaround was to use a new Incognito browser to
allow for accurate viewing (for example, a new browser session).

Furthermore, this issue was compounded by a variety of scenarios in which while there was
some overlap in viewing behavior, also created further difficulty troubleshooting.

The three primary contributors to the discrepancies in behavior were:
If the Recipient was viewing the document with the unique URL instead of the public URL.

If the document had people added directly to it (either through adding Salesforce Contacts
or people directly from the People tab).



If an esignature solution (Collaborate eSign, DocuSign, or Conga Sign) was being utilized.

The second impact was to the Recipient of documents, or Conga’s Customers’ Customers. If
the Recipient of any Collaborate document received more than one document (at any point
in time) it was possible that the Recipient’s browser saved the previous session when a
subsequent document was attempted to be viewed, which resulted in redirecting the
Recipient to the Collaborate Application Login Page instead of the Document viewing page.
This happened intermittently and had dependencies on the Recipient’s browser behaviors,
internal IT policies, etc.

Solution

The fix released on 6/12/2019 creates a new End User flow for the first scenario, allowing for
viewing the Recipient document in the same browser, and eliminates the need for an
incognito browser as a workaround. The fix also eliminates the second scenario, reverting to
prior behavior of Recipient’s of documents to view documents directly and not be redirected
to the Collaborate Application Login Page. To turn on this new functionality, submit a
request to our Support Team.

Exporting and Deleting Collaborate Data

Conga Collaborate provides users the options to export data (Open and Accepted
documents, and content including images, files, and pages) from their Collaborate org to a
cloud storage provider of their choice. Users also have the option to delete all data from
Collaborate as well.

To upload your data to cloud storage

1. Ensure your account is connected to a cloud storage provider. See Cloud Storage:
Connecting your Conga Collaborate Account for more informaction.

Submit a case with the Conga. Support team.

Fill out all required fields on the case submission form.

In the description field, detail the request to upload data to a cloud storage provider.

ok WS

The Conga Support team will process your request and your data will be uploaded to
cloud storage.

Note:



Documents such as proposals and contracts are exported as PDF files and
Content (such as images and .docx files) are exported as the same file type.

To delete all data from Collaborate

1. Submit a case with the Conga Support team.
2. Fill out all required fields on the case submission form.
- In the Description field, detail the request for data deletion.
3. The Conga Support team processes the data deletion request and hands it off the
Collaborate Engineering team to complete.
4. Once completed, the Conga Support team reaches back out to confirm data deletion.


https://support.conga.com/submitcaseform

Conga Copyright Disclaimer

Copyright © 2022 Apttus Corporation (“Conga”) and/or its affiliates. All rights reserved.

No part of this document, or any information linked to or referenced herein, may be reproduced, distributed, or
transmitted in any form or by any means, including photocopying, recording, or other electronic or
mechanical methods, without the prior written consent of Conga.. All information contained herein is subject
to change without notice and is not warranted to be error free.

This document may describe certain features and functionality of software that Conga makes available for
use under a license agreement containing restrictions on use and disclosure and are protected by intellectual
property laws. Except as expressly permitted in your license agreement or allowed by law, you may not, in
any form, or by any means, use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute,
exhibit, perform, publish, or display any part of the software. Reverse engineering, disassembly, decompilation
of, or the creation of derivative work(s) from, the software is strictly prohibited. Additionally, this document
may contain descriptions of software modules that are optional and for which you may not have purchased
a license. As a result, your specific software solution and/or implementation may differ from those described
in this document.

U.S. GOVERNMENT END USERS: Conga software, including any operating system(s), integrated software, any
programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are
“commercial computer software” pursuant to the applicable Federal Acquisition Regulation and agency-
specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the
programs, including any operating system, integrated software, any programs installed on the hardware,
and/or documentation, shall be subject to license terms and license restrictions applicable to the programs.
No other rights are granted to the U.S. Government.

Neither the software nor the documentation were developed or intended for use in any inherently dangerous
applications, including applications that may create a risk of personal injury. If you use this software or
hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup,
redundancy, and other measures to ensure its safe use. Conga and its affiliates disclaim any liability for any
damages caused by use of this software or hardware in dangerous applications.

Apttus, Al Analyze, Conga, Conga Al, Conga Al Discover, Conga Batch, Conga Collaborate, Conga Composer,
Conga Conductor, Conga Connect, Conga Courier, Conga Grid, Conga Mail Merge, Conga Merge, Conga
Orchestrate, Conga Sign, Conga Trigger, Digital Document Transformation, True-Up, and X-Author are
registered trademarks of Conga and/or its affiliates.

The documentation and/or software may provide links to web sites and access to content, products, and
services from third parties. Conga is not responsible for the availability of, or any content provided by third
parties. You bear all risks associated with the use of such content. If you choose to purchase any products or
services from a third party, the relationship is directly between you and the third party. Conga is not
responsible for: (@) the quality of third-party products or services; or (b) fulfilling any of the terms of the
agreement with the third party, including delivery of products or services and warranty obligations related to
purchased products or services. Conga is not responsible for any loss or damage of any sort that you may
incur from dealing with any third party.

For additional resources and support, please visit https://community.conga.com.
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